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Introduction

Overview

Welcome to TamoGraph Site Survey, a powerful and user-friendly application for collecting and visualizing 
Wi-Fi data, as well as predictive modeling. Wireless network deployment and maintenance requires the 
use of a professional RF site survey tool that facilitates otherwise time-consuming and very complex tasks, 
such as ongoing analysis and reporting of signal strength, noise and interference, TCP and UDP 
throughput, channel allocation, data rates, etc. By using TamoGraph, businesses can dramatically reduce 
the time and costs involved in designing, deploying and maintaining WLANs and improve network 
performance and coverage.

Why to Perform a Site Survey

In a word, wireless site surveys are necessary because radio wave propagation is difficult to predict, 
especially in non-open space environments. Considering all the variables that might affect the health and 
performance of your WLAN is virtually impossible. Changing conditions, even something as seemingly 
minor as a laptop equipped with a legacy 802.11g adapter that your new employee connected to the office 
wireless network, might seriously affect the WLAN performance. In addition, considering the wide 
proliferation of wireless infrastructure, factors such as interference from nearby WLANs play a very 
important role. This is why regular site surveys conducted with a professional tool are essential.

When to Perform a Site Survey

Pre-deployment surveys: At this stage, a site survey is necessary in order to verify that the network plan 
works well in a real-world environment. Placement of temporary access points (APs) and a quick survey of 
the resulting WLAN characteristics allow an engineer to fine-tune AP and antennae placement, determine 
the optimal number and types of APs and antennae, and avoid poor coverage zones. Using TamoGraph, 
you can also perform a simulation in a virtual environment prior to deployment.

Post-deployment surveys: Once a WLAN has been deployed, a complete verification site survey is 
necessary to ensure that the WLAN performance and coverage meet the design requirements. At this 
stage, the Wi-Fi equipment placement is finalized, and a site survey report should be generated so that the 
historical records can be accessed at any time in the future.

Regular, ongoing surveys: Maintaining high performance and coverage requires regular “check-up” 
surveys. New users, new equipment, site expansion, neighboring WLANs, and other factors can adversely 
affect your WLAN. It should be monitored on a regular basis.
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Survey Types

There are three types of surveys that you can conduct with TamoGraph: passive, active, and  predictive 
(the latter is technically not a survey; rather, it’s virtual modeling). During a passive survey, the application 
collects the most comprehensive data on the RF environment: information on access points and their 
characteristics, signal strength, noise level, interference, etc. This is the default and most important survey 
type that we recommend to conduct in every case. It is called passive because during this type of survey, 
the application passively listens for packets and does not attempt to connect to WLANs. However, to 
provide more insight into the real-world performance of your WLAN, TamoGraph can also perform active 
surveys, during which your Wi-Fi adapter connects to the wireless network(s) of your choice to measure 
actual throughput rates and a few other metrics. Unlike passive and active surveys, predictive modeling is 
not performed on-site. Predictive models are a computer simulation in which Wi-Fi characteristics are 
predicted for the virtual environment model created by the user. The process of creating and adjusting the 
virtual environment, selection and placement of simulated APs, and analyzing the resulting WLAN is 
commonly referred to as “RF planning”, “RF predictive modeling,” or “RF modeling.” Please refer to the 
Understanding Survey Types: Passive, Active, and Predictive chapter for more information on this topic. 
Additionally, TamoGraph can be used to perform spectrum analysis surveys.

6 GHz (Wi-Fi 6E) Support

In TamoGraph 8.0, we introduced support for the 6 GHz Wi-Fi band, also known as Wi-Fi 6E. This new 
band offers up to 1,200 MHz of new spectrum, which is a big step forward regarding WLAN capacity and 
performance. With TamoGraph 8.0, users can now conduct passive and active surveys in this band (a 
compatible adapter with 6 GHz support is required), as well as use predictive modeling to design and 
simulate new 6 GHz deployments and combine them with the existing 2.4 and 5 GHz bands. We 
implemented support for the latest Wi-Fi technologies and standards, such as Multiple BSSID elements, 
the new power spectral density (PSD) rules, among others.

To allow our users to conduct 6 GHz spectrum surveys, TamoGraph 8.0 now also supports a tri-band USB 
spectrum analyzer, WiPry by Oscium.

System Requirements

TamoGraph requires a portable computer with the following minimal system requirements:

   Computers running Microsoft Windows

Windows 10 or 11, Windows Server 2016, 2019, or 2022.

Intel Core 2 or similar CPU. A multicore CPU such as Intel i5 or i7 is recommended.

8 GB of RAM.

A compatible wireless adapter for passive surveys. For the up-to-date list of compatible adapters, 
please visit our website. Any modern wireless adapter may be used for active surveys.

https://www.tamos.com/download/main/tg
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An NMEA-compliant GPS receiver or a Windows GPS or GLONASS sensor, if you plan to perform 
GPS-assisted site surveys.

A USB spectrum analyzer, Wi-Spy by MetaGeek or WiPry by Oscium, if you plan to perform 
spectrum analysis surveys.

Internet Explorer 8.0 or higher, if you plan to import street maps from one of the online map 
services.

400 MB of free disk space.

   Computers running macOS

macOS Monterey, Ventura, Sonoma, and Sequoia.

MacBook, MacBook Pro, or MacBook Air manufactured in 2015 or later.

8 GB of RAM.

An NMEA-compliant GPS receiver, if you plan to perform GPS-assisted site surveys.

A USB spectrum analyzer, Wi-Spy by MetaGeek or WiPry by Oscium, if you plan to perform 
spectrum analysis surveys.

400 MB of free disk space.

You can also run TamoGraph on a desktop computer that is not equipped with a compatible wireless 
adapter. This operating mode may be feasible if you would like to collect Wi-Fi data using portable 
computers and then import, merge, and analyze the data on a desktop PC or iMac based on faster 
hardware and using a larger display.

Differences Between the Windows and macOS Versions

The Windows and macOS versions of TamoGraph are largely identical. In addition, TamoGraph project 
files are compatible across versions. Project files created with the Windows version of TamoGraph can be 
opened by the macOS version, and vice versa.

Nevertheless, there are many differences between the two operating systems and the underlying 
hardware. This results in some differences in the TamoGraph versions, which are summarized below:

Microsoft Windows macOS

Compatible Adapters Requires specific Wi-Fi adapter 
models for passive surveys.

Works with the Wi-Fi adapter built into 
your MacBook and does not require 
specific additional adapters.

Driver or Packet 
Capture Engine 
Installation

Requires you to install the 
special drivers that come with 
this product.

Requires you to install the packet capture 
engine.
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Simultaneous
Active + Passive 
Surveys

Supported, as long as two 
different adapters are plugged 
in.

Supported, as long as you use one of the 
compatible USB adapters for the passive 
part of the survey and the built-in adapter 
for the active part.

Using Multiple 
Adapters

Supported. Not supported.

Additionally, some menu items are located in different places in the two versions.

Driver Installation - Microsoft Windows

TamoGraph is a tool for monitoring wireless networks based on the latest 802.11be (Wi-Fi 7) and 802.11ax 
(Wi-Fi 6) standards, as well as the legacy ones, such as 802.11 a/b/g/n/ac. To conduct passive surveys, you 
must have a compatible wireless adapter to use this product. In order to enable the monitoring features of 
your wireless adapter, you will need to use the special drivers that come with this product.

When TamoGraph is not running, your adapter will be able to communicate with other wireless hosts or 
APs, just like when you are using the original driver supplied by the adapter manufacturer. When 
TamoGraph is running, your adapter will be put in passive, promiscuous monitoring mode.

Prior to installing the new driver for your wireless adapter, be sure that your adapter is compatible with 
this product. The list of compatible adapters can be found at the following URL:

https://www.tamos.com/download/main/tg

For detailed driver installation instructions, please launch the program and click Help =>  Driver 
Installation Guide in the program's menu.

If you use CommView for Wi-Fi, another TamoSoft product, you do not need to install or change the driver, 
as TamoGraph and CommView for Wi-Fi share the same drivers.

Wi-Fi Capture Engine Installation - macOS

To conduct passive and active surveys, TamoGraph uses your MacBook’s built-in Wi-Fi adapter. To enable 
Wi-Fi adapter’s monitoring features of the, you will need to install the Wi-Fi Capture Engine. You will be 
prompted to install it when you run TamoGraph for the first time. Alternatively, you can do so by clicking 
TamoGraph  => Install Wi-Fi Capture Engine  in the main menu. Note that the installation requires an 
administrative account. Once the engine has been installed, you can run TamoGraph as a standard user.

When TamoGraph is not running, your adapter will be able to communicate with other wireless hosts or 
APs as it normally does. When TamoGraph is running, your adapter will be put in passive, promiscuous 
monitoring mode. If you want to restore network connectivity while TamoGraph is running, select the 
Properties tab on the right panel, expand the Scanner frame, and click Stop Scanner.

https://www.tamos.com/download/main/tg
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If you want to use one of the supported external USB adapters, capture engine installation is not needed; 
you simply need to plug in the USB adapter.

Running TamoGraph Without the Scanner

Once the driver or the capturing engine has been installed, every time you run TamoGraph, it will try to 
take control of the Wi-Fi adapter, thereby switching off Wi-Fi connectivity of your computer. However, 
sometimes you may want to run TamoGraph without disrupting Wi-Fi connectivity, for example, when you 
simply want to use it for planning or analyzing past survey. If that’s the case, you can use command-line 
options to achieve that; see Command-Line Options and Configuration Settings for Advanced Users.

Trial Version Limitations

The trial of TamoGraph allows you to evaluate the software for 30 days and has the following limitations:

Watermarks are placed on all visualizations.

You cannot save projects or reports.

You cannot collect data and survey sites for longer than ten minutes.

If you create a predictive model, you cannot use the planning tool for longer than five minutes or 
place more than five virtual APs on the floor plan.

License Types

Two TamoGraph license types are available:  Standard and Pro. The more expensive Pro  license allows 
you to use the GPS functionality for conducting GPS-assisted site surveys outdoors, perform predictive 
modeling, and customize PDF and HTML reports. The Standard  license does not offer GPS, predictive 
modeling, or report customization functionality.
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Interface Overview

The application main window includes the following elements:

The resizable left-side panel displays an AP list of the APs detected by the scanner or the ones that 
are present in the imported projects.

The central area is used for displaying the floor or site plan image, survey paths, and visualizations 
of analyzed data.

The resizable right-side panel allows you to manage project floor plans and collected survey data, as 
well as to configure various project options and settings.

You can hide and show the left and right panels using the vertical splitter or through the menu commands 
View => Left Panel and View => Right Panel.

In addition to the three main elements, the application contains the main toolbar (provides quick access to 
frequently used commands), the RF Planner  toolbar (used in predictive modeling for drawing virtual 
objects; not shown by default), and the status bar (provides information on the wireless adapter and 
scanner status, current floor plan dimensions, coordinates, and zoom level, as well as the legend for the 
currently selected visualization).

The following chapters describe the functionality of these elements in detail.



TamoGraph Site Survey   ●   Interface Overview Page  11  of  120

Access Point List

The left application panel is used to display the list of APs detected by the application (if you have a 
compatible adapter installed.) It also displays virtual APs if you perform predictive modeling. You can use 
the Group by button to group APs by band, channel, SSID, name, or custom group. Grouping by SSID is the 
best method in a corporate WLAN environment, where all the WLAN's APs share the same SSID.

The AP list displays key AP parameters in the corresponding columns: SSID, vendor, channel, current signal 
level in dBm, supported encryption type(s), maximum data rate in Mbps, the number of MIMO spatial 
streams, and MAC address. If the vendor is unknown, the AP name is preceded by Unknown. If the vendor 
name is known, the AP name is preceded by the vendor name followed by the AP type. Additionally, for 
Cisco APs, TamoGraph will try to find and use AP names assigned by the administrator. You can rename 
APs by right-clicking on them and selecting Rename.  To restore the original name, simply delete a user-
assigned name by hitting the backspace key. If the AP uses channel bonding (several 20 MHz channels), 
the channel set is shown in parentheses after the primary channel number. For 802.11ac, 802.11ax, and 
802.11be APs, several channel sets might be shown, e.g., for the 40 MHz and 80 MHz modes. You can 
customize the columns by right-clicking on the list header or change their order by dragging them. The 
APs that are not currently audible are shown in grey font, and their signal level is shown as N/A.

The AP icons are color-coded to reflect the 802.11 bands and standards they use:

2.4 GHz 802.11b

2.4 GHz 802.11g

2.4 GHz 802.11n

5 GHz 802.11a

5 GHz 802.11na

5 GHz 802.11ac
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2.4, 5, and 6 GHz 802.11ax

2.4, 5, and 6 GHz 802.11be

The check boxes next to the APs play a very important role: They should be used for selecting the APs you 
want TamoGraph to analyze. When the Selected APs mode is enabled on the toolbar, data visualizations 
for passive surveys include only the APs that have checked boxes next to them.

To quickly select the APs that belong to the same frequency band (2.4, 5, or 6 GHz), you can use the 
buttons located above the AP list. Pressing a button selects all the APs that belong to the corresponding 
band, while pressing it again removes the selection. The same functionality is available by right-clicking on 
the AP list and using the Select All, Select 2.4 GHz, Select 5 GHz or Select 6 GHz APs or  Deselect All APs
commands. The right-click menu also allows to disable or enable the Ignore APs if max. signal is below
option (see AP Detection and Placement  for more information.) If the list of APs becomes too long and 
you prefer to not see the APs that are currently outside the range, select Advanced  => Remove Inactive 
APs. This will remove the APs that have been outside the range for longer than two minutes. The 
Advanced => Re-link Multi-SSID command may be useful when working with linking multi-SSID APs; for 
more information, see the corresponding chapter.

If the AP signal is strong enough and if a sufficient number of readings has been recorded, TamoGraph 
computes the AP location and places the corresponding icon on the site map. Those APs that are present 
on the site map have a small blue plus (+)  sign in the lower right corner of their icons. The Find 
approximate AP locations  command allows you to re-calculate the original estimated AP location(s) of 
either all or only the highlighted AP if you changed the locations by moving AP icons with the mouse or 
performed additional surveys. If an AP was not automatically placed on the site map and you want to 
place it there, you can drag the AP icon from the AP list to the site map. To remove it from the site map, 
drag the AP icon outside or use the Clear Access Point Locations command. See Adjusting AP Locations
for more information. Virtual APs that were created by the user for predictive modeling have a small blue 
“V” sign in the lower right corner of their icons; such APs cannot be auto-located or dragged off the site 
map.

When working with dozens of APs, it might be difficult to find the corresponding entry on the AP list for a 
given icon on the site map and vice versa. To help you with this task, two visual feedback mechanisms 
exist:

When you select an AP icon on the site map, the corresponding item on the AP list is highlighted in 
grey color. If a multi-SSID AP has been selected, multiple corresponding items on the AP list are 
highlighted (one per radio).

When you double-click an item on the AP list, the corresponding AP icon on the site map blinks a 
few times (assuming that the corresponding AP icon is shown on the site map). If the AP icon is not 
within the site map’s visible area, the site map is automatically scrolled to ensure that the icon is 
visible.
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You can also use the Search function to find APs by name, vendor, SSID, or MAC address (BSSID). To do 
this, use the search field located above the AP list and enter some text or part of a MAC address. If matches 
are found, they will be highlighted, and the selection line will be placed on the first match. To the right of 
the search field, you can see the total number of matches and the current match number. The “left” and 
“right” buttons can be used to navigate to the previous or next match.

Custom Groups

One of the possible AP grouping methods is by “Custom Group”. This method might be used if you have a 
grouping criterion that is not covered by the standard grouping methods, such as by SSID or by band. For 
example, you may want group APs by their location. Initially, APs are not assigned to any group. To create 
groups and assign APs to them, use the Custom Group menu. Under this menu, you can Add selected APs 
to an existing or new group (by “selected,” we mean the APs that are currently checked in the AP list) or 
Clear  grouping for all or selected APs. You can also Manage  all groups. When you use the Manage
command, the application displays a dialog listing all APs and their membership in the groups. Initially, all 
APs are marked as Ungrouped. You can create new groups, rename them, delete them, and move one or 
several APs to any group via drag-and-drop. Note that an AP cannot be assigned to multiple groups; it can 
be assigned either to one group or to no group. Groups are project specific, which means that they exist 
only within a given project. You cannot create or manage groups when no project is open.

Floor Plan / Site Map

This central area of the application window is used for displaying the floor plan or site map. When you 
perform a passive or active site survey, you use the floor plan to mark your current location. As you move 
and click on the plan, TamoGraph will show your walkabout path and the area you have covered, as 
shown on the illustration below:
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The application status bar displays the map dimensions and your current coordinates when you hover the 
mouse over the map. To zoom in our out, use the mouse scroll wheel or the Zoom button on the status 
bar. To pan the map, use the vertical and horizontal scroll bars or press and hold the space bar and drag 
the map while holding the left mouse button. If you are using a computer with a multitouch display, you 
can use the two-finger pinch zoom gesture to zoom in or out and the two-finger pan gesture to pan.

When you are through surveying the site, you can use the Visualization drop-down list on the toolbar to 
have TamoGraph display data visualizations for your site (e.g., signal level or AP coverage areas).

Plans and Surveys, Properties, and Options Panel

This panel gives you access to virtually all the application and project settings. Using this panel, you can 
manage floor plans or conducted surveys, configure requirements for your wireless network, change the 
scanner settings, select color schemes for your visualizations, etc. For a detailed description of these 
functions, refer to the Configuring TamoGraph chapter.

Main Menu

The application menu commands are described below. Some menu items are located in different places in 
the Windows and macOS versions.

Project

New – launches a new project wizard.
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Open – opens a previously saved project.

Save – saves the current project.

Save As – saves the current project under a different name.

Close – closes the current project.

Generate Report – opens the report generation dialog.

Save Current Visualization – saves the currently selected visualization and legend to an image file.

Clear Recent List – clears the list of recently opened project files.

Exit – closes the application.

Survey

Start – starts data collection.

Pause – suspends data collection temporarily.

Stop – stops data collection or site map calibration.

Continuous – turns on the continuous data collection mode.

Point-by-Point – turns on the point-by-point data collection mode.

GPS – turns on the GPS data collection mode.

Calibrate – allows you to set the map dimensions.

Export Survey Data  – exports collected data when the survey job is split between several 
computers.

Import Survey Data  – imports collected data when the split jobs need to be merged into one 
project.

Take Photo – allows you to take a photograph and add it to your project.

RF Planner

Auto-place APs – open the AP automatic placement wizard.

Reconfigure APs – open the AP automatic reconfiguration wizard.

Virtual Model  – turns on or off the virtual model and, respectively, shows or hides all virtual APs 
and other objects used in predictive modeling.

View

Left Panel – shows or hides the left panel.

Right Panel – shows or hides the right panel.

Main Menu  – shows or hides the main application menu. To show it again, press ALT or use the 
View context menu on the central pane.

Main Toolbar – shows or hides the toolbar in the main application window.
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RF Planner Toolbar  – shows or hides the toolbar for editing virtual objects used in predictive 
modeling.

Status Bar – shows or hides the application status bar.

Full Screen  – expands the main application window and hides all other applications. To exit full 
screen mode, press F11 or use the View context menu on the central pane.

Vertical Ruler – shows or hides the vertical ruler.

Horizontal Ruler – shows or hides the horizontal ruler.

Legend – shows or hides the legend on the map.

Spectrum and Networks  – shows or hides the spectrum and networks analysis pane. This item is 
enabled only when the project contains spectrum or passive data or when a compatible adapter or 
Wi-Spy is plugged in.

Dashboard – shows or hides the Dashboard panel with a set of real-time data indicators.

Access Points – shows or hides AP icons. This applies to both virtual APs and real-world APs.

Walkabout Paths – shows or hides survey paths.

Virtual Objects – shows or hides virtual objects (walls, attenuation areas, AP auto-placement areas, 
and floor areas) that were created as part of predictive modeling.

Media Objects – shows or hides icons that represent photographs taken during surveys.

Settings

Interface Font – allows you to change the interface font.

Language – allows you to change the interface language.

GPS Settings – allows you to configure your GPS receiver.

Camera and Voice Settings – allows you to configure a camera for adding photos to your project 
and voice recognition setting for controlling the application using voice commands.

Adapter Signal Level Correction – allows you to adjust the signal strength reported by your Wi-Fi 
adapter.

AP Ignore List – allows you to configure the list of APs to be ignored by the application.

Help

Contents – displays help documentation.

Contents (PDF) – displays help documentation in PDF format.

Driver Installation Guide – displays driver installation guide.

Check for Updates  – connects to the TamoSoft website and checks whether a newer application 
version is available.

Activation – activates your registration key.

About – displays information about the application.
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Dashboard

The Dashboard panel provides users with a real-time snapshot of the current Wi-Fi environment. You can 
show or hide the dashboard and change its location (left or right) using the View => Dashboard  menu 
item.

If TamoGraph detects a Wi-Fi adapter that can be used for passive surveys, the dashboard includes the 
following indicators:

Scanner progress – the circular indicator that visualizes the scanning progress. The circle represents 
a scan cycle, i.e. the time needed to sweep all selected channels once.

Scanner cycle duration – the text above the horizontal line inside the circle that indicates the time in 
seconds needed to sweep all selected channels once.

Number of available adapters for passive surveys – the number below the horizontal line inside the 
circle that indicates the number of adapters being used for passive surveys.

Scanner cycle duration recommendations – the color of the circle that indicates whether the scan 
cycle duration is optimal. A green circle indicates optimal scan cycle duration. A yellow circle 
indicates somewhat lengthy scan cycle duration. A red circle indicates that scan cycle duration is too 
long and needs to be shortened for better results. Hovering the mouse pointer over the circle 
reveals a hint window with extended information and recommendations.

Current signal strength – three bar indicators (for the 2.4, 5 and 6 GHz bands) that display the signal 
strength of the APs being monitored. Clicking on the gear icons to the right of the indicators allows 
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you to specify which AP signals should be displayed. You can set the indictor to display either the 
signal of the strongest of the selected APs (by selected, we mean the APs that are checked in the AP 
list,) or the signal of the strongest AP for the selected SSID. Double-clicking on the bars toggles the 
display between signal strength in dBm and percent.

Number of APs currently visible – three text labels (for the 2.4, 5 and 6 GHz bands) that display the 
number of APs that have been seen recently.

Signal strength chart – three histograms (for the 2.4, 5 and 6 GHz bands) that display the signal 
strength history.

While performing active surveys, the dashboard panel is automatically expanded to include more data 
related to the active survey being conducted. This includes the associated AP name, channel number, PHY 
rate, noise, SNR levels (if available), and a chart that displays the metrics being measured: throughout, loss, 
round-trip time, PHY rate, and signal level. The speaker icon allows you to enable or disable signal level 
vocalization; when the button is pressed, the computerized voice will periodically pronounce the current 
signal strength as you conduct the active survey. Double-clicking on the AP name toggles the text between 
the AP name, its MAC address (a.k.a BSSID), and SSID.

Both charts can be customized by using the context menu that is displayed when you right-click on the 
charts.

Spectrum and Networks Panel

This panel provides a live view of the RF environment by displaying currently active APs on the spectrum 
chart. To display this panel, click View => Spectrum and Networks. APs are displayed taking into 
consideration their channel number(s), channel bandwidth, and signal level. Using the context menu, you 
can show one or two frequency bands (due to space constraints, displaying three bands at the same time 
is not possible), and enable or disable SSID labels and gradients. Checking the Networks => Highlight 
selected menu item allows you to highlight the network that is currently selected in the AP list on the left 
panel.

Note that the same panel is used to display spectrum data when you conduct spectrum surveys. See 
Spectrum Analysis for more information.
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Performing a Site Survey

To perform a WLAN site survey, you need to

Create a new project with the help of the Project Wizard.

Calibrate the floor plan or site map.

Configure the survey options and WLAN requirements.

Collect wireless data  by walking along the planned survey path and periodically marking your 
location on the map or using a GPS receiver. If you perform predictive modeling, you do not need to 
collect wireless data. Rather, you need to create a virtual environment. See the chapter on 
predictive modeling for more information.

The following chapters describe these steps in detail. Additionally, be sure to read Best Practices, Tips, and 
Tricks to learn how to make your site surveys fast, efficient, and accurate.

New Project Wizard

To create a new project, click Project => New. A wizard window will appear.

Step 1

Specify the Name,  Description (optional), and Project path. The name you give to the project is used as 
the file name under which your project will be saved in the folder specified in the Project path field.

Step 2

In this step, you should Select an environment. The Environment panel allows you to configure some of 
the very important project parameters that affect the way data visualizations are computed. Because 
different environments have different characteristics in terms of signal attenuation, diffraction, reflection, 
etc., you are asked to select the environment that best describes the site you plan to survey. For each 
environment, the application recommends a Guess range. A guess range is the diameter of the circle for 
which the application predicts the WLAN characteristics with a high degree of certainty. For passive 
surveys, TamoGraph can also compute WLAN characteristics outside the guess range zone, although such 
computations have a lower degree of accuracy. Check the Extrapolate data beyond the guess range box 
to enable such computations. Enabling this option means that data visualizations  will cover the entire 
map rather than the areas that you actually surveyed. Enabling this option is not recommended unless you 
cannot survey some areas of the map for whatever reason. Finally, the Measurement units control can be 
used to choose the preferred units (feet or meters) for displaying distances and coordinates throughout 
the application. See the Environment chapter for more information.
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Step 3

Select the Channels to scan. The application scanner sweeps through the channels supported by the 
wireless adapter to collect and analyze packets being sent on the selected channels. You may want to 
modify the channel selection if you know that some of the channels supported by the wireless adapter are 
not used in your WLAN or in your country. For example, if your WLAN does not use the 5 GHz band, you 
may want to turn off all 5 GHz channels; this will shorten the scanning cycle and, therefore, increase the 
data accuracy. However, please keep in mind that skipping some of the channels may result in the 
application's inability to detect sources of interference, such as neighboring APs that work on the channels 
that were skipped. It is recommended that you not modify the default Scan interval  and Use the same 
interval for all channels settings at this stage. See the Scanner chapter for more information. You can use 
the Select channels button for selecting or deselecting all channels, as well as for selecting channels based 
on the country- or region-specific allowed channel lists (e.g., choosing  United States  will select channels 
1-11 and deselect channels 12-14 in the 2.4 GHz frequency band).

This wizard step is skipped if your computer is not equipped with a compatible 
wireless adapter. You might still want to create projects on such computers if you 
plan to conduct active surveys or use the survey job splitting—i.e., if the data 
collection process is performed on other computers and the collected data is then 
merged on your computer.

Step 4

In the final step, you should add an image file that contains the floor plan or site map of the facility or area 
that you want to survey (you will be able to add more images if your project includes several zones or 
floors later.) A floor plan or site map is required for accurate data analysis. If no image file is available, you 
may want to scan a plan, if it exists on paper, create one using a drawing program, such as CorelDraw, or 
even make a sketch using a ruler and pencil and then scan the sketch (be sure to follow the proportions). 
The image file should be between 250 and 2,500 pixels on a side (naturally, this applies to raster formats 
only; vector images, such as DWG, do not have pixel dimensions). Larger images will slow down the 
application. The following image file formats are supported on Windows: BMP, PNG, JPG, GIF, WMF, TIFF, 
PDF, DWG, DXF, and SVG. The following image file formats are supported on macOS: BMP, PNG, JPG, GIF, 
TIFF, PDF, DWG, DXF, and SVG.

If you add an AutoCAD image (DWG or DXF), an additional import settings dialog is displayed. This dialog 
allows you to select a layout to be used (if the file contains multiple layouts) and include or exclude 
specific layers. For example, you may want to exclude the plan legend. You can also crop the floor plan to 
define a specific zone to be used for surveying.

The application also supports PDF files. When you use a PDF file, an additional import settings dialog is 
displayed. This dialog allows you to select a page to be used (if the file contains multiple pages). 
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Alternatively, you can use any of the images embedded into the PDF file; such images are listed on a 
separate tab. You can also rotate or crop the floor plan to define a specific zone to be used for surveying.

If you plan to perform a large-area GPS-assisted survey, you may want to import a map from one of the 
online map services. Click Load Street Map to open a new map loader dialog. Once the initial map view is 
loaded (the application will try to guess your location based on the Wi-Fi environment), you can navigate 
to the area you want to survey, using the map controls or the Navigation  frame, in which you can enter 
your coordinates, or read them from the GPS receiver, or enter your address. Click Go to Location to load 
the map of the corresponding area. When you are satisfied with the area selection and zoom level, click 
Use Map. Note that the application will use the map image as you see it, with the selected zoom level and 
size in pixels as in the map loader window (the window can be resized). Be sure to select the area correctly 
and to set a zoom level that meets your needs, as you will not be able to resize the map or zoom in/out at 
a later time. When you open the map loader window, TamoGraph temporarily returns control over your 
Wi-Fi adapter to the operating system so that you can connect to the Internet and load the map. If a Wi-Fi 
connection to your AP is not established, connect your computer to the Internet over a wired connection, 
close the map loader window, and open it again.

Calibration

 Once the project has been created, you will be prompted to calibrate the floor plan 
or site map. Calibration is the process by which you “tell” the application about the 

map dimensions (and coordinates, if you perform a GPS survey). Depending on the survey mode selected 
on the toolbar, clicking the Calibrate button on the toolbar (the right button on the illustration) will allow 
you to perform either standard (non-GPS) calibration or GPS calibration. GPS calibration is performed if 
the GPS survey mode is selected (the “satellite” button on the illustration). In all other cases, standard 
calibration is performed.

Standard Calibration (non-GPS)

To calibrate the map in this mode, you need to know the distance between two points on the map. That 
can be the distance between two walls or windows. Click on the first point of the distance, and move the 
mouse pointer to the second point while holding down the left mouse button. Release the left mouse 
button when the mouse pointer is over the second point. A red line indicating the distance will be shown. 
At the bottom of the screen, enter the length of the red line and click Apply.

GPS Calibration

GPS functionality is available to Pro License users only.
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To prepare the map for a GPS survey, you need to add at least three reference points with known 
geographic coordinates. To create a new reference point, click Add new  and drag the point marker to a 
location on the map whose coordinates you want to enter. After that, you can do one of the following:

Enter the coordinates of that point if you know them, or

Walk or drive to that point and use your GPS receiver to get your current coordinates.

If you use the first method, simply enter the latitude and longitude of the new point in the corresponding 
fields on the left in one of the standard coordinate formats—e.g., 50.435237, 50° 26' 6.85" N, or 50° 26.114' N. 
Be sure to double-check the numbers that you enter. Entering precise coordinates is extremely important 
for the accuracy of the subsequent data collection and analysis. If you use the second method, turn on 
your GPS receiver, connect it to your computer, and click Get from GPS Receiver. TamoGraph will then 
connect to the GPS receiver (or display a GPS configuration dialog, if you have not configured it) and read 
your current coordinates. Once the  latitude  and longitude  have been entered, click Set  to save the 
coordinates of the first point.

Repeat these steps for all points. The points should be as far apart as possible and not located on a straight 
line. You can enter more than three reference points, but this is usually not necessary if your site map has 
correct proportions. Click Apply when done.

Configuration

Before proceeding to data collection, you may want to configure some of the application settings and 
project properties, although this is not mandatory. Available settings and options are described in the 
Configuring TamoGraph chapter. Specifically, it is recommended that you configure WLAN requirements. 
This is helpful for a quick and easy evaluation of the overall health of your WLAN and detection of 
potential issues.

Adapter Signal Level Correction

Because TamoGraph supports a large number of different Wi-Fi adapters in various form factors, using 
various antennas, it is impossible to ensure that the signal level readings provided by these adapters are 
exactly the same. You may want to correct the signal levels reported by your adapter using the 
functionality described below, so that passive surveys conducted using different adapters would have a 
similar baseline.

This feature is intended for advanced users only. Please do not utilize it unless you 
have a very good understanding of what exactly you are doing. If you want to 
simulate clients with different adapter sensitivity levels, consider using the Client 
Capabilities configuration instead.
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To access this functionality, either click Settings => Adapter Signal Level Correction or double-click on 
the adapter name in the left corner of application the status bar. The configuration dialog allows you to 
specify a pair of negative or positive values (one per frequency band) in dBm by which the raw signal 
levels reported by the adapter will be corrected. The values that you enter are saved as a preset associated 
with the specific adapter model. If you use different adapters, each adapter will have its own correction 
levels (if any are specified). Clicking Reset sets the correction levels to zero.

Once you have entered the values and clicked OK, the specified correction levels (if they are non-zero) will 
be shown next to the adapter name in the status bar. This allows you to see if any corrections are being 
applied without opening the configuration dialog.

Corrections affect all packets received during passive surveys, as well as the real-time signal levels shown 
in the AP list on the left panel. Corrections DO NOT affect data recorded in previously conducted surveys; 
they are NOT retroactive.

Data Collection

Once the project configuration has been completed, you are ready to perform the actual 
survey by walking the site with a laptop that runs TamoGraph (unless you perform 

predictive  modeling, where no on-site data collection is necessary). To facilitate the data collection 
process, TamoGraph offers three survey modes that can be selected by pressing the corresponding buttons 
on  the toolbar: Continuous (the left button on the illustration), Point-by-Point (the middle button on the 
illustration), and GPS (the right button on the illustration) for GPS-assisted outdoor surveys.

GPS functionality is available to Pro License users only.

In the default continuous mode, after you mark your initial location on the map by clicking on it, the 
application scanner continuously scans the air by sweeping through the Wi-Fi channels. When you mark 
the next location on the map, the data that has been collected between the two clicks on the map is 
spread evenly along the path between the two data points. This means that your path should consist of 
straight lines and that you should walk steadily, clicking on the map every time you change direction.

In the point-by-point mode, TamoGraph collects data only when you click on the map. In that mode, you 
should stay where you are after marking your location on the map, until the scanner completes the cycle. 
Then the scanner stops, until you mark your next location, where the scanner makes another full cycle. 
This means that your path can have any shape, but less data will be collected, as compared to the 
continuous mode, and a smaller area will be covered.

In the GPS mode, the data collection process is similar to the one in continuous mode, but th e location is 
automatically determined by the GPS receiver connected to the computer. Continuous  and  Point-by-
Point surveys can be conducted both indoors and outdoors; GPS surveys can be conducted outdoors only, 
as GPS receivers cannot receive location data when indoors.
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Before you begin, spend some time thinking through your walkabout path. Decide which areas you need 
to survey and how you are going to do that. Remember that it is quite all right to mix the three data 
collection modes—that is, you can survey some areas where walking steadily in a straight line is not a 
problem in continuous mode; you can then survey other areas in point-by-point mode, and then survey 
the area outside the building in GPS mode. You can also stop the survey at any moment and continue 
after a break, as you can select several survey segments for data analysis. Once you have thought through 
your walkabout path, begin the actual survey.

TamoGraph allows you to perform two types of surveys: active  and passive  (or both at the same time). 
Every time you start data collection, you will be prompted to select the type of survey, as shown below.

It is extremely important to understand the difference between the two survey types, as they focus on 
different WLAN characteristics. Please refer to Understanding Survey Types: Passive, Active, and 
Predictive  for more information. When performing an active survey, an additional configuration dialog is 
displayed before you can start data collection. This dialog is explained in the Active Survey Configuration
chapter. Additionally, when a compatible spectrum analysis device is connected to the computer, you will 
be able to collect spectrum data either in parallel with a passive survey (the first dialog option will be titled 
Passive Survey + Spectrum Survey) or in spectrum-only mode (another option titled Spectrum Survey
will be added to the dialog).

 Continuous Mode:  To start data collection, click on the Start  button (illustrated on the left) and then 
mark your initial location on the map by clicking on the  corresponding spot. Walk along the 
planned path at a steady pace in a straight line. You should walk a bit slower than you normally do. 

Every time you reach the end of the straight line on your path (i.e., every time you need to change 
direction), click on the map again to mark your current location. Data collection stops when you 
click on the Stop button (illustrated on the right.) If you want to suspend data collection temporarily 

without  stopping your current survey (e.g. when you want to answer a phone call and then continue), 
click on the Pause  button (illustrated on the left) to pause the survey and then click it again to 
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resume. Important: if you paused the survey, you can move freely, but you must return to the exact 
location where you paused the survey  before you resume it, otherwise your survey data will be 

invalid.

Point-by-Point Mode: To start data collection, click on the Start button. Mark your location on the map by 
clicking on the corresponding spot. TamoGraph will collect data by scanning the channels twice and 
display a notification at the bottom of the window when all the data has been collected. Proceed to the 
next point on your path and mark your location again. Repeat until you have surveyed all the planned 
points. Data collection stops when you click on the Stop button.

GPS Mode: To start data collection, turn on your GPS receiver, connect it to your computer, 
and then click on the Start button. Your current location will be displayed on the map with 

a circle. Make sure that the displayed location matches your actual location. If it does not, you made a 
mistake while calibrating the map with reference points, and you need to re-calibrate the map. Walk or 
drive slowly along the planned path. The slower you drive, the more Wi-Fi data will be collected, and the 
more accurate the data analysis will be. GPS surveys can be conducted outdoors only, in open areas where 
a GPS receiver can see many satellites. Location data accuracy is directly related to the number of satellites 
in view. As you  move along the path, location data accuracy is indicated on the application status bar, as 
shown on the illustration. If location data accuracy becomes poor, you may want to stop the survey until 
more satellites become visible to the receiver (you can click on the data accuracy indicator to display the 
GPS receiver configuration dialog that displays accuracy level and visible satellites). Data collection stops 
when you click on the Stop button.

When you are through with the survey, you can proceed to the data analysis of a passive  and/or active
survey. However, before you do, it is recommended that you read the next three chapters, especially if you 
are new to Wi-Fi site surveys. They provide important information about the available types of surveys, 
their purpose, as well as some valuable tips and tricks to make your site surveying more efficient.

Understanding Survey Types: Passive, Active, and Predictive

There are three types of surveys that you can conduct in TamoGraph: passive, active, and predictive (the 
latter is technically not a survey; rather, it’s virtual modeling). During a passive survey, the application 
collects the most comprehensive data on the RF environment: information on access points and their 
characteristics, signal strength, noise level, interference, etc. This is the default and most important survey 
type that we recommend to conduct for every project. If you need more insight into the real-world 
performance of your WLAN, TamoGraph can also perform an active survey. During active surveys your 
Wi-Fi adapter connects to the wireless network(s) of your choice and the application generates network 
traffic to measure actual throughput rates and a few other metrics. In addition to the surveys based on 
actual on-site measurements, TamoGraph can be used for planning WLANs that have not been deployed 
yet. This is called “RF predictive modeling” or “RF planning”, because Wi-Fi characteristics are predicted 
for the virtual environment model created by the user. The virtual model includes walls and other 
obstructions, as well as virtual APs placed by the user. In other words, it is a computer simulation. No on-
site measurements are conducted.
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The table below summarizes the distinctions between the survey types. Please read this information 
carefully to make sure you fully understand which survey type you need.

Passive Surveys Active Surveys
Predictive 
Modeling

When to 
conduct

Highly recommended at all 
times. The most 
comprehensive survey type 
that covers the most 
important WLAN 
characteristics and metrics.

Optional. Conduct when 
measurement of real-world 
performance characteristics 
of your WLAN is required.

Optional. Conduct 
before deployment 
to plan your WLAN 
and simulate its 
characteristics.

Hardware 
requirements

On Windows, a compatible 
wireless adapter is required. 
For the up-to-date list of 
compatible adapters, please 
visit our website. On 
macOS, no specific adapter 
is required; the application 
will work with the built-in 
adapter of your MacBook.

On Windows, virtually any 
modern wireless adapter 
with the latest drivers 
supplied by the adapter 
vendor will work. On 
macOS, no specific adapter 
is required; the application 
will work with the built-in 
adapter of your MacBook.

A fast multicore 
CPU. Intel i7 is 
highly 
recommended. No 
wireless adapter is 
required.

Additional 
software 
configuration 
requirements

None You must create a Windows 
profile for the WLAN you 
plan to test. On macOS, the 
WLAN you plan to test must 
be listed under Preferred 
Networks. If you plan to 
measure TCP and/or UDP 
throughput, you must also 
run the throughput server 
utility on the wired side of 
your WLAN.

None

How data is 
collected

The application passively 
listens for packets and does 
not attempt to connect to 
WLANs.

The application connects 
your Wi-Fi adapter to the 
wireless network(s) of your 
choice to measure actual 
throughput rates and a few 
other metrics.

No on-site data 
collection is 
performed. Data is 
simulated based on 
the virtual 
environment that 
you created.

https://www.tamos.com/download/main/tg
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Available 
visualizations

Signal Level
Signal-to-Noise Ratio
Signal-to-Interference Ratio
AP Coverage Areas
Number of APs
Expected PHY Rate
Frame Format
Channel Bandwidth
Requirements

Actual PHY Rate
TCP Upstream Rate*
TCP Downstream Rate*
UDP Upstream Rate*
UDP Downstream Rate*
UDP Upstream Loss*
UDP Downstream Loss*
Round-trip Time
Associated AP
Requirements

Same as for passive 
surveys

List of APs and 
their 
characteristics is 
available

Yes No Yes

Surveys can be 
conducted 
simultaneously

On Windows – yes. You can conduct a simultaneous Active 
+ Passive survey if your computer is equipped with two 
different Wi-Fi adapters. One of them must be compatible 
with passive surveys; for the up-to-date list of compatible 
adapters, please visit our website. On macOS – yes, if you 
use one of the compatible USB adapters for the passive 
part of the survey and the built-in MacBook adapter for the 
active part of the survey.

Not applicable

* When using advanced mode with a throughput server utility connection. See Survey Type Selection for 
more info.

As mentioned above, some additional software configuration is required when performing an active 
survey. The next chapter provides detailed information on how to configure TamoGraph for an active 
survey.

Active Survey Configuration

When you click the Active Survey  or Active + Passive  button in the survey type selection dialog, an 
additional configuration dialog is displayed as shown below.

https://www.tamos.com/download/main/tg
https://www.tamos.com/download/main/tg-macos
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This dialog allows you to configure TamoGraph for an active survey you are about to conduct.

Adapter Selection

The adapter selection section can be used to specify which Wi-Fi adapter to utilize for an active survey and 
which one for the passive survey (if you are conducting both survey types simultaneously, in the Active + 
Passive mode.)

If your computer has only one Wi-Fi adapter, you cannot change the default selection; that adapter 
will be used for the active survey.

If your computer has two Wi-Fi adapters and you are conducting both survey types simultaneously, 
in the Active + Passive  mode, you cannot change the default selection, either; the adapter that is 
compatible with passive surveys will be used for the passive part of the survey, while the other 
adapter will be used for the active part of the survey.
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1.

2.

If your computer has two Wi-Fi adapters and you are conducting an active survey only, you can 
select either of the two adapters. We recommend that you use the integrated adapter for active 
surveys. For example, if your laptop comes with an integrated Wi-Fi Intel adapter and you also use a 
Wi-Fi USB adapter, select the integrated Intel adapter.

Please keep in mind that the WLAN metrics that are measured during an active survey depend on the 
capabilities of your adapter. If your adapter's capabilities are inferior to the capabilities of your WLAN, this 
will be reflected in the results obtained during the survey. For example, if your APs support the 802.11ax 
standard with the maximum rate of over a thousand Mbps, whereas your Wi-Fi adapter is a legacy 802.11ac 
device with the maximum rate of 867 Mbps, the measured PHY rate and throughput rates will never 
exceed 867 Mbps, thereby giving you an underrated picture of the WLAN performance.

Connection Mode Selection

There are two connection methods for performing active surveys: the SSID method and the MAC address 
method (also frequently referred to as the “BSSID method”).

The SSID method allows the client to associate to the selected SSID and roam between multiple 
APs that share the selected SSID. This mimics real-world client roaming behavior. Note that some 
adapters let you adjust roaming thresholds; these roaming settings might affect the performance 
data.

The MAC address method locks a client into the MAC address of the AP and prevents the client 
from roaming. This allows you to analyze the connectivity zone and performance metrics of a single 
AP.

Note that for the MAC address method to work, support of this functionality is 
required from the operating system and the driver. The combination of the adapter 
model, OS, and the driver determine whether this method will work. If TamoGraph 
notifies you that this method is not supported, use the SSID method and create a 
temporary SSID specific to a single AP, which will let you bypass this problem.

Which of the two methods you choose depends on the specific purposes of your survey. The first method 
is typically used in post-deployment scenarios, while the second one is typically used on the deployment 
stage. If you use the first method, select the desired SSID from the drop-down list. If your WLAN doesn't 
broadcast its SSID, select the <Non-broadcast SSID>  item and you will be prompted to choose the 
network profile for that WLAN at a later stage. If using the second method, select the desired AP from the 
drop-down list.

Because performing active surveys involves a full association to a WLAN, you must properly configure 
security settings prior to the survey. Be sure to follow this checklist:
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When TamoGraph is not running, make sure that the client adapter you plan to use for active 
surveys can connect to the AP(s) and/or SSIDs you plan to connect to during an active survey. This 
must be a single-click connection right from the Wi-Fi system icon of Windows or macOS. You must 
not be prompted for any additional credentials. If a username or password is required, they must be 
cached by Windows/macOS. If other authentication, such as a smart card, is required, it too must be 
performed without requiring any user input.

Using third party authentication supplicants is not supported; the OS must be able to complete 
authentication by itself. In other words, a valid network profile for the given WLAN and the selected 
client adapter must exist in the OS.

Sometimes existing WLAN security configuration does not allow you to associate under the 
conditions described above. In such cases, we suggest that you create a temporary SSID with no or 
WPA-PSK security. Create a firewall rule to prevent clients using that temporary SSID from accessing 
any important intranet resources and delete that temporary SSID when you are done with the 
survey.

Survey Type Selection

Once an active survey has been started and the client associated to a WLAN, TamoGraph begins to 
measure client performance. You can select the Basic or Advanced active survey type.

In the Basic mode, the client sends pings to the computer on the wired side of the network at the specified
IPv4 or IPv6 address. This mode is the easiest to configure: Simply enter the IP address of a host that can 
respond to ping packets (this may be a computer or other ping-capable type of hardware, e.g., an AP.) 
Make sure that the firewall rules on the client side and the host side permit ping (also known as ICMP) 
request and response packets. The drawback of the Basic mode is that no data throughput measurements 
can be performed. Only the following visualizations will be available: Actual PHY Rate, Round-trip Time, 
Associated AP, and Requirements.

In the Advanced  mode, TamoGraph connects to a throughput test server utility on the wired side of the 
network at the specified IPv4 or IPv6 address  and port. During the survey, TamoGraph is continuously 
sending and receiving packets to/from the server utility and records performance data. This mode is a bit 
more difficult to configure, but you get much more data as a result of throughput testing. In addition to the 
Actual PHY Rate, Round-trip Time, Associated AP, and Requirements visualizations, you also get TCP 
Upstream and Downstream Rate, UDP Upstream and Downstream Rate, and UDP Upstream and 
Downstream Loss.

The only additional step required to use the Advanced mode is copying the throughput test server utility 
from the computer where TamoGraph is installed to the host on the wired side of the network and 
running the utility. On 32-bit Windows, the utility executable file can be found at:

C:\Program Files\TamoGraph\ThroughputTest\TTServer.exe

On 64-bit Windows, the utility executable file can be found at:

C:\Program Files (x86)\TamoGraph\ThroughputTest\TTServer.exe
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You will see the utility window as shown below.

Alternatively, the throughput test server utility for Windows or macOS can be downloaded from our 
website at https://www.tamos.com/products/throughput-test/. It is part of our freeware product, 
TamoSoft Throughput Test. Install the product and use the Run Server command.

In the Active Survey Configuration dialog, select the protocols you want to test: TCP (default) or TCP+UDP, 
if you are interested in UDP performance metrics, too. Advanced users may want to change the QoS traffic 
type (described in the next chapter.)

You are now ready to start an active survey. Always start active surveys when you are close to the AP your 
client will connect to, in the area where the signal level is high. This will allow the application to quickly 
validate the settings and start data collection. DO NOT start active surveys in the areas where the signal 
level is insufficient for stable connectivity. Click Verify and Start to proceed.

QoS Testing

If you are not an advanced user and not familiar with the concept of QoS, you do not need to read this 
chapter; just leave the default Best Effort selection in the QoS traffic type control and begin the survey.

Advanced users might want to use the QoS traffic type  control to specify the Quality of Service traffic 
type  that will be associated with the TCP and UDP data streams that are sent and received by the 
application. A description of the use of QoS and related standards and technologies, such as WMM, 802.11e, 
DSCP, and 802.11p, is beyond the scope of this manual, but in brief, you might want to use this functionality 
t o check how different QoS traffic types affect throughput. In a properly designed WLAN that uses 
enterprise-class APs, throughput values for high-priority traffic should exceed those for normal-priority 
traffic.

https://www.tamos.com/products/throughput-test/
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The table below summarizes different QoS traffic types that may be used. Please pay attention to the fact 
that not all the QoS types available in the application and described below have corresponding WMM 
access categories. In practice, this means that when you select a QoS type that has no WMM mapping, 
your Wi-Fi adapter driver might fail to QoS-tag packets at all.

QoS Type Description

Best Effort Flow traffic has the same network priority as regular traffic not associated with QoS. This 
traffic type is the same as not specifying priority, and as a result, the DSCP mark and 
802.1p tag are not added to sent traffic. Corresponds to the WMM AC-BE access 
category.

Background Flow traffic has a network priority lower than that of Best Effort. This traffic type could 
be used for traffic of an application doing data backup. Sent traffic will contain a DSCP 
mark with a value of 0x08 and an 802.1p tag with a value of 2. Corresponds to the 
WMM AC-BK access category.

Excellent 
Effort

Flow traffic has a network priority higher than Best Effort, yet lower than AudioVideo. 
This traffic type should be used for data traffic that is more important than normal end-
user scenarios, such as e-mail. Sent traffic will contain a DSCP mark with value of 0x28 
and 802.1p tag with a value of 5. This does not correspond to any WMM access 
category.

AudioVideo Flow traffic has a network priority higher than Excellent Effort, yet lower than Voice. 
This traffic type should be used for A/V streaming scenarios such as MPEG2 streaming. 
Sent traffic will contain a DSCP mark with a value of 0x28 and an 802.1p tag with a value 
of 5. Corresponds to the WMM AC-VI access category.

Voice Flow traffic has a network priority higher than AudioVideo, yet lower than Control. This 
traffic type should be used for real time voice streams such as VOIP. Sent traffic will 
contain a DSCP mark with a value of 0x38 and an 802.1p tag with a value of 7. 
Corresponds to the WMM AC-VO access category.

Control Flow traffic has the highest network priority. This traffic type should only be used for the 
most critical of data. For example, it may be used for data carrying user inputs. Sent 
traffic will contain a DSCP mark with a value of 0x38 and an 802.1p tag with a value of 7. 
This does not correspond to any WMM access category.

Best Practices, Tips, and Tricks

If the WLAN being surveyed has SSID broadcasting disabled, enable it for the duration of the survey, 
if possible. This will facilitate the identification of the APs you would like to have included in the 
data analysis.
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Fully charge your laptop and be prepared to recharge it. Having an extra battery on hand would not 
hurt. However, if your laptop goes into standby or hibernation while you are performing a survey, 
TamoGraph will save the data and stop the active survey. You will be able to continue where you 
stopped.

When you conduct GPS surveys, the survey process is fully automated; normally you do not need to 
touch any application controls, so you may want to close the laptop lid. If you plan to close the lid, 
be sure to configure the laptop power settings to prevent the laptop from going into standby or 
hibernation when you close the lid.

Plan your walkabout path in advance. You may want to write down numbers on the site map 
marking your path. Then, while surveying, you would just have to walk along the path and click on 
these numbers. When planning your path, be sure to plan it so that you capture the perimeters of 
the rooms rather than their center. This improves data quality.

If you care about signal leakage outside the building, plan your path along the outside building 
perimeter. Without this perimeter, TamoGraph will not be able to estimate the signal strength 
outside the walls.

Be sure to cover places of special importance, such as conference rooms or the CEO's office. Survey 
them with closed doors. Closed doors may considerably decrease the signal level, so surveying with 
open doors may give you a signal coverage map that is too optimistic.

If the site is large, consider splitting the site map into several parts, as working with smaller maps is 
easier. Besides, the report generated by TamoGraph will be more meaningful if separate maps are 
used for separate zones. A large map just will not be legible if has to be displayed on one page. You 
can have as many maps as you wish in a single TamoGraph project. The same applies to multi-floor 
buildings.

If the site is large, you can also split the job between several people sharing the same project. The 
correct way of doing this is described in the Survey Job Splitting chapter.

If you are going to survey a large facility with many employees during business hours, make an 
announcement telling them that someone will be conducting a survey. Ideally, this will prevent 
them from distracting you with questions.
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Survey Job Splitting

While performing surveys of large sites, it is sometimes convenient to split the data collection process 
between several employees who would walk the site independently, each of them surveying a separate 
area. Once the data has been collected, the separate surveys can be merged into a single project. Using 
TamoGraph, you can easily organize this mode of operation, as explained below.

If you plan to perform a site survey alone, using a single laptop, you do not need to read this chapter.

Step 1

Create a new project  and calibrate  the map. Save the project and copy the project file to the portable 
computers that will participate in the data collection process. The computer that is used for creating the 
project does not necessarily have to be equipped with a compatible wireless adapter. It can be a desktop 
computer.

Step 2

Open the project file in TamoGraph on each of the portable computers to which you copied the project 
file. Discuss how to split the survey job between your associates and assign different areas of the site map 
to them so that each of them surveys a separate area.

Step 3

Using the portable computers, your associates can now walk the site and survey the designated areas. 
When the area is fully surveyed, save the project and then click Survey => Export Survey Data in the main 
application menu. A dialog box will appear, and the user will be able to select the survey path(s) to be 
exported. Click Export to save the data to a file with the .SSTRACK extension.

Step 4

Copy the survey data files created on the portable computers back onto the main computer. Open the 
project that you used for the job splitting in Step 1. Click Survey  => Import Survey Data in the main 
application menu, select the SSTRACK  file to import, and then select the survey path(s) to be imported. 
Repeat this for all the SSTRACK files you copied from the portable computers.
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Step 5

The Plans and Surveys tab on the right panel now contains all the survey paths that were created by the 
different users who surveyed the site in parallel. Save the project. You are now ready to analyze the data
as normal.

Tips and Tricks

When you analyze the data collected by other computers, you typically do not need TamoGraph to scan 
Wi-Fi channels (if the computer is equipped with a wireless adapter) or display the driver installation guide 
(if the computer is not equipped with a wireless adapter). To turn off the scanner and prevent the driver 
installation guide from appearing, launch TamoGraph with the /scanneroff command line switch.
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RF Predictive Modeling

Predictive modeling is available to Pro License users only.

In addition to the surveys based on actual on-site measurements, TamoGraph can be used for planning 
WLANs that have not been deployed yet. This type of planning is called “predictive” or “virtual,” because 
Wi-Fi characteristics are predicted for the virtual environment model created by the user. The process of 
creating and adjusting the virtual environment, selection and placement of simulated APs, and analysis of 
the resulting WLAN is commonly referred to as “RF modeling” or “RF planning” (“RF” stands for Radio 
Frequency).

To create a predictive RF model, you need to:

Create a new project with the help of the Project Wizard.

Calibrate the floor plan or site map.

Configure the survey options and WLAN requirements.

Create a model of the environment. This includes placing walls and other obstructions on the floor 
plan, as well as placing APs and editing their properties.

To create a virtual model of the environment, the user needs to “tell” the application about the position, 
size, and type of the physical objects that affect radio wave propagation. Typically, walls and other 
obstructions, such elevator shafts, are already shown on floor plans; however, these are merely lines and 
dots that are meaningless to the application. The user has to draw such physical objects on top of the floor 
plan and define their characteristics.
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To start creating a virtual model, press the RF Planner button on the toolbar. This will show an additional 
toolbar with a few drawing tools. It is recommended to begin by drawing walls. Once the walls have been 
drawn, you can place APs on the floor plan, decide how many APs you need to provide adequate 
coverage, select the best positions for the APs, and configure their parameters (channel numbers, rates, 
antennas, etc.)

Once you have completed this process, you can analyze data as you normally do after a passive survey. If 
you are a novice in WLAN design, we also suggest that you read about Best Practices, Tips, and Tricks at 
the end of this chapter.

You must always verify that your WLAN design works as expected by conducting a 
real survey after deploying your WLAN. Predictive models cannot take into 
consideration all the factors that might affect real-world WLAN performance and 
therefore cannot fully substitute on-site surveys.

Remember that the accuracy of your results depends on the data you enter into the model. Ensure that 
you collect full business and technical requirements before you begin RF modeling. Know what types and 
numbers of client devices will be used, where and what applications they will use, and whether there are 
any mission-critical client devices that you need to consider. In addition, consider possible future changes 
and upgrades.
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Drawing Walls and Other Obstructions

To draw a wall or other obstructions (e.g., doors or windows) on the floor plan, press the wall drawing tool 
button and select one of the pre-defined wall types, for example “Brick wall” or “Interior office window.” 
You should select the type that best matches the actual wall you are going to draw. You can also select 
one of the two drawing modes: Line  or Polygonal path. If you selected the Line  mode, left-click on the 
floor plan to start a new wall and left-click once again in a new location to finish the wall. A straight line 
representing the wall will be drawn. If you selected the Polygonal path mode, left-click on the floor plan 
to start a new wall and left-click every time you need to start a new line segment. This will draw a 
connected series of line segments. If you hold the Ctrl key (on Windows computers) or the Shift key (on 
macOS computers) while drawing walls, the line is drawn in orthogonal mode (0, 90, 180, or 270 degrees). 
If you need to cancel the previous move, right-click on the shape and select Undo Last Segment  in the 
context menu. To finish the wall, click on the last point or press the ESC key. You can move or resize the 
walls that you have drawn. To move a wall, select it and drag it with the left mouse button to a new 
position. To resize a wall or wall segment, select it, move the mouse over the vertex (shown as a white 
circle), click on it, and drag it with the left mouse button to a new position.

Please note that there is no need to redraw similar obstructions manually; you can simply copy and paste 
objects individually or in groups. For example, you can copy a set of walls, doors, and windows from one 
room and paste it to another. See Copying, Pasting, and Deleting Multiple Objects for more information.

After the wall has been drawn, you can change its properties in the Obstruction Properties  dialog. To 
display this dialog, double-click on a wall or select the  Properties  context menu item. In the dialog 
window, you can change the obstruction type by selecting one of the existing presets or modify 
obstruction characteristics such as attenuation, reflection, or color. Attenuation  is a drop in strength 
measured in dB that the RF signal experiences when it passes through the obstruction. Because materials 
might attenuate differently at different frequencies, there are two separate attenuation values for 2.4 and 
5/6 GHz. You can enter a custom attenuation value. A custom value can be obtained by measuring signal 
strength on each side of the obstruction and calculating the difference. Measurements can be performed 
using TamoGraph or any WLAN analyzer, e.g., CommView for WiFi. Reflection  is a percentage of signal 
strength that is reflected by the obstruction at the 90° angle. Color is an arbitrary color used to show the 
obstruction on the floor plan. If you prefer obstructions to appear colorless (i.e., grayscale), you can 
configure the application to grayscale them in the Visualization Settings  panel. When you have edited 
obstruction properties, you can save the current configuration for future use by clicking the Save as Preset
button at the bottom of the dialog window.

You can also select an existing preset, modify it, and click Save to save it under the same name. To save it 
under a different name, change the preset name before clicking Save. Click New to create a new preset 
from scratch. To delete an existing preset, click Delete.

Consider creating separate custom presets for each wall or door type in your project even if they match 
existing presets. This allows you to change the values or colors of all similar objects with a few clicks, as 
shown below:
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Drawing Attenuation Zones

An attenuation zone is an area where the signal strength drops over distance. This makes it different from 
walls and other obstructions, where the drop occurs only one time, when the signal passes through a 
specific object, and where the object thickness is negligible. To draw an attenuation zone on the floor plan, 
press the attenuation zone drawing tool button and select one of the pre-defined attenuation zone types; 
for example “Elevator shaft” (there is also a zone type titled “Floor Area” that is not an attenuation zone per 
se; we will talk about this in the Working with Multi-floor Sites chapter). You should select the type that 
best matches the actual attenuation zone you are going to draw. You can also select one of the two 
drawing modes: Rectangle mode or Polygon mode. A rectangle is defined by its top left and bottom right 
corners; it is aligned vertically/horizontally and cannot be rotated. Polygons consist of multiple line 
segments, allowing more complex shapes to be created. If you selected Rectangle mode, left-click on the 
floor plan to start a new zone, drag the mouse to form a rectangle, and release the left mouse button to 
finish. If you selected Polygon mode, left-click on the floor plan to start a new zone and left-click every 
time you need to start a new line segment. This will draw a connected series of line segments. If you hold 
the Ctrl  key (on Windows computers) or the Shift  key (on macOS computers) while drawing, the line is 
drawn in orthogonal mode (0, 90, 180, or 270 degrees). If you need to cancel the previous move, right-click 
on the shape and select Undo Last Segment  in the context menu. To finish the zone, click on the last 
point, or press the ESC key, or click Done on the info panel below the floor plan. You can move or resize 
the zone borders that you have drawn. To move a zone, select it and drag it with the left mouse button to 
a new position. To resize a zone or zone segment, select it, move the mouse over the vertex (shown as a 
circle), click on it, and drag it with the left mouse button to a new position.

After the zone has been drawn, you can change its properties in the Attenuation Zone Properties dialog. 
To display this dialog, select a zone and double-click on it, or select the Properties context menu item. In 
the dialog window, you can change the zone type by selecting one of the existing presets or modify zone 
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characteristics such as attenuation or color. Attenuation is a drop in strength measured in dB per meter (or 
foot, depending on the measurement units of your project) that the RF signal experiences when it moves 
across the zone. Because materials might attenuate differently at different frequencies, there are two 
separate attenuation values for 2.4 and 5 GHz. You can enter a custom attenuation value. A custom value 
can be obtained by measuring signal strength on each side of the zone, calculating the difference, and 
dividing it by the distance. Measurements can be performed using TamoGraph or any WLAN analyzer; e.g., 
CommView for WiFi. Color is an arbitrary color used to show the zone on the floor plan. If you prefer zones 
to appear colorless (i.e., grayscale), you can configure the application to grayscale them in the 
Visualization Settings  panel. When you have edited zone properties, you can save the current 
configuration for future use by clicking the Save as Preset button at the bottom of the dialog window.

As with the material presets, you can select an existing preset, modify it, and click Save to save it under the 
same name. To save it under a different name, change the preset name before clicking Save. You can also 
click New to create a new preset from scratch. To delete an existing preset, click Delete.

Copying, Pasting, and Deleting Multiple Objects

While working on your RF model, you can copy multiple virtual objects and paste them to the current or a 
different floor plan. To select multiple objects, hold the Ctrl key (on Windows computers) or the CMD key 
(on macOS computers) and left-click on each object you would like to add to the selection. Another click 
on the selected object removes the selection from the given object. Clicking anywhere outside the 
selection unselects all objects. Alternatively, multiple objects can be selected by drawing a frame, i.e. 
pressing and holding the left mouse button and dragging the mouse.

If multiple objects of different type are selected (e.g., APs, walls), an additional panel is displayed below the 
floor plan. Using the checkboxes on that panel, users can control which type(s) of objects should be 
included in the selection. By default, all types of objects are included..

Once the objects have been selected, you can copy them to clipboard by pressing Ctrl + C  (on Windows 
computers) or CMD + C (on macOS computers,) or by using the Edit => Copy context menu item. Copied 
objects can be pasted to the same floor plan, a different floor plan within the same project, or even to a 
floor plan in a different project. To paste objects, use Ctrl + V  (on Windows computers,) CMD + V  (on 
macOS computers,) or the Edit => Paste context menu item. You may need to adjust the pasted objects’ 
positions after pasting.

To delete multiple objects, select them as described above and press the Del key.

Undo and Redo

TamoGraph keeps track of all the changes that you make to your RF model as you work. This allows you 
to roll back your model to any previous state within the current editing session. This function is useful if 
you make a mistake and want to undo a certain action.

To access this functionality, you can use the Redo last operation and Undo last operation buttons on the 
RF planner toolbar. These buttons contain drop-down menus that list all previously performed editing 
operations. You can also use the context menu commands, Edit => Undo and Edit => Redo, as well as the 



TamoGraph Site Survey   ●   RF Predictive Modeling Page  41  of  120

keyboard shortcuts: Ctrl + Z and Ctrl + Y (on Windows computers) or CMD + Z and Shift + CMD + Z (on 
macOS computers).

Virtual APs Placement Methods

Two AP placement methods are available: manual  and automatic. If you use the manual method, you 
add virtual APs and select their locations yourself. The number of APs to place, capacity considerations, 
signal levels, and all other WLAN requirements are the responsibility of the user. If you use the automatic 
method, you let the application decide where to place APs given the requirements (e.g., the number of APs 
needed to cover each point, client capacity, etc.). The advantage of the manual method is in its utmost 
flexibility: you are in full control of the process. At the same time, this method requires experience in 
designing WLANs and may be rather time-consuming. Automatic placement is much simpler and faster, 
but the output of even the most advanced algorithm may not be ideal; AP positions may still require 
manual adjustments. Additionally, when you manually place and configure APs, you can select different 
AP models and/or antenna types; with automatic placement, all the APs must be exactly the same.

Manual Placing and Configuring Virtual APs

To place an AP on the floor plan, press the AP drawing tool button and select one of the pre-defined AP 
types; for example, “Generic 802.11ax (2.4 GHz)” or “Generic dual-band 802.11ax.” Click on the floor plan to 
place an AP in a desired location. After that, you can change its properties by double-clicking on the AP or 
by selecting the  Properties  context menu item. The  AP Properties  dialog can be used for loading AP 
characteristics from one the presets, assigning a unique name to the AP, or for customizing AP 
characteristics. Virtual AP icons are marked with a small blue “V” in the icon corner so that you could 
distinguish between real and virtual APs.

To customize an AP, you can use two tabs: one for Radio #1  (typically 2.4 GHz) and one for Radio #2
(typically 5 or 6 GHz). Both of the radios can be either configured independently and use different 802.11 
standard and bands, or share the same band and/or standard. The only restriction is that the 2.4 GHz band 
can be assigned to Radio #1 only. These tabs allow you to turn on and off these radios independently 
(using the Radio enabled check box) and configure the following characteristics for each of the two radios:

Standard. Use this drop-down list to select one of the 802.11 standards. For Radio #1, select any 
standard in any band. For Radio #2, select any standard in any band, except for the cases where this 
combination mandates the use of the 2.4 GHz band.

Channel width. If the selected standard allows channel bonding, then select one of the available 
channel widths: up to 40 MHz for 802.11n, up to 160 MHz for 802.11ac and 802.11ax, and up to 320 
Mhz for 802.11be.

Channel / Channel set. Select a single channel if the channel width is set to 20 MHz or a set of 
channels if the channel width is greater than 20 MHz.

MAC address. You can change the MAC address to your AP. This is typically not necessary because 
the application always assigns unique MAC addresses to the APs.

SSID. Use this field to assign an SSID to the AP. The same SSID may be shared by several APs.
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Power. Use this drop-down list to select the AP transmit power. Most of the APs have a transmit-
power of 17 dBm (50 mW). It is always a good idea to refer to the documentation of the specific AP 
model you plan to deploy to find this value. Remember that transmit power might depend on the 
channel frequency and band.
For the APs that work in the 6 GHz band, transmit power is configured differently. The current 
power setting is shown on the Power button caption. When this button is clicked, an additional 
dialog is displayed, in which the following options are available.

Fixed EIRP. This option simply sets a fixed EIRP value, similar to how it works in the 
traditional 2.4 and 5 GHz bands.

PSD Rules (FCC). This option allows you to configure AP power as per the Wi-Fi 6E FCC rules, 
where transmit power is defined by the Power Spectral Density (PSD). According to these 
rules, the total transmit power depends on the channel width and is capped from above. The 
FCC rules define three AP classes depending on the intended usage: Standard Power (SP), 
Low Power Indoor (LPI), and Very Low Power (VLP). You can select one of these predefined 
types.

PSD Arbitrary. This option is similar to the previous one, PSD Rules (FCC), but gives you 
flexibility in setting a PSD value and maximum power limit. This option is intended for non-
US users who live in countries where Wi-Fi 6E AP classes differ from the ones set by the FCC 
in the USA.
For a more detailed explanation of the PSD concept and AP classes in Wi-Fi 6E, please read 
the online resources here and here.

HT / VHT / HE / EHT Parameters. Use this frame to control the advanced 802.11n (HT), 802.11ac 
(VHT), 802.11ax (HE), and 802.11be (EHT) parameters: primary channel number, number of spatial 
streams, short guard interval, and supported rates. The Supported Rates  dialog can be used to 
specify the legacy and HT /VHT rates supported by the AP. It is a common practice to disable some 
or all of the legacy rates when you plan a WLAN for performance rather than coverage.

Antenna. Use this frame to specify the kind of antenna used by the AP. The Select button opens the 
antenna selection dialog (overviewed below). With the Rotation control, you can specify the angle 
(in degrees) relating to the horizontal positioning of the antenna. With the Elevation  control, you 
can specify the angle (in degrees) above the horizon, i.e., the angle by which the antenna is tilted up 
or down in relation to the theoretical horizon. With the Tilt  control, you can specify the angle (in 
degrees) relating to the vertical axis, i.e., the angle by which the antenna is tilted sideways. The 
Height  control can be used to specify the height of the AP above the floor level. The  Advanced
dialog provides top, front, right, and 3D views of the selected antenna diagram and can be used to 
adjust the antenna orientation either by rotating the diagram top, front, or right views or by entering 
numeric values.

When you have edited AP properties, you can save the current configuration for future use by clicking the 
Save as Preset button at the bottom of the dialog window.

https://www.extremenetworks.com/extreme-networks-blog/saddle-up-and-get-ready-for-wi-fi-6e-everything-is-bigger-in-6-ghz/
https://www.litepoint.com/blog/an-introduction-to-wi-fi-6e-spectrum/


TamoGraph Site Survey   ●   RF Predictive Modeling Page  43  of  120

Antenna Selection

When you click Select in the Antenna  frame, an antenna selection dialog is displayed. Using this dialog, 
you can choose from a variety of antenna models by major Wi-Fi equipment vendors or one of the generic 
antenna types. Each listed antenna has a name, vendor name, and gain. By default, the available antennas 
are grouped as follows:

Recently Used – antennas that you have recently used in your projects. Initially, this group is empty.

Generic Antennas – standard antenna types that are not associated with a specific vendor.

Vendor Antennas – antennas manufactured by major Wi-Fi equipment vendors.

Checking the Group by Vendor checkbox re-groups the list by vendor name. You can use the Quick 
search field to find antennas that match the search string. Note that the search is performed only for 
vendor antennas; recently used and generic antennas are always displayed.

Advanced users may want to add their own antenna patterns or edit existing ones by clicking the New 
antenna and Edit current antenna buttons, respectively. This will open the AntEditor utility. Please note 
that this is an experimental tool, and we do not provide official support for it. Please watch Using 
TamoSoft Antenna Editor to learn how to use this utility.

In addition, if you want to add a new antenna pattern for a specific AP and you cannot or do not want to 
do this yourself, just contact our technical support and we will add your antenna pattern to TamoGraph in 
a matter of days. Just ensure that the AP’s radiation patterns (in graphical or numerical format) are publicly 
available (or available to you, in which case you should send them to us).

Adjusting Horizontal Antenna Orientation

Once an AP has been placed on the floor plan, you can change its horizontal antenna orientation without 
opening additional dialogs. To do that, select an AP with a mouse click; you will see a ring that surrounds 
the AP icon and a triangle-shaped marker that shows the direction of the antenna’s main lobe. To modify 
the direction, hover the mouse over the triangle and, while holding the left mouse button pressed, drag 
the triangle to change the antenna’s main lobe direction.

Naturally, this operation is advisable only if you are working with directional antennas, such as sector 
antennas. For omnidirectional antennas, rotating the antenna is not needed at all.

Creating Vendor-Specific AP Presets

As described in the previous chapter, TamoGraph allows for full customization of all virtual AP parameters. 
This functionality makes it possible to create virtual AP presets that match actual hardware from major AP 
vendors, such as Cisco, Aruba, etc.

Before we explain this procedure, we would like to answer one of the most frequently asked questions:

Why do you not add vendor-specific AP presets yourselves?

https://www.youtube.com/watch?v=ZEVsnArIwL0
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1.

2.

Indeed, TamoGraph includes only a few generic AP presets, because real-world, hardware APs have 
many configurable parameters and only you know how your AP is configured. The simplest example is 
an 802.11ac AP by vendor XYZ that supports 80, 40, and 20 MHz channels in the 5 GHz band. What channel 
width should we use to add that specific AP to the list of our presets? If we select 80 MHz channel width 
and you configured your real-world AP to use 20 MHz, your virtual model will be incorrect. Adding three 
different presets is also a bad idea because channel width is not the only configurable parameter. There 
are others, such as AP transmit power, channel number, etc. Therefore, you, the WLAN administrator, 
should create unique AP presets in accordance with your unique AP configurations. This is very easy. All 
AP presets consist of two parts:

AP configuration parameters (power, channel, installation height and angles, etc.)

Antenna preset.

This can be expressed by a simple formula:

AP Preset = AP Parameters + Antenna Preset

Yet another reason we do not add vendor-specific AP presets is that many outdoor AP models do not have 
integrated antennas. Instead, the user can select from a number of external antennas, which means that 
the same AP model may have multiple antenna options and, therefore, multiple presets.

To illustrate the process, let us assume that we want to create an AP preset for a new WLAN for which we 
will use Aruba AP-325 access points. First, click on the Virtual APs tool on the toolbar and select Manage / 
Create New Presets:



TamoGraph Site Survey   ●   RF Predictive Modeling Page  45  of  120

This opens the Preset Manager  where you can modify all the AP parameters and change the antenna 
type. The screenshot below illustrates a few changes we made to the default values for the 5 GHz radio to 
ensure that the virtual AP matches the real-world Aruba AP-325 APs that we will deploy:
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The following changes have been made:

The preset name was changed to “My Aruba AP-325”.

The channel width was set to 40 MHz. Although Aruba AP-325 APs support up to 80 MHz, let us 
suppose we will limit the channel width to 40 MHz.

Let us imagine that this is a dense deployment, so the transmit-power was reduced to 12 dBm.

AP-325 APs are 4x4 MIMO devices, so the default number of spatial streams was changed to four.

Finally, we need to click Select… to change the generic antenna to one that matches the AP. As 
mentioned above, we can choose from a variety of antenna models by major Wi-Fi equipment vendors or 
one of the generic antenna types. In this case, we will select the Aruba AP-320 series antenna:
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If you cannot find a matching antenna, please refer to Antenna Selection, which lists a few options 
available to users.

You may want to click Advanced…  to examine 3D views of the selected antenna diagram and to adjust 
the antenna orientation either by rotating the diagram views or entering numeric values.

Finally, clicking OK  confirms the antenna selection. The same adjustments and antenna selection should 
be performed for the 2.4 GHz radio.

Clicking Save saves the new preset. The preset is now available alongside the generic presets in the drop-
down list. Managing AP presets is similar to managing walls or attenuation zone presets. You can select an 
existing AP preset, modify it, and click Save  to save it under the same name. To save it under a different 
name, change the preset name before clicking Save. You can also click New to create a new preset from 
scratch. To delete an existing preset, click Delete.
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Automatic Placing and Configuring Virtual APs

Note that currently automatic AP placement functionality is implemented on a per-
floor basis only. If you are working with a multi-floor project, APs from adjacent floors 
will not be taken into account when you run the auto-placement wizard. The wizard 
should be run for each floor.

Before you can auto-place virtual APs on the floor plan, you need to draw one or several areas where you 
plan to deploy the APs and where you want to have Wi-Fi coverage; this will determine future AP 
positions. You can also optionally define the number and types of WLAN clients for each area, and, finally, 
run the auto-placement wizard.

Drawing Deployment and Coverage Areas

To draw a deployment or coverage area on the floor plan, press the deployment or coverage drawing tool 
button on the RF Planner toolbar:

Select one of the pre-defined types:

Deployment Area – the area that can be used for deploying APs. Some areas in your office might 
not be suitable for AP mounting, in which case you may want to draw one or several deployment 
areas that do not cover the areas where AP mounting is undesirable.

Coverage Area – refers to the area where you need Wi-Fi coverage. Some areas in your office, such 
as bathrooms or staircases, might not need Wi-Fi coverage. In such cases, you can draw coverage 
areas that do not include bathrooms or staircases. If the coverage area does not overlap the 
deployment area, the automatic planner avoids placing APs in such “coverage-only” areas and tries 
to provide coverage using the APs located in the nearest deployment areas.

Deployment and Coverage Area  – when deployment and coverage areas fully overlap, you can 
draw the combined “deployment + coverage” area.

You can also select one of the two drawing modes: Rectangle mode  or Polygon mode. A rectangle is 
defined by its top left and bottom right corners; it is aligned vertically/horizontally and cannot be rotated. 
Polygons consist of multiple line segments, allowing more complex shapes to be created. If you selected 
the  Rectangle mode, left-click on the floor plan to start a new area, drag the mouse to form a rectangle, 
and release the left mouse button to finish. If you selected the Polygon mode, left-click on the floor plan to 
start a new area and left-click every time you need to start a new line segment. This will draw a connected 
series of line segments. If you hold the Ctrl  key (on Windows computers) or the Shift  key (on macOS 
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computers) while drawing, the line is drawn in orthogonal mode (0, 90, 180, or 270 degrees). If you need to 
cancel the previous move, right-click on the shape and select Undo Last Segment in the context menu. To 
finish the area, click on the last point, or press the ESC key, or click Done on the info panel below the floor 
plan. You can move or resize the area borders that you have drawn. To move an area, select it and drag it 
with the left mouse button to a new position. To resize an area or area segment, select it, move the mouse 
over the vertex (shown as a circle), click on it, and drag it with the left mouse button to a new position.

Configuring WLAN Clients

After the area(s) have been drawn, you may want to configure the number and types of WLAN client 
devices that you plan to service. This step is optional. When you run the auto-placement wizard 
(overviewed below), you will be prompted to select one of the three WLAN planning methods: for 
Coverage, for Capacity (simple), and for Capacity (advanced). The number and types of WLAN client 
devices will be taken into account only if you use the Capacity (advanced) method. To add clients, right-
click on a coverage or deployment + coverage area and select Properties or simply double-click on the 
area.

A Coverage Area Properties dialog will be displayed:

On the right side, you can see the list and number of clients that are currently configured for the given 
area. When you open this dialog for the first time, this list is empty. To add clients to the area, use the list 
on the left side: select one of the available client types and use the arrow button to move it to the right 
side or simply drag it to the right side. Once the new client type appears on the right side, select the item 
and change the Quantity value to reflect the actual number of clients that you want to service in this area.

Each pre-defined client type is associated with a number of typical applications. For example, Generic 
smartphone/tablet may use an e-mail client and VoIP client, but not Web browsing with access to heavy 



TamoGraph Site Survey   ●   RF Predictive Modeling Page  50  of  120

media content. To edit the applications associated with a client type, double-click on the client type or 
click the Edit client template button. To add a new client type, click the New client template button. The 
following dialog will be displayed:

In this dialog, you can configure the Name  for the client type being edited, as well as the 802.11 
characteristics of the client adapter, namely Supported standards, Channel width, and the number of 
Spatial streams. On the right side of the dialog, you can configure typical associated Applications  by 
checking or unchecking the corresponding checkboxes. Each application has a set of requirements that 
you can edit by double-clicking on the application item or by clicking the  Edit application template
button. To add a new application type, click the  New application template  button. The following dialog 
will be displayed:
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Use this dialog to configure the requirements for the selected application, or, if you are creating a new 
application, for a new one.

Once you have configured WLAN clients for all of your coverage areas, you can run the auto-placement 
wizard to place access points automatically.

Using the Auto-Placement Wizard

The auto-placement wizard is a tool for the automatic placement of access points in the predictive 
modeling process. It is an alternative to manual AP placement. The difference between the two is 
overviewed in the Virtual APs Placement Methods  chapter. To run the wizard, click on the Auto-place 
APs  button on the RF Planner  toolbar. You will be prompted to select one of the three WLAN planning 
methods:

Coverage  – Use this option to optimize your WLAN for coverage. It is assumed that the APs' 
capacity is adequate for the number of clients connected to the WLAN. The wizard will try to make 
sure that the entire area is covered by Wi-Fi without considering the number and type of clients that 
will be using the WLAN. Such planning may be used for warehouses or other areas where client 
devices do not generate much network traffic.

Capacity (simple)  – Use this option to optimize your WLAN for capacity to provide sufficient 
resources for client servicing and load balancing on a site-wide basis. To proceed, you need to 
estimate the number of APs that will service your site and enter the estimated value into the Total 
number of APs to deploy field.

Capacity (advanced) – Use this option to optimize your WLAN for capacity to provide sufficient 
resources for client servicing and load balancing on a per-zone basis. The wizard will try to make 
sure that each coverage area is covered by Wi-Fi taking into consideration the number and type of 
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clients that you have assigned to each area. This option is most useful when you specify several 
coverage areas with different requirements on the same floor, such as high-density areas with 
applications that require high throughput and low RTT vs. areas with few clients, etc.

After clicking Next, you will be prompted to select the type of APs to be deployed. You can select from one 
of the presets by clicking Load Preset  or use the configuration options on that page. Be sure to use the 
parameters, such as Power,  Spatial streams, and Antenna  type, that best match the actual APs that you 
plan to deploy. If you check Some 2.4 GHz radios can be disabled, the algorithm may turn off 2.4 GHz 
radios of some of your dual-band virtual APs to reduce co-channel interference while still meeting the 
requirements for coverage and redundancy.

One of the most important parameters to configure is the Channel width. In virtually all high-density 
enterprise deployments, you should use 20 MHz channels. There are very few use cases for 40 MHz 
channels in the 5 GHz band. Unless the use case is a small branch office or home, with clean spectrum, do 
not use channels wider than 20 MHz in the 5 GHz band. In the 2.4 GHz band, the rule of thumb is to never 
use 40 MHz  channels; there is simply no room left for channel re-use in the 2.4 GHz band if you use 40 
MHz channels.

The next page allows you to select specific channel plans for your 2.4 GHz, 5 GHz and 6 GHz radios.

For 2.4 GHz, we recommend channels 1-6-11 in the regulatory domains where 11 channels are allowed, or 
1-7-13 in the regulatory domains where 13 channels are allowed. As a backup option, you may want to use 
1-4-7-11 and 1-5-9-13, respectively; however, these setups are by no means recommended, because if you 
use four 20 MHz channels, a channel overlap is inevitable. For 5 and 6 GHz, your choice of channels is 
dictated by two key factors: the regulatory domain and the set of channels supported by your APs and 
clients. Before you select channels, first verify which of them are allowed in your regulatory domain. 
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Second, if you want to use DFS channels, verify that hardware supports them; in some APs and clients, DFS 
channels are disabled.

On the next page of the wizard, you need to specify two key Coverage requirements (note that this page 
is not shown if you have selected Capacity (advanced) as the WLAN planning method).  The Minimum 
number of APs that must provide coverage in each point value is used to determine the number of APs 
used for redundancy and seamless roaming. The With the signal level of at least  field is used to 
determine the minimum signal level in dBm provided by the APs in each point of the coverage area. It is 
important to note that the requirements may or may not be the same for the 2.4 and 5 GHz bands. For 
example, you may want to require -67 dBm in the 5 GHz band for your modern VoIP-enabled 
smartphones and tablets, but only -75 dBm for legacy 2.4 GHz devices. If you want to have the same 
requirements for both bands, use the chain-link button to make the requirements interlocked.

On the final page, you need to select the  Computation method  to be used: Standard or High precision. 
The first method uses a standard mathematical model for a quick AP placement computation. It is 
recommended for large WLANs with dozens of APs. The second method uses a much more complex 
model for a very detailed and precise AP placement computation. Because of the amount and complexity 
of mathematical computations being used in this method, the process might take a long time, especially if 
you are not running the program on a high-end, multicore CPU.

Click Done to begin the automatic AP placement computations. If you do not like the result, press Ctrl + Z
(on Windows computers) or CMD + Z (on macOS computers) to revert to the previous state.

Reconfiguring Virtual APs

In addition to automatic AP placement for new deployments where no virtual APs have been placed 
(discussed in the previous chapter), TamoGraph allows you to reconfigure an existing predictive model. 
The purpose of such reconfiguration is to optimize the channel allocation of the existing virtual APs and/or 
to adjust their output power levels to make sure that yours existing virtual APs meet the new 
requirements. Unlike automatic AP placement discussed above, reconfiguring virtual APs does not change 
the APs’ positions on the floor plan.

To run the wizard, click on the Reconfigure APs button on the RF Planner toolbar. You will be prompted 
to select one of the following reconfiguration modes:

Coverage requirements – reconfigures an existing predictive model to match new requirements for 
signal levels and the number of APs to cover the WLAN.

Channel plan – reconfigures an existing predictive model to optimize channel assignment.

Both – combines the two modes listed above.

The reconfiguration can be applied to all existing APs or to only a subset: use the Bands and AP Selection 
frame to select the Bands to reconfigure as well as to indicate whether you want to work with All APs or 
only Selected APs.
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After clicking Next, you will be prompted to select Coverage requirements (if you have chosen that 
reconfiguration mode). The Minimum number of APs that must provide coverage in each point value is 
used to determine the number of APs used for redundancy and seamless roaming. The With the signal 
level of at least field is used to determine the minimum signal level in dBm provided by the APs in each 
point of the coverage area. To reduce co-channel interference, the algorithm may adjust the output power 
of the APs to be placed. Use the Minimum AP power and Maximum AP power drop-down lists to set the 
constraints of such adjustments. If the Minimum AP power is set to Power off, the algorithm may turn off 
the corresponding radio completely. If you prefer to not have the power level adjusted, set Minimum AP 
power and Maximum AP power to the same value equal to the AP’s default output power. If you prefer to 
avoid any intermediate power level and would rather have the radio either fully turned off or work at the 
default power level, check the Don’t allow intermediate power levels box. It is important to note that the 
requirements may or may not be the same for the 2.4 and 5 GHz bands. For example, you may want to 
require -67 dBm in the 5 GHz band for your modern VoIP-enabled smartphones and tablets, but only -75 
dBm for legacy 2.4 GHz devices. If you want to have the same requirements for both bands, use the chain-
link button to make the requirements interlocked.

On the next page, you will be prompted to select a Channel plan (if you have chosen that reconfiguration 
mode).  For 2.4 GHz, we recommend channels 1-6-11 in the regulatory domains where 11 channels are 
allowed, or 1-7-13 in the regulatory domains where 13 channels are allowed. As a backup option, you may 
want to use 1-4-7-11 and 1-5-9-13, respectively. However, these setups are by no means recommended, 
because if you use four 20 MHz channels, a channel overlap is inevitable. For 5 GHz, your choice of 
channels is dictated by two key factors: the regulatory domain and the set of channels supported by your 
APs and clients. Before you select channels, first verify which of them are allowed in your regulatory 
domain. Second, if you want to use DFS channels, verify that hardware supports them; in some APs and 
clients, DFS channels are disabled.

Click Done  to begin the AP reconfiguration process. If you do not like the result, press Ctrl + Z  (on 
Windows computers) or CMD + Z (on macOS computers) to revert to the previous state.

Working with Presets

Presets are pre-configured sets of values for APs, walls, and attenuation zones (and, additionally, for floors/
ceilings, if you work with multi-floor sites). Presets can be accessed via the Manage Presets  menu item 
available in the corresponding drop-down menus for each of the three object types. At the top of the 
preset management dialog, you can see a drop-down list populated with existing presets. You can select 
an existing preset, modify it, and click Save  to save it under the same name. To save it under a different 
name, change the preset name before clicking Save. You can also click New to create a new preset from 
scratch or delete an existing preset by clicking Delete

Applying Visualizations

Data analysis for predictive models is very similar to data analysis for passive surveys; it is described in 
detail in the Analyzing Data – Passive Surveys and Predictive Models chapter. In brief, you simply need 
to select a visualization from the drop-down list on the toolbar. However, in case of predictive models, you 
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can also control the Visualization quality by using the corresponding control on the toolbar. Visualization 
quality is an important parameter that defines how precise the calculations are. High-precision calculations 
come at a cost: the higher the precision, the longer the computation time. The application offers four 
quality presets: Low, Medium, Good, and Best. They differ in grid size and in applying advanced RF 
propagation effects, such as reflection and Fresnel zones. We suggest that you use low or  medium
visualization quality while you design your WLAN and make adjustments to your design. When the design 
is ready, you can use good or best visualization quality for the final verification and/or report generation.

Calculating RF propagation is a very CPU-intensive task that might take a long time 
for large floor plans with many APs. It is recommended that you use a fast multicore 
CPU, such as Intel i7, because in this case the application could take advantage of 
parallel computations that are possible on multicore CPUs. It is also recommended 
that you split large floor plans into smaller parts if computing visualizations takes too 
long.

Working with Multi-floor Sites

When a WLAN for a multi-floor building is being designed, the virtual model must take into consideration 
signal “leak” from the adjacent floors. This is important for two reasons. First, it is a common practice to 
provide connectivity to the adjacent floor by means of the APs that are deployed one floor below or above 
(usually below, because APs are typically placed on the ceiling, and, therefore, are closer to the floor 
located above.) Second, if providing connectivity by this method is not planned, it is important to make 
sure that the signal that penetrates the floors does not cause interference. With TamoGraph, you can 
create and analyze multi-floor models as explained below.

Creating a Multi-floor Project

To create a multi-floor project, you should first follow the same steps that you follow to create a standard 
project; you must add a floor plan to the project and calibrate it. You can begin with the first floor. Once a 
standard project with a single floor plan has been created, you can use the Plans and Surveys tab on the 
right panel to manage floors and define their characteristics. Floors define the building’s vertical structure. 
Floor maps within each floor contain images of the floor plans. Click Add => Floor to create a new floor 
level. If this is the first time you have added a floor to the project and the project already contains 
previously added floor plans, you will be prompted to move the existing floor plans to the newly created 
floor. You can also do this later, by dragging the floor plans to the new floor.

After that you can click Add => Floor again to create a new floor level. If the floor plans are identical for all 
the floors in your model, you can duplicate floors after drawing walls and other obstructions on the first 
floor plan and placing alignment points; this is described in detail below. If the floors are not identical, you 
should add individual floor plans images in one of the supported graphic formats for every floor by 
selecting the corresponding floor and using the Add => Plan… command. New floor plans must then be 
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calibrated. Note that for each floor, you can add multiple floor plans that might have different scale and 
orientation.

Once the floors have been created and the corresponding floor plans have been added and calibrated, you 
should specify floor heights and a few other characteristics. New floors are added with default floor 
materials and heights; to specify correct values for your building, right-click on any of the floor items and 
select Properties or click on the Floor Manager button. You can also use this dialog to rearrange floors.

Use the Add Roof  button to add a roof on top of all floors. You can specify the material reflection and 
attenuation of the roof in the Floor/Ceiling Properties window accessible via the Modify… button. Once 
you have defined the floor and roof properties, address floor plan alignment as explained below.

Aligning Floors

When you work with a multi-floor site model, TamoGraph can analyze Wi-Fi signals that come from the 
adjacent floors. To be able to take advantage of this functionality, you need to perform floor alignment. 
Floor plan alignment is necessary because floor plans might have different scale, orientation, or offset. 
While floor alignment is not mandatory, TamoGraph will use only the data from the current floor unless 
you perform floor alignment. To perform it, please do the following:

Right-click on the first floor plan and select Align Floor Plan.

Choose a few locations on the floor plan that will be easily identifiable on the plans of other floors. 
This could be elevator shaft corners, building corners, staircase corners, or anything else that you 
can easily find on all the floor plans that you use in the project.

Click Add point to place a new marker on the floor plan, and then move the marker to one of these 
locations. Create at least two markers. Each marker is assigned a unique number. If you made a 
mistake, click Delete point or Clear all.

Once you have placed two or more alignment markers, click Apply.

Repeat this operation for all the floor plans that you would like to have aligned. The markers must 
be positioned exactly below or above the corresponding markers on the adjacent floor. For 

example, if marker #2 on the 5th floor is placed in the bottom right corner of the building, marker #2 
must be also placed in the bottom right corner of the building on the floor plan of the 6th floor.

To check the current floor alignment status, select Properties or click on the Floor Manager  button. The 
floors that are properly aligned are marked with a green checkbox. The floors that have not been aligned 
yet are marked with a yellow exclamation mark. Just like map calibration, floor alignment must be done 
only once.

Floor Duplication

If the floor plans are identical for some or all the floors in your model, you can simply right-click on the first 
floor and select Duplicate Floor  to create a copy of the first floor with exactly the same floor plan. If the 
walls and other obstructions, their placement, and materials are identical for all floors, you can calibrate a 
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single floor plan, draw walls, perform floor alignment as described above, and then use the Duplicate 
Floor  command; that way, you will not need to recreate the same virtual floor model for every floor or 
align the floors, because duplication includes the walls and alignment points. You can select which object 
types should be copied to the new duplicate. By default, all objects except virtual APs will be copied.

Dealing with Complex Floor Structures

When you use a floor manager to specify the materials that separate floors, you assume that each floor is a 
contiguous piece of material that covers the entire floor plan area. However, there are cases that are more 
complex. For example, one can find buildings that have “holes” in the floors that span one or several 
stories. To deal with such virtual models, you should use the “Floor Area” drawing tool; it is grouped 
together with attenuation zones and can be found in the corresponding drop-down list on the RF Planner 
toolbar, next to the “Elevator shaft” or “Filing cabinet” items. Floor areas are drawn just like other 
attenuation zones, using Rectangle or Polygon mode. As soon as you have drawn the first floor area on a 
given floor, the application will assume that the floor has a non-standard geometry and only those areas 
that are covered with “Floor area” contain floor material; areas that are not covered are considered free 
from any obstructions.

To avoid unnecessary clutter, floor areas are hidden by default. Their visibility can be turned on and off in 
the  View => Virtual Objects => Floor Areas  menu. We recommend hiding floor areas once you have 
completed the design of your virtual model. Additionally, for the sake of clarity, it should be mentioned 
that when you edit floor areas, you are editing the floor below your feet, not above your head. It should 
also be mentioned that the floor material and its properties are configured on the  Floor Manager, as 
discussed in the previous chapters.

Zero Attenuation Obstruction Material

A special radio-transparent floor/ceiling material can be assigned to a floor to create additional levels 
where you need to visualize coverage but that do not have a physical floor or ceiling. Such levels can be 
useful when you have obstructions like storage shelves or partial walls whose height is lower than the 
ceiling, or when you need to analyze coverage at multiple levels above the floor in a tall warehouse.

Analyzing Data

Data analysis for multi-floor sites is similar to data analysis methods for single-floor predictive models; they 
are described in the Applying Visualizations chapter. However, there are some peculiarities that should be 
noted. In addition to the signals from the APs located on the floor being analyzed, TamoGraph will also 
analyze the signals that penetrate from the APs located on the adjacent floors, taking into account their 
position, height above the floor, and the material of the ceilings. The APs located on the adjacent floors are 
displayed on the AP list (the left pane of the main TamoGraph window), but the names of such APs are 
shown using a pale blue font color. This allows you to identify the APs that do not belong to the current 
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floor. Note that you cannot change the properties of such APs or delete them. If you want to change 
properties of an AP or delete it, first select the floor to which it belongs using the Plans and Surveys tab.

Mixing Real and Virtual Data

There are situations when you may want to combine data collected during a passive on-site survey with 
the data that you get from predictive models. For example, after performing a passive survey, you might 
find out that some areas on your floor plan lack good signal coverage. To determine the number and best 
placement of additional APs, you can use virtual APs. Simply place them on the floor plan, draw 
obstructions to get a realistic RF propagation picture for your environment, and select one of the 
visualizations to see the results; data from both real and virtual APs will be mixed.

If you no longer need data from virtual APs in your project, you do not have to delete them one by one. 
You can simply click RF Planner => Virtual Model to show or hide all virtual APs and other objects used in 
predictive models. This will also exclude influence from virtual APs on all visualizations.

Best Practices, Tips, and Tricks

Designing WLANs is a complex task that requires a thorough understanding of the underlying technology 
and design principles. If you are new to WLAN design and deployment, we strongly recommend that you 
read a good book on this topic, such as The Certified Wireless Design Professional Official Study and 
Reference Guide. Additionally, consider the following tips and tricks.

Just because your AP's maximum output power can be set to 17 or 20 dBm does not mean that it 
should be set to this value. You should consider the fact that most Wi-Fi client devices, such as 
laptops, tablets, or desktops with Wi-Fi adapters, have a lower output power, typically 13 or 15 dBm. 
As a result, a client might “hear” a 20 dBm AP from a very long distance, but the AP might not “hear” 
the client. Additionally, APs with high output power create unnecessary interference with other APs 
in dense WLAN environments. If you design your WLAN for performance rather than coverage, you 
will probably want to have a rather dense placement of APs. Here, stronger does not necessarily 
mean better. You might consider lowering the power level so that it matches the power level of 
client devices.

If you design your WLAN for coverage rather than performance, using high AP output power might 
be acceptable. However, be sure to read the AP specifications to find out the actual power level it 
can provide. Remember that the maximum allowed power level might be different for different 
channels!

Signal level does not tell you the whole story. Consider an 802.11n AP operating in the 2.4 GHz band 
with the standard omnidirectional antenna and the default 17 dBm output power placed on a map 
with no obstructions. If you select the Signal Level visualization, TamoGraph will draw a very large 
(a few hundred meters) circle around your AP. Does this mean that the whole area can be 
considered to be covered by the AP? Of course not, because, for example, at the distance of 
approximately 300 meters the signal level would be about -90 dBm. Yes, the signal is there; your 
client device might even detect the AP and display it on the list of available networks; but there 

https://www.amazon.com/CWDP-304-Certified-Wireless-Professional-Reference/dp/1737216639/
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would be no connectivity. First, because the AP might not “hear” the client, as explained before. 
Second, even marginal connectivity requires the signal-to-noise ratio of at least 4 dBm. Considering 
that the typical noise level in the 2.4 GHz band in urban areas is about -90 dBm, the signal level 
must be at least -86 dBm. At that level, the client might be able to connect, but the throughput 
would be extremely poor. That said, the  Expected PHY Rate  or  AP Coverage Areas visualizations 
might be much more informative than the Signal Level  visualization. TamoGraph does not draw 
the signal level if the difference between it and the noise level is below 4 dBm.

It is a common practice nowadays to use the 2.4 GHz band for legacy, low throughput devices and 
the 5 GHz band for newer, high throughput 802.11n, 802.11ac, or 802.11ax devices. When you put a 
dual-band AP on the floor plan, both the 2.4 GHz and 5 GHz radios are enabled by default and both 
are selected on the AP list on the left panel of the main application window. This means that the 
Signal Level or  Expected PHY Rate visualizations will show you cumulative pictures; if more than 
one radio is included in the visualization, they will show the values for the strongest AP. However, 
you will probably want to estimate coverage and expected PHY rates for each band individually, 
because the range of 5 GHz radios is shorter and because the attenuation level for 5 GHz signals is 
higher. To do that, press the Select APs button on the toolbar and use the checkboxes next to the 
APs to select and deselect them individually. You can also group APs by band and then select or 
deselect all 5 GHz or 2 GHz APs with a single click. You might notice that while good coverage is 
available in the 2.4 GHz band in the entire area, 5 GHz coverage is not available everywhere.

Selecting the right antennas for your AP might considerably increase signal level, decrease 
interference, and, therefore, improve performance. If the antennas of your APs are replaceable, this 
adds another degree of freedom to your WLAN design. Using TamoGraph, you can select an 
antenna from a large collection of generic and vendor-specific antennas. You can also view antenna 
patterns in 3D.

If in doubt, you can create several copies of the same floor using different AP and antenna models 
and see which results best suit your requirements and budget.
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Analyzing Data – Passive Surveys and Predictive Models

When TamoGraph has collected the necessary data in the course of one or several passive site surveys, or 
when you have created a virtual environment model in the course of predictive modeling, the application 
is ready to display a number of Wi-Fi data visualizations that will help you determine important 
characteristics of your WLAN, such as signal coverage, and detect potential performance problems. The 
information given in this chapter is applicable to passive surveys and predictive models; data analysis for 
active surveys is described in the Analyzing Data – Active Surveys chapter. You may also want to review 
Understanding Survey Types: Passive, Active, and Predictive.

Selecting Data for Analysis

Three key interface elements affect what data will be analyzed and how. These elements are overviewed 
below.

The Plans and Surveys tab on the right panel defines what data the application will visualize. This tab is 
organized as a hierarchical tree, where for each floor or site plan, you will see one or more site surveys you 
have conducted. You need to select the floor plan to be analyzed and mark one or more survey paths to 
be included using the corresponding checkboxes (unless you are working on a predictive model, where no 
actual on-site measurements are conducted.) Depending on where and when the surveys were conducted, 
you may want to check all or only some of the survey checkboxes. For example, if you have a large site 
and you made one break while conducting the site survey, your walkabout path will consist of two parts, 
both of which should be included in the analysis. In a different scenario (e.g., if you surveyed the entire site 
prior to installing additional wireless hardware and then surveyed it again after the installation), you will 
probably want to include only one of the surveys and then compare it with the other by changing the 
checkbox selection. The Type column indicates the survey type: Active, Passive, or Active+Passive. We are 
reviewing passive surveys in this chapter, so you should select the surveys that are marked as Passive or 
Active+Passive  in this column. You can use the Comments column to add or modify comments for 
surveys or modify the survey names for clarity at any time.

The Visualization drop-down box on the toolbar defines what type of analytical tool will be applied to the 
selected site plan. A visualization is a graphical representation of WLAN characteristics displayed as an 
overlay on top of the floor plan. The available visualization types will be described below. To select a 
visualization, simply select the corresponding item from the drop-down list, under the Passive section. To 
clear all visualizations, select None. When no visualization is selected, the floor plan is overlaid with the 
walkabout paths and guess range areas (the zones within which TamoGraph can make a good assessment 
of the WLAN parameters).

The Selected APs / All APs buttons on the toolbar, along with the AP list, control which subset of 
observed APs is used for visualizations. Typically, you should select the All APs mode only if all the listed 
APs belong to your WLAN, as there is no point in visualizing, for example, the wireless coverage areas for 
the AP to which your wireless clients cannot connect. The default mode is Selected APs, in which 
TamoGraph will analyze only the signals originating from the APs you selected in the AP list on the left 
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panel. In most corporate WLANs, all APs share the same SSID, so the easiest way to select only your APs is 
using the Group by => SSID command button located above the AP list and checking the box next to your 
SSID.

It is extremely important that the correct subset of APs be selected for analysis. 
Selecting APs that do not belong to your WLAN will result in incorrect coverage maps 
and prevent TamoGraph from identifying network issues. It will also slow down the 
analysis process.

Data visualizations, such as signal level or signal-to-noise ratio, may or may not cover the entire area of the 
floor plan. This depends on the Extrapolate data beyond the guess range  option, which can be 
configured in the new project wizard or at a later time on the Properties tab of the right-side panel. If this 
option is enabled, TamoGraph will calculate WLAN characteristics beyond the areas covered by your 
walkabout path. While this is convenient, as the time needed to collect data for the entire area is reduced, 
data extrapolation cannot produce reliable results. Your walkabout path should normally cover all the 
areas for which accurate data is important.

Ignoring APs and Deleting AP Data

Sometimes, a surveyor might need to ignore one or several APs completely. This might be the case when 
APs do not have a fixed location, e.g., APs that are installed in elevators, or when APs are used temporarily, 
e.g., a laptop that is used as a hot spot. To ignore such an AP, select it on the AP list, right-click on it, and 
then select Advanced => Ignore this AP.  The AP's MAC address (also known as BSSID) will be added to 
the ignore-list and any packets from this AP will be discarded. The ignore-list can be accessed via the 
Settings => AP Ignore List  command of the main application menu. You can review the list and add or 
remove one or multiple MAC addresses.

If you already collected some data from the APs you decided to ignore later, you can use the Remove 
Ignored APs’ Passive Data  option; it will delete passive data about all APs whose MAC addresses are 
currently on the “Ignore” list.

Another similar option is Remove Selected APs’ Passive Data that allows deleting data about all the APs 
that are currently selected (i.e., the APs with check marks next to them) without placing the APs on the 
“Ignore” list.  In this case the AP will re-appear on the AP list if/when its beacons are received later.

Both options can be access by right-clicking on the AP list => Advanced menu.

These operations cannot be undone. Once the data is deleted, it cannot be restored. 
Proceed with care.
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Adjusting AP Locations After Passive Surveys

When you have performed a passive site survey, TamoGraph will automatically place APs on the site map. 
The location of APs is estimated based on the collected data. Location estimates may not always be 
accurate due to the complex nature of radio wave propagation, but you can correct them by dragging the 
AP icon to the correct location with a mouse.

The effect that the AP icon locations have on the calculations of the signal level and other visualizations 
depends on the How AP icon locations affect signal setting that you can find on the Visualization 
Settings panel (located on the Options tab of the right-side panel.) By default, Estimated AP locations are 
used to complement measured signals (new algorithm), which means that correcting the location may 
improve the quality of data analysis in the areas located far from the walkabout path. This is 
recommended for most surveys. If you select Estimated AP locations do not affect signal levels; they are 
icons only, the application displays data based ONLY on the actual measurements; there are no 
extrapolations. This is suitable for the surveys where signal levels are low and AP locations cannot be 
estimated accurately. Finally, you may want to select Estimated AP locations are used to complement 
measured signals (old algorithm, up to version 4.1). This option exists solely for providing compatibility 
with the TamoGraph versions prior to 4.2; the result might be overly optimistic.

If you corrected the AP location(s) by moving the corresponding icon(s), you can revert to the original 
location by right-clicking on the AP list on the left panel and then clicking Auto-locate Access Points (this 
action can be applied to All or Selected APs; here by Selected, we mean the APs that are checked in the 
AP list). To remove an AP completely, drag and drop it outside the map area or use the Clear Access Point 
Locations command (again, this action can be applied to All or Selected APs; here, by Selected, we mean 
the APs that are currently checked in the AP list). Removing an AP from the site map means that the AP 
location becomes undetermined, which, in turn, means that, for this AP, no data extrapolation is 
performed, and only the actual signal readings are used.

Displaying AP locations is an optional feature. Additionally, by default, TamoGraph does not attempt to 
estimate the locations of those APs for which the signal level is low. The AP Detection and Placement
panel (located on the Options tab of the right-side panel) can be used for configuring these features.

When an AP is placed on the site map (either automatically or by the user), this is indicated on the left 
panel by a small plus (+)  sign in the lower right corner of the AP icon. If an AP was not automatically 
placed on the map and you want to place it there, you can drag the AP icon from the AP list to the site 
map. To remove it from the site map, drag the AP icon outside.

Splitting an AP into Multiple Unique APs

Sometimes, passive pre-deployment site surveys are performed by moving about a single AP and testing 
coverage every time you change the AP location. This method is often referred to as “AP-on-a-stick.” The 
purpose of this method is to find good locations for future AP installations and to estimate expected 
coverage (or, sometimes, to find the best location for only one AP).
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1.

2.

3.

4.

If you perform such surveys using one-floor plan, the results will not be ideal because TamoGraph 
assumes that your AP location is fixed; it will place only a single AP icon in the estimated location and the 
coverage calculations will be based on that estimated location. This is not what you want when you 
perform AP-on-a-stick surveys; you probably want TamoGraph to treat your test AP as a unique physical 
device in each of the surveys conducted.

To address this problem, we suggest one of the following solutions (we recommend the second solution):

1. You can add multiple copies of the same floor plan to the project. Every time you move the test AP to a 
new location, perform a survey using a new copy of the floor plan. By doing so, you will obtain completely 
independent coverage results for each new location. The drawback of this method is that you will not be 
able to see cumulative coverage visualization on a single floor plan.

2. You can perform all the surveys using the same floor plan. During a typical “AP-on-a-stick” survey, you 
would take the following steps:

Choose a location for the future installation of your first AP.

Place your “AP-on-a-stick” in that location.

Perform a single, full survey of the coverage area. If a single survey is impossible (i.e., if you have to 
stop and make several surveys for a single AP placement), be sure to merge such surveys before 
moving on.

Choose a location for the future installation of your second AP and repeat this cycle for the second, 
third, fourth, etc. AP.

When you have completed the testing cycle (new AP location – new survey – new AP location – new 
survey…), all of your surveys will contain data for only one AP with a single MAC address. That is not what 
you want. What you want is to split a single physical AP into multiple copies, one copy per survey. All AP 
copies will be assigned new, unique MAC addresses, and, therefore, TamoGraph will treat them as 
independent APs. To do that, select your test AP on the left panel, right-click on it, and then select 
Advanced  => Split. This will display a dialog window in which you can select two or more surveys that 
you performed using the AP-on-a-stick method. Click OK  to complete the operation. If you have a dual-
band AP, you will need to perform this split operation twice, once for each band.

After the split, new APs are given new names and new MAC addresses. For example, if the original AP 
name is “Cisco 802.11n” and the original MAC address is 00:23:04:88:C6:90, and if your performed three 
surveys in three different locations, the new APs would be named “Cisco 802.11n – Copy 1,” “Cisco 802.11n – 
Copy 2,” and “Cisco 802.11n – Copy 3,” and their MAC addresses would be 00:23:04:88:C6:91, 
00:23:04:88:C6:92, 00:23:04:88:C6:93, respectively.

Once you split the AP into multiple independent, unique APs, you can adjust AP icon locations to reflect 
their actual positions, as described in the previous chapter, and apply any visualization to the selected 
surveys.

Note that this operation cannot be undone, so you may want to save a backup copy of the project file prior 
to performing this operation.
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Working with Multi-SSID APs

A multi-SSID (also called “multi-MAC”) access point is a single access point that broadcasts multiple SSIDs 
using a single radio. Each SSID uses a separate, distinct MAC address (also known as “BSSID”), which 
means that such APs appear as separate, distinct devices for WLAN users. Detection of multi-SSID APs is 
important for one of the visualizations, namely Signal-to-Interference Ratio, for an obvious reason: 
despite the fact that multiple SSIDs use the same channel, they cause no interference between themselves.

TamoGraph attempts to detect such multi-SSID APs and mark them accordingly. They appear as a group 
of icons on the floor plan, where each SSID/MAC address is represented by one icon. They also share a 
single tooltip window that lists the SSIDs and MAC addresses used by the AP’s radio.

Because detection of multi-SSID APs cannot be 100% reliable for a number of technical reasons, 
TamoGraph allows you to link several icons to form a multi-SSID AP if automatic detection failed or, 
conversely, split an incorrectly detected multi-SSID AP into separate radios. These operations can be 
performed using the Multi-MAC/Multi-SSID Access Point context menu of the floor plan (central pane).

Sometimes, once the survey has been fully completed, the result of linking multi-SSID APs and/or their 
positions might be erroneous; this could also be the case when importing survey results other users 
conducted. In such situations, you may want to use the Advanced => Re-link Multi-SSID command, which 
allows you to restart the automatic linking procedure from scratch, based on the information previously 
saved in the ApLinked.txt file and using all the surveys that are currently present in the project.

AP Rank and Secondary Coverage

Modern Wi-Fi networks are usually designed to meet stringent capacity, flexibility, and fault tolerance 
requirements. One of the most widely used methods of ensuring fault tolerance and, at the same time, 
increasing capacity, is providing secondary or even tertiary coverage; such coverage is provided by APs the 
coverage zones of which overlap. APs are positioned so that in case of failure or overload, no client is left 
without Wi-Fi, as nearby AP(s) can service the zone. An additional benefit is fast and more reliable 
roaming.

To facilitate analyzing non-primary coverage, TamoGraph offers the AP Rank  selector that can be found 
on the application main toolbar. This selector can be used when analyzing data from passive surveys and 
predictive models. By clicking the AP Rank button, you switch the visualization from the primary coverage 
(the strongest AP) to the secondary (the second strongest) and then to the tertiary (the third strongest) 
coverage. For example, to see the signal level provided by the second-strongest AP in a given location, you 
need to select the Signal Level visualization and click the AP Rank button once, so that the square “2” is 
highlighted. If you click the AP Rank button repeatedly, the rank is switched cyclically, i.e. 1-2-3-1…, and so 
on. If you need to select a specific rank without going through the full cycle, use the menu that can be 
invoked by clicking on the arrow to the right of the button.
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Visualization Types

The following chapters describe different visualization types and the configuration settings that affect 
them. They will also help you interpret the data and suggest solutions to problems with Wi-Fi coverage 
and performance.

Signal Level

This visualization shows the signal strength map (also called the coverage map) measured in dBm. Signal 
strength is one of the most important factors that influence WLAN performance, as in the areas with low 
signal, establishing a reliable and high-throughput link between the AP and client devices is impossible. 
Signal level is shown for the AP that has the strongest signal in the given map area among the APs 
selected for analysis. You can deselect one or several of the selected APs to see the signal level of less 
strong APs.

A signal level above -60 dBm is considered excellent. Levels between -60 and -85 dBm are mediocre, and 
levels below -85 dBm provide only marginal connectivity. Signal strength is affected by the distance from 
the AP, AP output power, type and direction of antenna, and, most importantly, physical obstructions, such 
as walls, doors, windows, and their material.

Double-clicking on the signal level legend on the status bar allows you to configure the color scheme and 
change its value range.

Suggested Solutions

When low signal areas are discovered, the following solutions are suggested:

Change AP locations: You should minimize the number of obstructions between the AP and the low 
signal zone. Additionally, the material of the obstructions plays an important role; for example, the 
attenuation factor of a brick wall far exceeds that of a cubicle wall or window.

Add more APs: Sometimes repositioning APs does not provide the desired effect, and the option 
becomes installing additional APs in the problematic areas.

Use a different antenna: A high-gain antenna (if your AP supports the use of such antennae) 
redirects radio signal in the desired direction, thereby increasing the signal level in some zones and 
decreasing it in the others.

Increase output power: Some APs allow for the adjustment of the transmission power. However, for 
most, the maximum power is already set as the default factory setting.

Signal-to-Noise Ratio

This visualization shows the signal-to-noise ratio (SNR) measured in dB. SNR is a measure to quantify by 
how much the signal level exceeds the noise level. Noise is generated by non-802.11 sources of radio 
waves (this includes 802.11 frames damaged during propagation). In low SNR zones, client devices may not 



TamoGraph Site Survey   ●   Analyzing Data – Passive Surveys and Predictive Models Page  66  of  120

be able to communicate with APs. SNR is shown for the AP that has the strongest signal in the given map 
area among the APs selected for analysis. You can deselect one or several of the selected APs to see SNR 
values for less strong APs.

In a typical environment, the noise level is about -90 dBm. The signal level measured within a few meters 
from the AP would be about -50 dBm. This gives an SNR value of 40 dB, which is considered excellent. 
Marginal connectivity is possible when the AP signal level is -85 dBm, so an SNR value of 5 dB is 
considered poor. A higher noise level and, correspondingly, a lower SNR are usually caused by Bluetooth 
devices, cordless phones, and microwave ovens.

Double-clicking on the SNR legend on the status bar allows you to configure the color scheme and change 
its value range.

Suggested Solutions

When low SNR areas are discovered, two possible strategies should be considered: increasing the signal 
level or decreasing the noise level. The first strategy is discussed in the previous chapter; to decrease the 
noise level, the following solutions are suggested:

Check the environment for potential sources of noise and turn them off, if possible, to see how that 
affects SNR.

If you experience low SNR values in the 2.4 GHz band, consider switching your APs to the 5 or 6 GHz 
band, where noise level is typically lower.

If switching to the 5 or 6 GHz band is not an option, try to select a different channel in the 2.4 GHz 
band.

Note that identifying and removing the source of noise might not be an easy task. In practice, the easiest 
solution is usually increasing the signal level rather than decreasing the noise level.

Signal-to-Interference Ratio

This visualization shows the signal-to-interference ratio (SIR) measured in dB. SIR is a measure to quantify 
by how much the signal level of an AP (interfered AP) exceeds the interference level. The interfering signal 
is the signal being transmitted by other APs (interfering APs) that may or may not belong to your WLAN 
and that use the same or one of the adjacent 802.11 channels. In low SIR zones, client devices may 
experience low throughput. SIR is shown for the AP that experiences the worst interference in the given 
map area among the APs selected for analysis. You can deselect one or several of the selected APs to see 
SIR values for the APs that experience less interference.
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Selecting one AP at a time for SIR analysis is recommended because this produces a 
clearer picture. You should isolate AP-specific problem zones by selecting your APs 
one by one. Working with a cumulative picture, displayed when multiple APs are 
selected, is more difficult.

SIR is best illustrated with an example. Consider an area where the AP signal strength is -50 dBm, and the 
AP works on channel 1. In the same area, a -70 dBm signal from another AP that works on the same 
channel can be seen. If WLAN utilization is 100% (i.e., if the APs send radio waves all the time), the SIR 
value would be 20 dB. However, real-world WLAN utilization is almost never that high, which decreases 
the interference and increases SIR. If the interfered and interfering APs have the same signal strength, the 
SIR value would be 0 dB. In classical, non-digital radios, a SIR value of 0 dB makes signal reception 
impossible, but 802.11 devices use a technology that allows them to operate despite a zero or even 
negative SIR value, which sounds counterintuitive.

Simply put, if an AP is not heavily loaded, it transmits just a few hundred packets per second. If a nearby 
AP working on the same channel also transmits a few hundred packets per second, the transmissions 
“collide” very infrequently, thus resulting in virtually zero interference. The average network utilization that 
is used for SIR computations is a configurable option (see below).

Interference is highest when the interfered and interfering APs work on the same channel. In the 2.4 GHz 
band, where channel frequencies overlap, adjacent channel interference is still substantial when the 
interfered and interfering APs are one and two channels apart and becomes virtually non-existent when 
they are five channels apart. In the 5 GHz band, there is no adjacent channel interference. Many modern 
devices use channel bonding, i.e., two 20 MHz channels for 802.11n, up to eight 20 MHz channels for 
802.11ac/ax, and up to sixteen 20 MHz channels for 802.11 be at the same time. For example, channel 11 
might be used as the primary channel and channel 6 as the secondary one. In these cases, TamoGraph 
factors in interference on non-primary 802.11n, 802.11ac, 802.11ax, or 802.11be channels, if any. It should also 
be noted that when visualizing SIR, the application takes into consideration interfering signals from all APs, 
regardless of whether they are selected in the AP list. The application also detects multi-SSID APs and 
does not consider separate different SSIDs with different MAC addresses of the same AP as sources of 
interference with each other (see Working with Multi-SSID APs for more information).

The following options on the Visualization Settings  panel (located on the Options  tab of the right-side 
panel) affect the way SIR is analyzed:

Area is considered covered if signal strength is at least – this setting defines the AP coverage area 
based on the minimum signal strength. If the signal strength is below the specified level, the area is 
considered to be not covered, and no SIR values will be computed for the area (such areas will 
appear as white spots). This improves the SIR visualization clarity: In low signal areas, SIR is almost 
always very low, but such areas should not distract your attention, as they cannot ensure good 
connectivity or throughput anyway.

Average network utilization  – this setting defines how heavy the interference is from the 
interfering APs. If the interfering signal strength is high, but the network utilization is low, the 
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interfering AP does not create much interference. A typical office WLAN has a network utilization of 
between 10% and 25%. Adjust this setting to match the actual value for your WLAN.

Double-clicking on the SIR legend on the status bar allows you to configure the color scheme and change 
its value range.

Suggested Solutions

Low SIR areas are not uncommon in WLANs. The presence of such areas does not necessarily mean that 
the WLAN will suffer from low throughput. However, if such zones cover most of your site and are located 
close to APs, corrective actions should be taken. When low SIR areas are discovered, the following 
solutions are suggested:

Change the channel selection. APs working in proximity should never use overlapping channels. 
Consider the classical “honeycomb” AP placement, if possible. Note that in some 802.11n equipment, 
the position of the secondary channel (below or above the primary one) is a user-configurable 
option, which gives you an additional degree of freedom.

If you experience low SIR values in the 2.4 GHz band, consider switching your APs to the 5 or 6 GHz 
band, where there are more non-overlapping channels from which to choose. If you use an 802.11n 
AP with 40 MHz bandwidth in the 2.4 GHz band, you have virtually no way of avoiding interference. 
For example, if the primary channel is set to 1, the secondary channel is set to 5. In the United States, 
where there are eleven channels in the 2.4 GHz band, all you can do is configure the next AP to 
work on the primary channel 11, the secondary being 6. As a result, the secondary channels would 
be only one channel apart, which may result in high interference. If channel bonding is not used 
(i.e., a single 20 MHz channel), you have three non-overlapping channels from which to choose: 1, 6, 
and 11. This is illustrated in the image below.

AP Coverage Areas

This visualization shows the areas covered by the APs. An area is considered covered if the signal is strong 
enough for the clients to communicate to the AP. You can select and deselect one or several of the APs to 
see individual or group coverage areas. Coverage areas are color-coded: For each AP, a small colored 
square is shown next to the AP icon. The corresponding color is used to display the coverage area contour 
or fill.
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The definition of “strong enough” is rather subjective because certain signal strength might be sufficient for 
low data rates, but insufficient for the high data rates required for such applications as VoIP. Additionally, 
802.11 adapters vary in sensitivity, and some adapters might be able to provide good connectivity in zones 
where other adapters fail to connect altogether.

The following options on the Visualization Settings  panel (located on the Options  tab of the right-side 
panel) affect the way AP coverage areas are analyzed and visualized:

Area is considered covered if signal strength is at least – this setting defines the AP coverage area 
based on the minimum signal strength. If the signal strength is below the specified level, the area is 
considered to be not covered.

AP coverage areas  – this allows you to change the color coding method used for displaying 
coverage areas. In No fill, contours only  mode, the application draws contours of the coverage 
areas without filling the areas with colors. In Fill and mix colors mode, AP coverage areas are filled 
with colors; when areas overlap, the application draws a striped pattern, alternating the colors of the 
respective APs. In Fill, the strongest AP on top  mode, AP coverage areas are filled with colors; 
when areas overlap, the application draws the color of the strongest AP. In Fill, the weakest AP on 
top  mode, AP coverage areas are filled with colors; when areas overlap, the application draws the 
color of the weakest AP.

Number of APs

This visualization shows how many APs cover the given area. An area is considered covered if the signal is 
strong enough for the clients to communicate with the AP. In many WLANs, multiple AP coverage is an 
important requirement that ensures uninterrupted connectivity, load balancing, and seamless roaming. If 
this requirement exists in your WLAN, you can use this visualization to make sure that AP coverage areas 
sufficiently overlap.

As in the AP Coverage Areas  visualization, the definition of “strong enough” is rather subjective because 
certain signal strength might be sufficient for low data rates, but insufficient for the high data rates required 
for such applications as VoIP. Additionally, 802.11 adapters vary in sensitivity, and some adapters might be 
able to provide good connectivity in zones where other adapters fail to connect altogether. The 
Visualization Settings  panel (located on the Options  tab of the right-side panel) offers the Area is 
considered covered if signal strength is at least setting, which defines the AP coverage area based on the 
minimum signal strength. If the signal strength is below the specified level, the area is considered to be not 
covered.

Double-clicking on the Number of APs legend on the status bar allows you to configure the color scheme.

Expected PHY Rate

The physical layer (PHY) rate is the speed at which client devices communicate with the AP. When you 
move a computer connected to the AP within the WLAN coverage area, the adapter properties dialog on 
Windows or the Wi-Fi icon menu on macOS displays the varying connection speed, which may be as high 
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as a few thousand Mbps when you are close to the AP or as low as 1 Mbps when you are 50 meters away 
from it. The displayed speed is the PHY rate.

The PHY rate directly affects the throughput rate, which is the average speed at which the client and AP 
can exchange application-level data, such as files. The throughput rate is always lower than the PHY rate, 
typically by more than 50%, due to a number of factors, such as protocol overheads and retransmissions. A 
low PHY rate always means low data throughput and therefore poor WLAN performance.

When calculating PHY rates, TamoGraph uses the Client Capabilities  settings that 
might or might not be as good as the AP capabilities. If the adapter's capabilities are 
inferior (e.g., if an 802.11n adapter is connected to an 802.11an AP), then the 
maximum PHY rate that the AP supports will not be reached. Please refer to the 
description of Client Capabilities for more information.

The PHY rate is shown for the AP that has the strongest signal in the given map area among the APs 
selected for analysis. This mimics the roaming behavior of client adapters that connected to the strongest 
AP. While other audible APs may offer higher PHY rates, a typical adapter will connect to the AP with the 
strongest signal. You can deselect one or several of the selected APs to see PHY rate values for less strong 
APs.

Expected PHY rate calculations are based on signal strength and use a table that maps signal levels to PHY 
data rates. The table uses average values for common adapter types. The actual PHY rate that you observe 
may be lower or higher than the expected rate, depending on the specific adapter and AP equipment 
being used.

Double-clicking on the Expected PHY rate legend on the status bar allows you to configure the color 
scheme.

Suggested Solutions

When low expected PHY rate areas are discovered, the following solutions are suggested:

Increase the signal level, as it is directly related to the PHY rate. See the suggested solutions for 
increasing signal level in the Signal Level chapter.

Check your AP capabilities. If you are using newer 802.11n equipment, make sure that the maximum 
MCS indices, Short GI, and 40 MHz channel bandwidth are allowed in the device configuration.

Check your Client Capabilities settings. You might have erroneously limited them too much.

If you are using legacy 802.11n equipment, consider upgrading to 802.11ax.
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Frame Format

This visualization shows what format of 802.11 frames (also called packets) is being used in the given WLAN 
area. Wi-Fi networks use three frame formats:

Non-HT: This is a legacy frame format used by 802.11 a/b/g equipment.

HT-mixed: This is a frame format introduced in the 802.11n standard. It uses a protection mechanism 
that allows 802.11n devices to coexist with legacy 802.11 a/b/g devices, including those that do not 
belong to your WLAN.

HT-Greenfield: This is a frame format introduced in the 802.11n standard, too. Unlike in HT-mixed 
mode, devices operating in Greenfield mode assume that there are no legacy 802.11 a/b/g stations 
around using the same or adjacent channels. 802.11 a/b/g devices cannot communicate with 
Greenfield devices. Rather, their packets will collide, causing problems for both parties.

VHT: This is the frame format introduced in the 802.11ac standard. This format is used in the 5 GHz 
band only. It uses a protection mechanism that allows 802.11ac devices to coexist with legacy 802.11a 
and 5 GHz 802.11n devices, including those that do not belong to your WLAN.

HE: This is the frame format introduced in the 802.11ax standard. This format is used in  2.4, 5, and 6 
GHz bands.

EHT: This is the latest frame format introduced in the 802.11be standard. This format is used in 2.4, 5, 
and 6 GHz bands.

Frame format is shown for the AP that has the strongest signal in the given map area among the APs 
selected for analysis. This mimics the roaming behavior of client adapters that connected to the strongest 
AP. While other audible APs may use other frame formats, a typical adapter will connect to the AP with the 
strongest signal. You can deselect one or several of the selected APs to see frame formats for less strong 
APs.

Among the three pre-802.11ac frame formats, the best throughput is provided by HT-Greenfield. In HT-
mixed format, protection mechanisms that ensure coexistence with legacy equipment reduce throughput. 
However, it should be noted that as per the 802.11n standard, support for HT-Greenfield frame format is 
not mandatory, and currently, few APs support it. In the realm of 802.11ac, VHT is the only available format.

Double-clicking on the Frame Format legend on the status bar allows you to configure the color scheme 
and change its value range.

Suggested Solutions

If you do not see the frame formats that you expect to see, the following solutions are suggested:

Check your AP configuration. If you are using 802.11n equipment, see if Greenfield mode is available, 
if HT-Greenfield frame format is what you want. Note that some APs have the “802.11n only” option, 
but this option does not necessarily mean that HT-Greenfield frame format will be used. Rather, 
switching this option "on" may simply disable legacy data rates.
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Your AP's ability to send frames in HT-Greenfield format depends on the wireless environment. A 
Greenfield-enabled AP may fall back to HT-mixed format in some situations (e.g., when a 
non-802.11n device connects to the AP or when other non-Greenfield APs are detected nearby). 
Because of the changing environment, the site survey results regarding the frame format may 
change from time to time. Perform site surveys regularly.

If you are using legacy 802.11n equipment, consider upgrading to 802.11ax.

Remember that VHT is not available in the 2.4 GHz band.

Channel Bandwidth

This visualization shows what type of channel bandwidth (also called channel width) is being used in the 
given WLAN area. Wi-Fi networks use three types of channel bandwidth:

20 MHz Legacy: This is a legacy type used by 802.11 a/b/g equipment. Each channel occupies 20 
MHz of radio spectrum.

20 MHz HT and 40 MHz HT: These are bandwidth types introduced in the 802.11n standard. They 
occupy either 20 MHz or 40 MHz of spectrum space and use HT-mixed and HT-Greenfield frame 
formats.

20 MHz VHT, 40 MHz VHT, 80 MHz VHT, and 160 MHz VHT: These are the types introduced in the 
802.11ac standard. They use 20, 40, 80, or 160 MHz-wide channels. VHT is used only in the 5 GHz 
band.

20 MHz HE, 40 MHz HE, 80 MHz HE, and 160 MHz HE: These are the types introduced in the 
802.11ax standard. They use 20, 40, 80, or 160 MHz-wide channels. HE is used in the 2.4, 5 and 6 GHz 
bands.

20 MHz EHT, 40 MHz EHT, 80 MHz EHT, 160 MHz EHT, and 320 MHz EHT: These are the types 
introduced in the 802.11be standard. They use 20, 40, 80, 160, or 320 MHz-wide channels. EHT is 
used in the 2.4, 5 and 6 GHz bands.

Channel bandwidth is shown for the AP that has the strongest signal in the given map area among the APs 
selected for analysis. This mimics the roaming behavior of client adapters that connected to the strongest 
AP. While other audible APs may offer other types of bandwidth, a typical adapter will connect to the AP 
with the strongest signal. You can deselect one or several of the selected APs to see channel bandwidth 
types for less strong APs.

Double-clicking on the Channel Bandwidth legend on the status bar allows you to configure the color 
scheme and change its value range.

Suggested Solutions

If you see 20 MHz Legacy or 20 MHz HT channel bandwidth in the areas where you expect to see 40 MHz 
HT, the following solutions are suggested:
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Check your AP configuration. If you are using newer 802.11n equipment, make sure that it is 
configured to use 40 MHz or automatic 20/40 MHz channel width.

Your AP's ability to use 40 MHz channels depends on the wireless environment. A 40 MHz-enabled 
AP may fall back to 20 MHz mode in some situations (e.g., when an 802.11n client that does not 
support 40 MHz bandwidth is connected). Because of the changing environment, the site survey 
results regarding the channel bandwidth may change from time to time. Perform site surveys 
regularly.

If you are using legacy 802.11 a/b/g equipment, consider upgrading to 802.11ac or 802.11ax.

If you see the HT channel bandwidth in the areas where you expect to see VHT, make sure that your AP is 
configured to use the 802.11ac mode and that you have correctly configured its channel width. Also, keep 
in mind that VHT is available only in the 5 or 6 GHz band.

Channel Map

These visualizations (there are three separate visualizations for the 2.4 GHz, 5 GHz, and 6 GHz bands) show 
per-channel coverage for the selected band. The predominant channel is determined by the AP that has 
the strongest signal in the given area. Each channel is marked with the corresponding legend color.

These visualizations are intended to assist the surveyor in detecting problems with channel reuse patterns 
in existing high-density WLANs that do not use dynamic frequency selection. They are also instrumental in 
predictive modeling, when you design new Wi-Fi deployments.

Requirements

This visualization shows what requirements set by the user are met. The Requirements panel (located on 
the Properties  tab of the right-side panel) allows the user to set thresholds for key WLAN parameters, 
namely (under the Passive section):

Minimum signal level (shown as SL on the legend)

Minimum signal-to-noise ratio (shown as SNR on the legend)

Minimum signal-to-interference ratio (shown as SIR on the legend)

Minimum APs required (shown as AP on the legend)

Minimum PHY rate (shown as PHY on the legend)

Minimum allowed frame format (shown as FF on the legend)

Minimum channel bandwidth (shown as CB on the legend)

The zones where the requirement is not met are marked with the corresponding legend color. If more 
than one requirement is not met, only one color will be used (priority is given to the requirements closer 
to the top of the list). If multiple APs are required, the strongest AP will be checked against the 
requirement list. If all the requirements are met, no color overlays will be displayed.



TamoGraph Site Survey   ●   Analyzing Data – Passive Surveys and Predictive Models Page  74  of  120

The meaning of the requirements listed above is explained in detail in the preceding sections of the 
Analyzing Data – Passive Surveys and Predictive Models chapter.

Double-clicking on the "Requirements" legend on the status bar allows you to configure the color scheme 
and change its value range.
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Analyzing Data – Active Surveys

Once TamoGraph has collected the necessary data in the course of one or several active site surveys, the 
application is ready to display a number of Wi-Fi data visualizations that will help you to determine 
important characteristics of your WLAN, such as actual PHY rate or throughput rates, and detect potential 
performance problems. The information given in this chapter is applicable to active surveys; data analysis 
for passive surveys is described in the Analyzing Data – Passive Surveys and Predictive Models chapter. 
You may also want to review Understanding Survey Types: Passive, Active, and Predictive.

Selecting Data for Analysis

Three key interface elements affect what data will be analyzed and how. These elements are overviewed 
below.

The Plans and Surveys tab on the right panel defines what data the application will visualize. This tab is 
organized as a hierarchical tree, where for each floor or site plan, you will see one or more site surveys you 
have conducted. You need to select the floor plan to be analyzed and mark one or more survey paths to 
be included using the corresponding checkboxes. Depending on where and when the surveys were 
conducted, you may want to check all or only some of the survey checkboxes. For example, if you have a 
large site and you made one break while conducting the site survey, your walkabout path will consist of 
two parts, both of which should be included in the analysis. In a different scenario (e.g., if you surveyed the 
entire site prior to installing additional wireless hardware and then surveyed it again after the installation), 
you will probably want to include only one of the surveys and then compare it with the other by changing 
the checkbox selection. The Type  column indicates the survey type: Active,  Passive, or Active+Passive. 
We are reviewing active surveys in this chapter, so you should select the surveys that are marked as Active
or Active+Passive  in this column. You can use the Comments column to add or modify comments for 
surveys or modify the survey names for clarity at any time.

The Visualization drop-down box on the toolbar defines what type of analytical tool will be applied to the 
selected site plan. A visualization is a graphical representation of WLAN characteristics displayed as an 
overlay on top of the floor plan. The available visualization types will be described below. To select a 
visualization, simply select the corresponding item from the drop-down list, under the  Active  section. To 
clear all visualizations, select None. When no visualization is selected, the floor plan is overlaid with the 
walkabout paths and guess range areas (the zones within which TamoGraph can make a good assessment 
of the WLAN parameters).

Unlike passive surveys, active surveys do not include information on the APs in the survey area; they are 
focused on the specific WLAN or AP to which you connected during the active survey. For this reason, the 
Selected APs / All APs buttons on the toolbar are disabled when you select a visualization for an active 
survey. The AP list might still be available if you also performed a passive survey or if APs can be currently 
“heard” by the application, but checking or unchecking the boxes next to the listed APs has no effect in this 
case.
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Visualization Types

The following chapters describe different visualization types and the configuration settings that affect 
them. They will also help you interpret the data and suggest solutions to problems with Wi-Fi coverage 
and performance.

Actual PHY Rate

The physical layer (PHY) rate is the speed at which client devices communicate with the AP. When you 
move a computer connected to the AP within the WLAN coverage area, the adapter properties dialog on 
Windows or the Wi-Fi icon menu on macOS displays the varying connection speed, which may be as high 
as 450 or 300 Mbps when you are close to the AP or as low as 1 Mbps when you are 50 meters away from 
it. The displayed speed is the actual PHY rate at which the client was connected to the AP during an active 
survey. This is unlike the Expected PHY Rate  available for passive surveys, where the PHY rate is not 
measured, but rather estimated based on the signal level. The actual PHY rate that you observe may be 
lower or higher than the expected rate, depending on the specific adapter and AP equipment being used.

To be able to determine the maximum possible PHY rate, the set of supported rates 
and standards of the adapter you use for active surveys must be at least as good as 
that of the AP. If the adapter's capabilities are inferior (e.g., if an 802.11b adapter is 
connected to an 802.11n AP), the maximum PHY rate will not be reached.

The PHY rate that is measured is the rate at which the adapter is connected to the AP at any given spot 
along the survey path. As you move along the path, the adapter typically roams to the AP that provides the 
strongest signal within your WLAN.

It is important to remember that some adapters let you adjust roaming thresholds; these roaming settings 
might affect the roaming behavior and, therefore, the measured PHY rate. For example, consider two APs 
located 20 meters away from each other with the signal level ranging from -30 dBm next to the APs to -70 
dBm in the middle of the distance between the APs. As you walk from the first to the second AP, some 
clients will roam as soon they pass the middle point, while others will not roam until they are only a few 
meters away from the second AP. For this reason, the PHY rate visualization is heavily dependent upon 
one's walkabout path and its direction. Walking from the first to the second AP might produce a picture 
that would be different from the one produced by walking in the opposite direction.

Double-clicking on the Actual PHY rate legend on the status bar allows you to configure the color scheme 
and change its value range.

Suggested Solutions

When low actual PHY rate areas are discovered, the following solutions are suggested:
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Verify that the set of supported rates and standards of the adapter being used for active surveys is at 
least as good as that of the AP.

Low PHY rates might be caused by non-aggressive roaming. Check the adapter roaming settings 
and repeat the survey in the questionable zones. Try to walk very slowly to give the adapter time to 
roam and establish a good quality link to the AP.

Increase the signal level, as it is directly related to the PHY rate. See the suggested solutions for 
increasing signal level in the Signal Level chapter.

Check your AP capabilities. If you are using newer 802.11n equipment, make sure that the maximum 
MCS indices, Short GI, and 40 MHz channel bandwidth are allowed in the device configuration.

If you are using legacy 802.11n equipment, consider upgrading to 802.11ax.

TCP Upstream and Downstream Rate

The TCP Upstream Rate and TCP Downstream Rate visualizations show TCP throughput rates measured in 
Mbps (megabits per second.) Throughput (also often referred to as “goodput”) is the amount of 
application-layer data delivered from the client to the server (upstream) or from the server to the client 
(downstream) per second. The protocol overhead is not included, so when we talk, for example, about the 
TCP throughput rate of 1 Mbps, we mean that 125 Kbytes of actual data payload were sent between two 
network nodes during one second, not including TCP, IP, and Ethernet or 802.11 headers.

Throughput rates are one of the most important real-world metrics of a WLAN, because they determine 
the end user experience and network-related application performance.

Double-clicking on the TCP Upstream and Downstream Rate legend on the status bar allows you to 
configure the color scheme and change its value range.

Suggested Solutions

When low throughput areas are discovered, the following solutions are suggested:

Verify that the actual PHY rate is sufficient. Throughput rates cannot exceed PHY rates; in practice, 
they are about 50% lower than PHY rates. For example, if the PHY rate in the given area is only 2 
Mbps, you should not expect the throughput rate to exceed 1 Mbps. In practice, it might be as low as 
0.1 or 0.2 Mbps, depending on other conditions.

Other common reasons for low throughput rates are interference and excessive network traffic. The 
Signal-to-Interference Ratio  visualization available for passive surveys might provide insight into 
interference issues. Excessive network traffic might be caused either by oversubscription (too many 
clients per AP) or by excessive network load by some clients. The former can be addressed by 
increasing the number of APs, while the latter should be verified and handled by network traffic 
monitoring software.

The client-AP part of the link might not be the bottleneck. Even if the wireless link quality is 
excellent and provides high throughput rates, the wired side of the network might be the problem. 
For example, if the throughput test server utility is running on a computer equipped with a 100 
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Mbps adapter, your throughput rates in this test will never exceed 80 or 90 Mbps, despite the fact 
that the wireless side of the link might provide 150 or 200 Mbps throughput. Make sure that the 
bandwidth of the wired side exceeds the bandwidth of the wireless side; check Ethernet adapter 
speeds, switch port speeds, cabling, etc. All the hardware between the client and server should 
support the speed of at least 1 Gbps.

UDP Upstream and Downstream Rate

The UDP Upstream Rate and UDP Downstream Rate visualizations show UDP throughput rates measured 
in Mbps (megabits per second.) Throughput (also often referred to as “goodput”) is the amount of 
application-layer data delivered from the client to the server (upstream) or from the server to the client 
(downstream) per second. The protocol overhead is not included, so when we talk, for example, about the 
UDP throughput rate of 1 Mbps, we mean that 125 Kbytes of actual data payload were sent between two 
network nodes during one second, not including UDP, IP, and Ethernet or 802.11 headers.

Just like TCP throughput rates, UDP throughput rates are one of the most important real-world metrics of a 
WLAN, because they determine the end user experience and network-related application performance. 
Unlike TCP, UDP is typically used in audio and video streaming applications, such as VoIP, so UDP 
throughput metrics might give you an insight into expected VoIP quality.

Double-clicking on the UDP Upstream and Downstream Rate legend on the status bar allows you to 
configure the color scheme and change its value range.

Suggested Solutions

When low throughput areas are discovered, the following solutions are suggested:

Verify that the actual PHY rate is sufficient. Throughput rates cannot exceed PHY rates; in practice, 
they are about 50% lower than PHY rates. For example, if the PHY rate in the given area is only 2 
Mbps, you should not expect the throughput rate to exceed 1 Mbps. In practice, it might be as low as 
0.1 or 0.2 Mbps, depending on other conditions.

Other common reasons for low throughput rates are interference and excessive network traffic. The 
Signal-to-Interference Ratio  visualization available for passive surveys might provide insight into 
interference issues. Excessive network traffic might be caused either by oversubscription (too many 
clients per AP) or by excessive network load by some clients. The former can be addressed by 
increasing the number of APs, while the latter should be verified and handled by network traffic 
monitoring software.

The client-AP part of the link might not be the bottleneck. Even if the wireless link quality is 
excellent and provides high throughput rates, the wired side of the network might be the problem. 
For example, if the throughput test server utility is running on a computer equipped with a 100 
Mbps adapter, your throughput rates in this test will never exceed 80 or 90 Mbps, despite the fact 
that the wireless side of the link might provide 150 or 200 Mbps throughput. Make sure that the 
bandwidth of the wired side exceeds the bandwidth of the wireless side; check Ethernet adapter 
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speeds, switch port speeds, cabling, etc. All the hardware between the client and server should 
support the speed of at least 1 Gbps.

UDP Upstream and Downstream Loss

This visualization shows loss of UDP packets from the client to the server (upstream) or from the server to 
the client (downstream) measured in percentages. Packet loss is applicable to UDP tests only, because in 
TCP, all packets must be acknowledged and no data loss may occur. UDP loss is calculated as the 
percentage of data that was lost during transmission. For example, if the server sent 1 megabit of data in 10 
milliseconds and the client received 0.6 megabits in 10 milliseconds, while 0.4 megabits were lost en route, 
a 40% downstream loss has occurred.

UDP loss determines end user experience in audio and video streaming applications, such as VoIP. High 
loss percentage might cause high jitter and delays in audio and video.

When viewing this visualization, it is very important to understand that high downstream loss is normal. 
UDP traffic is not acknowledged. This means that the party that sends traffic can send as much traffic as the 
networking system can handle without “caring” about how much of it will be lost. A typical computer on 
the wired side of the network (server) equipped with a gigabit adapter can send hundreds of megabits per 
second. This data will first reach a switch, which might be the first bottleneck, and then the AP, which is 
almost always a bottleneck, because a typical 802.11n access point cannot send more than 100 or 150 Mbps 
of data downstream, i.e., to the client. As a result, over 50% of UDP packets might be lost en route, but this 
is the only way to figure out the maximum downstream UDP throughput value.

Suggested Solutions

When high UDP loss areas are discovered, the following solutions are suggested:

Verify that the actual PHY rate is sufficient. Throughput rates cannot exceed PHY rates; in practice, 
they are about 50% lower than PHY rates. For example, if the PHY rate in the given area is only 2 
Mbps, you should not expect the throughput rate to exceed 1 Mbps. In practice, it might be as low as 
0.1 or 0.2 Mbps, depending on other conditions.

Other common reasons for low throughput rates are interference and excessive network traffic. The 
Signal-to-Interference Ratio  visualization available for passive surveys might provide insight into 
interference issues. Excessive network traffic might be caused either by oversubscription (too many 
clients per AP) or by excessive network load by some clients. The former can be addressed by 
increasing the number of APs, while the latter should be verified and handled by network traffic 
monitoring software.

Round-trip Time

This visualization shows Round-trip time (RTT) measured in milliseconds. RTT is the length of time it takes 
for a data packet to be sent from the client to the server and back.
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RTT affects application responsiveness: A high RTT value means that an application server's response to a 
client request is slow. RTT also affects end user experience in audio and video streaming applications, 
because a high RTT value will inevitably cause a VoIP lag. Varying RTT might also cause VoIP jitter.

When the surveyor walks the facility during an active survey, the adapter periodically renegotiates the PHY 
rate and roams to new APs. During these periods of time, RTT values might peak, which is normal.

Suggested Solutions

When areas with consistently high RTT are discovered, the following solutions are suggested:

Common reasons for high RTT values are interference and excessive network traffic. The Signal-to-
Interference Ratio visualization available for passive surveys might provide insight into interference 
issues. Excessive network traffic might be caused either by oversubscription (too many clients per 
AP) or by excessive network load by some clients. The former can be addressed by increasing the 
number of APs, while the latter should be verified and handled by network traffic monitoring 
software.

Associated AP

This visualization shows to which APs the client was associated during an active survey. As you move 
along the path, the client adapter typically roams to the AP that provides the strongest signal within your 
WLAN.

It is important to remember that some adapters allow for adjustment of roaming thresholds; these 
roaming settings might affect the roaming behavior and, therefore, this visualization. For example, consider 
two APs located 20 meters away from each other with the signal level ranging from -30 dBm next to the 
APs to -70 dBm in the middle of the distance between the APs. As you walk from the first to the second AP, 
some clients will roam as soon as they pass the middle point, while others will not roam until they are 
only a few meters away from the second AP. For the same reason, the Associated AP visualization is 
heavily dependent upon the walkabout path and its direction. Walking from the first to the second AP 
might produce a picture that would be different from the one produced by walking in the opposite 
direction.

Requirements

This visualization shows what requirements set by the user are met. The Requirements panel (located on 
the Properties  tab of the right-side panel) allows the user to set thresholds for key WLAN parameters, 
namely (under the Active section):

Minimum TCP upstream rate (shown as ↑TCP on the legend)

Minimum TCP downstream rate (shown as ↓TCP on the legend)

Minimum UDP upstream rate (shown as ↑UDP on the legend)
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Minimum UDP downstream rate (shown as ↓UDP on the legend)

Minimum actual PHY rate (shown as APHY on the legend)

Maximum round-trip time (shown as RTT on the legend)

The zones where the requirement is not met are marked with the corresponding legend color. If more 
than one requirement is not met, only one color will be used (priority is given to the requirements closer 
to the top of the list). If all the requirements are met, no color overlays will be displayed.

The meaning of the requirements listed above is explained in detail in the preceding sections of the 
Analyzing Data – Active Surveys chapter.
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Spectrum Analysis

Spectrum analysis involves the use of special RF equipment designed to listen to and analyze the 
frequency bands utilized by Wi-Fi devices. Because these bands are unlicensed, they are often shared with 
non-Wi-Fi sources of RF signals, such as wireless video cameras, microwave ovens, or cordless phones, 
which cause interference. The purpose of spectrum analysis is to detect and identify such sources of 
interference, eliminate them, and/or identify the WLAN channels with minimal interference. While 
spectrum analysis is not a mandatory part of a site survey, it might be very beneficial, especially in noisy RF 
environments.

Hardware Requirements

TamoGraph can perform spectrum analysis simultaneously with passive surveys by interfacing with WiPry
or Wi-Spy, USB-based spectrum analyzers. WiPry can be purchased from TamoSoft from Oscium.

TamoGraph supports the following Wi-Spy 
models:

Wi-Spy DBx (dual-band, 2.4 GHz and 5 GHz)

Wi-Spy 2.4x (single-band, 2.4 GHz)

Wi-Spy 2.4i (single-band, 2.4 GHz)

 

  TamoGraph supports the following 
WiPry models:

WiPry Clarity (tri-band, 2.4 GHz, 
5 GHz, and 6 GHz)

WiPry 2500x (dual-band, 2.4 
GHz and 5GHz)

 

 

 

https://oscium.com/product-category/spectrum-analyzers/
https://www.tamos.com
https://www.oscium.com/
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When a dual-band model, Wi-Spy DBx, is used, it continuously sweeps both bands, one after the other. 
Using two Wi-Spy DBx units simultaneously might improve data quality, as TamoGraph would dedicate 
each of the units to one band only. Note that you cannot use two WiPry devices of the same type 
simultaneously. You can, however, combine WiPry Clarity and WiPry 2500x, and you can mix Wi-Spy and 
WiPry devices.

Spectrum Data Graphs

When external USB spectrum analyzer is plugged in, a live spectrum picture is displayed on the central 
pane of the main TamoGraph window, as shown below.

The spectrum pane is similar to the one you can see in Chanalyzer, a spectrum analysis application by 
MetaGeek that comes with Wi-Spy. By default, the spectrum pane displays one or two planar spectrum 
graphs for single- and dual-band Wi-Spy models, respectively.

The appearance of the graphs can be controlled via the context menu. Select 2.4 GHz, 5 GHz, 6 GHz  or
 Dual to have the spectrum pane display one of the single frequency bands or two of three available bands 
simultaneously (5 GHz, 6 GHz  and  Dual  are available only if you have a dual-band or tri-band analyzer) 
Select Current Level to display a line that shows the current signal amplitude; select Max Level to display 
a line that shows the maximum signal amplitude. The X-axis item allows you to select the measurement 
units of the horizontal axis; you can choose between Frequency  in MHz and Channel numbers. By 
enabling the Waterfall  view, you can have the application graph amplitude over time. Select 1/3, 1/2, or 
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2/3 of the window size  to adjust the area of the window occupied by the waterfall graph. The spectrum 
pane can be detached from the main application window and displayed as a separate floating window. 
Use the Detach Window and Attach Window to perform the respective operations. You can also hide the 
spectrum pane by checking or unchecking the View => Spectrum item in the main application menu.

Note that in order to view spectrum data in TamoGraph, you must close Chanalyzer if it is running; Wi-Spy 
cannot be accessed and controlled by multiple applications simultaneously.

Performing Spectrum Analysis Surveys

Spectrum data can be collected either simultaneously with passive surveys or in spectrum-only mode (you 
will be prompted to select one of these two options in the survey type selection dialog.) The survey 
procedure is very similar to the one that you follow when you perform standard passive surveys. It is 
described in detail in the Data Collection chapter. To collect spectrum data during a passive survey, simply 
plug spectrum analyzer into a USB port of your computer before you begin the survey. However, there are 
a few peculiarities that you should keep in mind:

Spectrum data collection cannot be performed simultaneously with active surveys. During active 
surveys, spectrum data might be distorted due to the proximity of the Wi-Fi adapter that sends and 
receives large amounts of data. Therefore, spectrum data collection is disabled when active or 
simultaneous passive + active surveys are performed.

The data collection style for a spectrum survey is typically different from the style used for standard 
Wi-Fi surveys. Specifically, when performing spectrum surveys, the surveyor should spend more 
time in each survey point before moving to the next one. However, simultaneous Wi-Fi and 
spectrum data collection might give the surveyor valuable information. We recommend using the 
point-by-point mode, as described in the Data Collection  chapter, because in that mode, the 
spectrum analyzer has more time to collect data than it has in continuous mode. If you prefer to 
collect spectrum data in a traditional way, i.e., spend 30 seconds or a minute in a given location or 
zoom into a specific frequency range, you can do that using Chanalyzer.

Viewing Collected Spectrum Data

After you have performed a survey, the spectrum data collected can be viewed in two ways. The first 
option is viewing data in the main application window. When you hover the mouse over any point of the 
walkabout path, the spectrum pane displays the graph for the given survey point. Because a meaningful 
chart must contain data collected over a certain period of time (typically one minute), the chart displays 
data collected during the time period starting -30 seconds prior to the selected walkabout path point and 
ending +30 seconds following the selected walkabout path point, or a total time span of one minute. If you 
analyze the points at the very beginning of the walkabout path, the time span shifts accordingly. For 

example, for the first point, the time span would start with the first second and end with the 60th second. 
The same principle works for the points at the very end of the walkabout path. When you move the mouse 
away from the walkabout path, the spectrum pane begins displaying live data again (if compatible 
spectrum analyzer is plugged in.)



TamoGraph Site Survey   ●   Spectrum Analysis Page  85  of  120

The second option is viewing data in PDF or HTML reports. When a report with spectrum data is 
generated, location markers are overlaid on the floor plan and walkabout path, and a sequence of 
spectrum charts corresponding to each location marker is added to the report.

Exporting Spectrum Data

The spectrum data collected during site surveys can be exported into the WSX format for subsequent 
viewing in Chanalyzer by MetaGeek (version 4.2.1.28 or higher required). To export spectrum data, open a 
project that contains a spectrum analyzer survey, select a survey on the Plans and Surveys tab, and click 
Project => Export Spectrum Data.
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Reporting and Printing

After performing a site survey and viewing its results in the main application window, you can create a 
report that contains all the information and visualizations related to your survey. To configure the report 
options and generate a report, click Project => Generate Report in the main application menu.

The report generation dialog allows you to configure the following report options:

Plans and Surveys. This frame lists the available floor plans and survey paths to be included in the 
report. Depending on where and when the surveys were conducted, you may want to check all or 
only some of the survey checkboxes. By default, the selection is the same as in the main application 
window. If you are working with a predictive model, data from this model is shown as a “Virtual 
Data” item. If you are working with a survey that contains spectrum analysis data, that data is shown 
as a “Spectrum Data” item. At the bottom of this frame, you can also see the indication of the 
Current AP selection mode, which tells you if the report will be generated for all or for only the 
selected APs. Again, the selection is the same as in the main application window. If you want to 
change the AP selection mode, close the report dialog and change the mode, using the 
corresponding buttons on the toolbar of the main window. By default, TamoGraph merges the data 
collected during all the selected surveys. Check Don't merge surveys if you want to get a separate 
report for each of the survey paths. This might be useful if you want to generate a report illustrating 
the changes in WLAN characteristics depending on varying conditions, e.g. multiple surveys of the 
same office when you test different AP placements at the deployment stage. Normally, Don't merge 
surveys should not be checked.

Project information. Use the Surveyor, Location, and Description  fields to specify additional 
information about your project.

Visualizations. This list allows you to select which visualizations you would like to see in the report 
by checking or unchecking the corresponding boxes. Check Map with no visualizations  if you 
would like to have the original site map / floor plan included. Add per-AP visualizations is an 
important option that allows you to add additional visualizations for each of the selected APs. For 
example, if you want to create a report for five APs and include the Signal Level visualization with 
the Add per-AP visualizations option, the report will contain one cumulative signal level 
visualization for all the five APs and, additionally, five separate visualizations for each of the APs. 
Without the Add per-AP visualizations option, the report will contain only one cumulative signal 
level visualization that includes data on all the five APs. The Add per-AP visualizations option is 
available only when the Don't merge surveys option is turned off. The Split visualizations by band
option makes the application generate separate visualizations for each band. For example, when 
this option is enabled, if a certain location is covered by three APs in three frequency bands (2.4, 5, 
and 6 GHz), then the Signal Level  visualization would produce three separate heatmaps for the 
three bands. When this option is disabled, a single heatmap would show the strongest signal, 
regardless of the specific band.
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For passive surveys and predictive models, you can also add visualizations for secondary and 
tertiary coverage, i.e., coverage provided by the second- and third-strongest AP. To do that, you 
should click on the rectangle to the right of the visualization type. The rectangle displays the AP 
rank(s) to be included into the report: 1 for the default, standard visualization, where the metrics are 
shown for the strongest AP, 1+2 for the strongest and second-strongest AP, and 1+3 for the strongest 
and third-strongest AP. For more information, see AP Rank and Secondary Coverage.

Additional items to include. Check the corresponding boxes to include additional information 
pertaining to your site survey. Checking Walkabout paths  will add survey paths to the site map(s) 
(not available if you do not include the Map with no visualizations item); checking AP list will add 
the table that lists all the APs observed during the survey; checking Map descriptions will add the 
descriptions (if any) of the floor plan(s) entered by the user; checking Survey comments  will add 
the comments (if any) for specific surveys entered by the user; checking Virtual Obstructions  will 
display virtual obstructions, such as walls or attenuation areas, on the floor plan. This option is 
applicable to predictive models only. Checking Media Objects  will add photographs taken during 
the surveys.

Output settings. Use the Format  drop-down list to select the report format. You can choose 
between PDF, ODT (OpenDocument Text format that you can edit in  Microsoft®  Word  or 
OpenOffice), HTML, HTML (single file), and KMZ (Google Earth™) formats. The difference between 
the HTML  and  HTML (single file) is that in the former, images are stored in a separate subfolder, 
whereas in the latter, images are embedded into a single .MHT file, which can be natively viewed 
only in Microsoft Internet Explorer. KMZ files can be used for viewing results of GPS surveys in 
Google Earth; see the Google Earth Integration  chapter for details. The Paper size drop-down list 
can be used to specify the size of the report pages: A4, A3,  or Letter. You can also select a Page 
orientation: Portrait or Landscape. If you generate reports in PDF format, you can control the JPEG 
quality  (the higher the quality is, the larger the file size will be) and the Embed fonts  option. 
Embedding fonts increases the output file size considerably, but ensures that the file looks correct 
on any system, even if the fonts used in that file are not installed.

Object size factor. Depending on the floor plan dimensions and report page size, the objects in the 
report, such as AP icons, may appear too small or too large. Although the application tries to 
compute the best icon size for the given combination of plan dimensions and page size, you may 
want to adjust the object size manually by using this control.

Language. This control allows selecting the report language that does not necessarily match the 
language of the application user interface. For example, if the TamoGraph UI is English, you can 
generate a report in German.

Once you have configured all the options, you may want to customize its look (fonts, colors, logos, etc.) by 
clicking Customize  and then clicking Save to select the file name and have TamoGraph generate the 
report. Check the Open report after generation box to have the file opened by the associated viewer upon 
generation. If you would like to print the report without saving it to a file, click Print. Alternatively, you can 
first save the report and then print it from the associated viewer (Adobe Acrobat in the case of PDF files or 
your favorite browser in the case of HTML files).
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Customizing Reports

Report customization is available to Pro License users only.

The report customization dialog can be accessed by clicking the  Customize  button and checking the 
Enabled report customization  box. By using the customization functionality, you can change text colors, 
fonts, logos, or add additional text to PDF or HTML reports.

The following customization elements are available:

Heading #1 and Heading #2 – use these fields to modify the default report heading and subheading 
on the first report page.

Footer – use this field to modify the default footer text that is placed at the bottom of every report 
page except the first one.

Additional summary row and  Additional summary text  – use these fields to add a row to the 
report summary located on the first page.

Logo – this element allows you to replace the default logo on the first page. You can select an 
image in any common graphic format.

Colors – use this frame to set custom colors. #1 is for the heading on the first page; #2 is for other 
headings; #3 is for the background of the tables; #4 is for the table heading text color; #5 is for the 
main text color.

Fonts – use this frame to modify the default fonts. #1 is for the heading font; #2 is for the main text 
font.

Additionally, you may want to Add a page before the report  and/or Add a page after the report  by 
checking the corresponding boxes. Clicking Edit opens an editor window where you can enter and format 
any text and specify the headings for the additional pages.

To apply the new settings, click OK. To restore the default settings, click Default.
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Google Earth Integration

You can export survey results to a popular geographical information program, Google Earth™. This 
functionality is intended for large outdoor GPS-assisted surveys that you conduct using TamoGraph. By 
exporting data to Google Earth, you get an additional analysis option that integrates TamoGraph 
visualizations with rich geographical data provided by Google Earth. Data is exported in to a single Google 
Earth file (KMZ format) and can be viewed on any computer where Google Earth is installed.

To be able to export data to Google Earth, your survey project must be GPS-calibrated; see the GPS 
Calibration chapter for more details. When you open the KMZ file in Google Earth, your visualizations are 
overlaid on top of the satellite images or street maps. You can control which layers/visualizations are 
shown using the Places interface element in Google Earth. You can also rearrange the report according to 
your requirements by dragging the tree nodes in the Places  interface element; such rearranged reports 
can be saved into a new file. You can learn more about working with Google Earth by visiting https://
support.google.com/earth/.

There are two methods of data export from TamoGraph to Google Earth.

Current Visualization Export

This is the simplest method that lets you export a single visualization that is currently selected. Select a 
visualization on the toolbar, use the Project => Save current visualization menu command, select Google 
Earth (*.kmz) as the file output format, enter a file name, and then click Save to save the visualization. The 
resulting KMZ file can then be opened in Google Earth by double-clicking on it.

Export from the Report Dialog

For more advanced options, you can use the Project => Generate Report menu command. In the report 
configuration dialog, check the visualization(s) and survey(s) you would like to export and then select KMZ 
(Google Earth) from the Format drop-down list. Note that not all the surveys can be exported to Google 
Earth; only those surveys that were GPS-calibrated can be exported because the application must know 
the exact coordinates of your map to be able to export data; see the GPS Calibration  chapter for more 
details. Click Save  to generate a KMZ file. Unlike the first method that includes a single visualization, this 
method allows TamoGraph to generate a complex report file that contains a tree-like structure of layers 
that can be navigated and displayed in Google Earth. Visualizations and auxiliary elements can be 
accessed in the Places interface element in Google Earth. You will be able to select layers, view locations 
of APs, turn on and off visualizations, and further customize the view.

https://earth.google.com/
https://support.google.com/earth/
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Configuring TamoGraph

Virtually all of the application and project settings can be configured using the right-side panel (if the panel 
is hidden, click View =>  Right Panel  or click on the central part of the right splitter to have it displayed). 
This panel includes three tabs whose functionality is described below in detail.

Plans and Surveys

This tab displays a hierarchical list of the project floor plans or site maps and performed surveys, as shown 
below.

This list is an important tool that offers the following functionality:

Add, rename, or delete floors (for multi-floor projects) and floor plans / site maps: The project 
hierarchy consists of floors, floor plans, and surveys. The top hierarchy level is a floor, which contains 
one or several floor plans. A floor plan contains one or several surveys (i.e., walkabout paths with 
associated data collected by TamoGraph). Adding a floor is optional. Your project does not 
necessarily have to have the top-level floor node; when you create a new project, a floor level is not 
automatically created, and your floor plan becomes the top-level node. To add a new floor, click 
Add  => Floor. To add a new plan, select the floor you want to add the plan to and click Add  =>
Plan or  Add => Street map, if you want to import a map from one of the online map services or 
Microsoft MapPoint (MapPoint Europe or MapPoint North America are required to use MapPoint 
maps). To move a plan and related surveys to a newly created floor, simply select the plan with the 
mouse and drag it to the corresponding floor node. You can also use the context menu commands 
to Rename or Delete floors and floor plans.

Include, exclude, or delete surveys: Every survey that you performed shows up as a separate check-
boxed item under the floor plan where the survey took place. Checking the box makes the 
application include the data collected in the course of the selected survey in data analysis and 
visualizations. Depending on where and when the surveys were conducted, you may want to check 
all or only some of the survey check boxes. For example, if you have a large site and you made one 
break while conducting the site survey, your walkabout path will consist of two parts, both of which 
should be included in the analysis. In a different scenario (e.g., when you surveyed the entire site 
prior to installing additional wireless hardware and then surveyed it again after the installation), you 
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will probably want to include only one of the surveys and then compare it with the other one by 
changing the checkbox selection. You can also use the context menu commands to  Rename  or 
Delete surveys.

Merge surveys: Sometimes, you may want to merge several surveys into a single one for clarity and/
or convenience. Typically, this might be desirable when you made a break and then resumed the 
survey from where you previously stopped. In such a situation, it is quite logical to merge two 
surveys into a single one, as they represent a single logical walkabout path. To do that, check the 
surveys you want to merge and use the Merge Surveys context menu command. Please note that 
that the types of the surveys to be merged, their data collection methods, and all other parameters 
must be exactly the same. For example, you can merge two active surveys conducted in continuous 
mode in which you collected TCP and UDP throughput data, but you cannot merge an active and a 
passive survey, or two active surveys if in one of them you collected TCP data and in the other you 
collected TCP and UDP data. Similarly, you cannot merge two surveys if one of them was conducted 
in continuous mode while the other was conducted in point-to-point mode.

The Type column displays the type of survey that was conducted: Passive, Active, or Passive + Active. You 
can use the Comments column to add or modify comments for surveys. The Floor Manager is a tool that 
may be used in multi-floor predictive models; more information can be found in the Working with Multi-
Floor Sites chapter.

Properties

Using this tab, you can configure the project properties. It includes the following panels: Plan / Map, 
Environment, Client Capabilities, Requirements, and Scanner. You can collapse or expand panels by 
clicking on the arrow button on the right-hand side of the panel.

Plan / Map

The Plan / Map panel can be used for editing the floor plan Map name, adding Description/Comments to 
the plan, and adjusting the image brightness and contrast, if the floor plan is too bright, too dark, or lacks 
contrast. If the floor plan image is colored, you may want to check the Discard color information box to 
convert it to grayscale, as grayscale images give you a clearer picture when overlaid with data 
visualizations.

Environment

The Environment panel allows you to configure some of the very important project parameters that affect 
the way data visualizations are computed.

Because different environments have different characteristics in terms of signal attenuation, diffraction, 
reflection, etc., you are asked to Select an environment from the list. You should select the environment 
that best describes the site being surveyed.
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For each environment, the application recommends a Guess range. A guess range is the diameter of the 
circle for which the application predicts WLAN characteristics with a high degree of certainty. The lower 
the range, the more accurate the measurements, but the longer your walkabout path is. The higher the 
range, the less accurate the measurements, but the less time you spend performing a survey. When you 
conduct a site survey and click on the map to mark your location, TamoGraph displays your path and 
draws the guess range around the route points and your path, thus giving you a visual indication of the 
zone that you covered with your survey. The image below illustrates the walkabout path and guess range 
zone drawn along the path.

It is quite all right to decrease the suggested guess range, but increasing it is not recommended for the 
reasons explained above.

For passive surveys, TamoGraph can also compute WLAN characteristics outside the guess range zone, 
although such computations will have a lower degree of accuracy. Check the Extrapolate data beyond the 
guess range box to enable such computations. Enabling this option will mean that data visualizations will 
cover the entire map rather than the areas that you actually surveyed. Enabling this option is not 
recommended.

The Apply power spectral density (PSD) correction in the 6 GHz band checkbox, as the name suggests, is 
applicable only to 802.11ax/be APs that work in the 6 GHz band. Such APs operate within the power 
limitations set by the FCC in the USA and similar regulatory bodies in other countries. Essentially, the 
limitation is that the transmit power depends on the channel width: the wider the channel, the more 
transmit power can be used. This constitutes a problem for passive surveys in which TamoGraph normally 
relies on the signal strength of the received beacons and probe responses. Because beacons and probe 
responses are transmitted using the narrowest possible channel width (i.e., 20 MHz), their RSSI could be 
lower than the RSSI of the actual data packets. However, this is true only for some classes of 6 GHz APs, 
such as Low Power Indoor (LPI) APs and Very Low Power (VLP) APs. Standard Power (SP) APs reach the 
highest power spectral density at 20 MHz, so no correction is needed for SP APs. For a more detailed 
explanation, please read the online resources here and here.

Therefore, to account for the difference between the signal strength observed in the beacons and the 
signal strength of the data packets, TamoGraph automatically detects the AP class in the captured beacons 
and applies the PSD correction to the APs for which such correction is required. However, as a back-up in 
the situations where the manufacturer did not include the AP class info into the beacons or where the AP 
classes are sustainably different from the US FCC-defined classes, you may want to use this option. When 

https://www.extremenetworks.com/extreme-networks-blog/saddle-up-and-get-ready-for-wi-fi-6e-everything-is-bigger-in-6-ghz/
https://www.litepoint.com/blog/an-introduction-to-wi-fi-6e-spectrum/
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this option is off, TamoGraph applies the PSD correction based on the AP class detected in the beacons, i.e. 
the correction is applied to LPI and VLP APs (or similar non-FCC AP classes). When this option is on, 
TamoGraph applies the PSD correction to all the observed 6 GHz APs.

For predictive models, you can specify the expected noise level  for your virtual environment. There are 
two separate controls for each band 2.4 GHz, 5 GHz and 6 GHz bands. The default level is -90 dBm for 2.4 
GHz and -95 dBm for 5 GHz and 6 GHz.

Finally, the Measurement units control can be used to choose the preferred units (feet or meters) for 
displaying distances and coordinates throughout the application.

Client Capabilities

The PHY rate used in the AP-client connection is determined by the capabilities of the AP and the 
capabilities of the client. For example, an 802.11ac AP that supports three spatial streams and 80 MHz 
channels can provide data rates up to 1,300 Mbps. However, if the client is limited to 802.11n, two spatial 
streams, and 40 MHz channels, the PHY rate will not exceed 300 Mbps.

Using the Client Capabilities  panel, you can simulate different types of clients, and this affects the 
Expected PHY Rate and Requirements visualizations. You can select the Supported standards (802.11 a/
b/g/n/ac/ax/be), Channel width (20, 40, 80, 160, or 320 MHz), and Spatial streams (between 1 and 4). By 
default, client capabilities are set to the best real-world values: 802.11 a/b/g/n/ac, 80 MHz channel width, 
and three spatial streams. While the 802.11ac standard allows up to eight spatial streams and up to 160 
MHz channel width, such clients currently do not exist. If you want to visualize the Expected PHY Rate
constrained by the client capabilities, you can do so by adjusting them.

The Signal correction fields can be used to simulate clients that have radios that are much more or much 
less sensitive than average. Setting a negative value simulates a client that has a “weak” radio, i.e. bad 
reception. Setting a positive value simulates a client that has a “strong” radio, i.e. good reception. The 
correction affects all visualizations applicable to passive surveys. Normally, you should not change the 
default zero values unless you are a very experienced user and know exactly what you are doing.

The Preset  field allows you to create several frequently used client configurations and switch between 
them effortlessly.

Note that the client capabilities configured in this pane affect only passive surveys and predictive models; 
they do not affect active surveys, because in an active survey, PHY rates depend on the actual client 
adapter that you use.

Requirements

Using the Requirements panel, you can configure the requirements that your WLAN should meet. The 
configuration that you create will be used for displaying the Requirement (passive surveys)  and 
Requirements (active surveys)  visualizations. These visualizations are helpful for a quick and easy 
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evaluation of the overall health of your WLAN and detection of potential issues. You can set thresholds for 
the following WLAN parameters (click on the links for the detailed description of the corresponding items):

Passive Surveys and Predictive Models

Minimum signal level

Minimum signal-to-noise ratio

Minimum signal-to-interference ratio

Minimum APs required

Minimum PHY rate

Minimum allowed frame format

Minimum channel bandwidth

Active Surveys

Minimum TCP upstream rate

Minimum TCP downstream rate

Minimum UDP upstream rate

Minimum UDP downstream rate

Minimum actual PHY rate

Maximum round-trip time

To facilitate requirements configuration, three presets are available: Basic  (for basic, low throughput 
connectivity), Medium, and Advanced  (for high throughput, redundant connectivity, e.g., for VoIP). You 
can select a preset from the drop-down list, adjust the values, or create your own by clicking on the New 
button, typing a preset name, and then clicking the Save button. You can also delete presets by clicking on 
the Delete button.

Scanner

The Scanner panel gives you access to the Wi-Fi scanner configuration. The application scanner sweeps 
through the channels supported by the wireless adapter to collect and analyze packets being sent on the 
selected channels. It is not recommended that you modify the default 250 ms per channel scan interval. 
As for the list of channels to be scanned, you may want to modify it if you know that some of the channels 
supported by the wireless adapter are not used in your WLAN. For example, if your WLAN does not use the 
5 GHz band, you may want to turn off all 5 GHz channels; this will shorten the scanning cycle and, 
therefore, increase the data accuracy. However, please keep in mind that skipping some of the channels 
may result in the application's inability to detect sources of interference, such as neighboring APs that work 
on the channels that were skipped. If you uncheck the Use the same interval for all channels  box, you 
will be able to specify individual per-channel intervals. It is recommended that you leave this box checked. 
You can use the  Select channels  button for selecting or deselecting all channels, as well as for selecting 
channels based on the country- or region-specific allowed channel lists (e.g., choosing  United States  will 
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select channels 1-11 and deselect channels 12-14 in the 2.4 GHz frequency band). The Scanner panel can be 
used only if you have a compatible adapter for passive surveys.

Options

This tab allows you to configure the application options. It includes the following panels: Colors and Value 
Ranges, AP Detection and Placement, Visualization Settings, Tips, Computations, and Miscellaneous. 
You can collapse or expand panels by clicking on the arrow button on the right-hand side of the panel.

Colors and Value Ranges

Using this tab, you can configure color schemes, drawing styles, and value ranges used in visualizations 
overlaid on top of the floor plan or site map. Use the Survey path  color selection boxes to choose the 
colors to be used for drawing active  and  inactive  paths. An active path is the path along which you are 
currently walking, marking your location on the map. Inactive paths are the paths from previously 
performed surveys.

You can also choose between several  Visualization schemes  that will be used for visualizations, such as 
signal level or expected PHY rate. Checking the Smooth colors  box makes the transition between colors 
smooth. Checking the Invert colors  box inverts the colors in the selected visualization scheme. If you 
would like to see the contours between areas of different color, check the Contour box.

Using the Value Ranges section, you can configure the range of values represented by the selected color 
scheme for the Signal Level, Signal-to-Noise Ratio, Signal-to-Interference Ratio, Number of 
APs, Expected PHY Rate, Actual PHY Rate, TCP Upstream and Downstream Rate, UDP Upstream and 
Downstream Rate, and Round-trip Time visualizations. For example, if you selected the color scheme that 
ranges from red to blue and a signal level value range from -80 dBm to -30 dBm, any area where the 
signal level is equal to or below -80 dBm will be shown in red, and any area where the signal level is equal 
to or above -30 dBm will be shown in blue. Additionally, you can adjust the Steps value (i.e., the number of 
distinct colors to be used). Using the same example, the entire value range from -80 to -30 dBm would be 
50 dBm; setting the Steps value to 10 would mean that every 5 dBm, a new color would be used to display 
the signal level and the total number of distinct colors zones would be 10. Setting the Steps  value to 20 
would double the number of distinct colors, making the color overlay much smoother.

Click the Reset button below the value ranges to revert to the default range settings.

AP Detection and Placement

This tab allows you to configure some of the options that control how TamoGraph detects APs and shows 
them on the map.

Ignore APs if max. signal is below – Checking this box prevents the application from detecting and 
processing signals from very weak APs. Typically, such APs do not affect your WLAN and cannot provide 
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connectivity due to weak signal. The default cut-off level is -90 dBm; if the signal from an AP never 
exceeds the specified level, TamoGraph will completely ignore it.

Mark estimated AP locations – Checking this box makes the application automatically place APs on the 
map once the survey has been performed. If the estimated AP location is not accurate, you can correct it 
by moving the AP icon on the map with the mouse. If you corrected the AP location(s) by moving the 
corresponding icon(s), you can revert to the original location by right-clicking on the AP list on the left 
panel and then clicking Auto-locate Access Points (this action can be applied to All or Selected APs; here 
by Selected we mean the AP that is currently highlighted in the AP list).

Don't auto-place APs if max. signal is below – Checking this box prevents the application from trying to 
determine the location of those APs for which a strong signal was not detected. TamoGraph automatically 
determines the position of APs with strong signals and marks them on the map (if the previous option is 
enabled). If the signal is not strong enough, such AP placement may not be accurate: The AP might be 
located outside the site map and might not belong to your WLAN. The default cut-off level is -75 dBm; if 
the signal from an AP never exceeds the specified level, TamoGraph will not try to mark its position on the 
map. If the AP was not placed on the map, you can do it yourself by dragging the corresponding AP icon 
from the left-side AP list and dropping it on the map.

Maximum number of APs in tooltips – When a mouse hovers over survey path turning points, a tooltip is 
displayed. The tooltip contains the list of the strongest APs audible in the selected point. Use this control to 
limit the number of APs shown on the list.

Visualization Settings

The following settings affect the way TamoGraph displays some visualizations:

Area is considered covered if signal strength is at least – This setting defines the AP coverage area based 
on the minimum signal strength. If the signal strength is below the specified level, the area is considered to 
be not covered, which means that some data values will not be computed for the area (such areas will 
appear as white spots). The definition of “strong enough” is rather subjective because certain signal 
strength might be sufficient for low data rates, but insufficient for the high data rates required for such 
applications as VoIP. Additionally, 802.11 adapters vary in sensitivity, and some adapters might be able to 
provide good connectivity in zones where other adapters fail to connect altogether. The default value is 
-70 dBm. By default, this setting is applicable to the following visualizations: Signal-to-Interference Ratio, 
AP Coverage Areas, Number of APs, Frame Format, and Channel Bandwidth. Optionally, you can make 
it applicable to the Signal Level visualization by checking the Also applicable to Signal Level visualization
checkbox.

Average network utilization – This setting defines how heavy the interference is from the interfering APs. 
If the interfering signal strength is high, but the network utilization is low, the interfering AP does not 
create much interference. A typical office WLAN has a network utilization of between 10% and 25%. Adjust 
this setting to match the actual value for your WLAN. This setting is applicable to the following 
visualization: Signal-to-Interference Ratio.
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AP coverage areas  – This setting allows you to change the color coding method used for displaying 
coverage areas. In No fill, contours only  mode, the application draws contours of the coverage areas 
without filling the areas with colors. In Fill and mix colors  mode, the AP coverage areas are filled with 
colors; when areas overlap, the application draws a striped pattern, alternating the colors of the respective 
APs. In Fill, the strongest AP on top mode, AP coverage areas are filled with colors; when areas overlap, 
the application draws the color of the strongest AP. In Fill, the weakest AP on top  mode, AP coverage 
areas are filled with colors; when areas overlap, the application draws the color of the weakest AP. This 
setting is applicable to the following visualization: AP Coverage Areas.

Grayscale obstructions  – This setting controls whether virtual objects (used in predictive models) are 
displayed in color or grayscale mode. Available options are Always, When applying visualizations, and 
Never.

How AP icon locations affect signal  – This setting controls the effect that the AP icons have on the 
calculations of the signal level and other visualizations. The following three options are available:

Estimated AP locations do not affect signal levels; they are icons only – Suitable for the surveys 
where signal levels are low and AP locations cannot be estimated accurately. In this mode, the 
application displays data based ONLY on the actual measurements; there are no extrapolations.

Estimated AP locations are used to complement measured signals (new algorithm) –
Recommended for most surveys. It uses a new, more realistic algorithm for computing signal 
propagation. This is the default option.

Estimated AP locations are used to complement measured signals (old algorithm, up to version 
4.1) – The old-style algorithm used in versions prior to 4.2. The result is typically overly optimistic.

Tips Panel

The tips panel is a small panel that is shown at the bottom of the application window; it displays useful 
tips and tricks that help you perform certain tasks. You can control whether to show tips when Conducting 
Surveys  and performing RF Planning  and Selecting multiple obstruction objects by checking or 
unchecking the corresponding checkboxes. Experienced users may want to turn off tips altogether to free 
more space for the floor plan. By default, all tips are enabled.

Computations

The following settings affect the way TamoGraph performs heavy computational tasks needed for 
predictive RF models:

Use GPU for faster computations  – Check this box if you want TamoGraph to use the computational 
resources of your graphics processing unit (also known as “video card”). If your computer is equipped with 
a modern, fast GPU (preferably a discrete, dedicated one), selecting this option will make computations of 
complex RF models much faster. Note that this option is disabled if your GPU is not supported or if you are 
running a 32-bit TamoGraph version.
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Allow background computations  – This option is turned off by default. Check this box if you want 
TamoGraph to conduct computations in the background. For example, if this option is turned on, once you 
have opened a project with a predictive model, TamoGraph will start computing the model before you 
select any visualization. These saves time when you actually select a visualization to work with the model. 
Please turn on this option only if you running TamoGraph on a very powerful computer to ensure that 
other tasks are not slowed down due to the background computations.

Miscellaneous

The following miscellaneous options are available:

Use voice assistance during survey  – Check this box if you want TamoGraph to use the operating 
system’s text-to-speech engine to pronounce hints and warnings while you perform a survey. This option 
is available only if the current program interface is set to English. The drop-down list below this box allows 
you to select one of the available voices.

Load last opened project at startup  – Check this box if you want TamoGraph to automatically load the 
last project you worked on (if any) when the application starts.

Autosave project after survey – Check this box if you want to automatically save projects every time the 
survey is completed ensuring that the latest data is added to the project.

Autosave a project backup  – Check this box if you want to save a separate backup copy of the project 
whenever potentially risky or time-consuming operations are performed on the open project. You can 
specify the location for saving these backup copies and define how many of the most recent copies should 
be kept. Set the value to “0” for an unlimited number of copies. Note: this function is disabled by default.

Display scanner progress on the taskbar  – Check this box if you want TamoGraph to animate the 
Windows taskbar button while you perform a survey. Not available in macOS.

Use AP names from Cisco Aironet extensions – Check this box if you want TamoGraph to use Cisco CCX 
to assign names to Cisco APs. This box also enables similar functionality when displaying Aruba APs.

Custom AP names are used globally – Check this box if you want TamoGraph to use custom AP names 
throughout all the projects that you work with on a given computer. When this box is not checked, custom 
AP names are project-specific.

Show AP labels on the map – Check this box if you want TamoGraph to display a small label with the AP 
name next to each AP on the floor plan.

Ignore multitouch features – Check this box if you want TamoGraph to ignore the fact that you are 
running it on a computer with a multitouch display. When TamoGraph detects a multitouch display, it 
makes certain changes to the interface elements to make them more convenient to use. For example, 
pane splitters become wider, the circles that represent walkabout points become larger, and so on. If you 
do not need these changes, you can use this option to force TamoGraph to use a standard user interface. 
Enabling or disabling this option requires a restart. Not available in macOS.
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Smart map scrolling – Select when you want TamoGraph to use smart map scrolling: Always, During 
Survey, or never, if you uncheck this box. Smart map scrolls the map automatically whenever you click or 
tap next to the map edge, eliminating the need to scroll the map as you move along your path.

Enable automatic updates – Check this box if you want TamoGraph to connect to the TamoSoft and see 
whether a new TamoGraph version is available. When this option is enabled, TamoGraph checks for 
updates once a week.
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Configuring GPS Receiver

GPS functionality is available to Pro License users only.

To perform GPS surveys using TamoGraph, you need a source of Global Navigation Satellite System 
(GNSS) data. TamoGraph supports two types of such data sources:

A GPS receiver. TamoGraph supports any GPS receiver as long as it is NMEA-compliant. This 
includes almost all Bluetooth and USB GPS receivers; such receivers communicate with the 
computer over a virtual COM port (also referred to as a “serial port”). Unlike GPS receivers, GPS 
navigators (which typically have displays) are usually not NMEA-compliant and therefore cannot be 
used with TamoGraph unless special software is used. You can use Garmin devices; however, you 
will have to use GPSGate Client, a commercial utility, to make your Garmin navigator NMEA-
compliant.

On Windows only: a Windows GNSS sensor. Such sensors are integrated into many new Windows 
laptops and tablets. Note that there are location sensors that do not use satellite navigation. 
TamoGraph supports only satellite-based (GPS or GLONASS) sensors; other types of location 
sensors are not supported.

Using GPS Configuration Dialog

If you use an integrated Windows GNSS sensor, you do not need to perform any additional configuration 
steps or driver installations. Simply click Settings => GPS Settings to verify that your sensor is working and 
providing data on your current coordinates.

If you use an external GPS receiver, connect it to your laptop and configure it as per the manual provided 
by the device manufacturer. For Bluetooth devices, this typically involves “Bluetooth pairing”; and for USB 
devices, a driver installation is usually needed. Once your device has been connected to your laptop and 
turned on, click Settings => GPS Settings.

To configure TamoGraph to use your GPS receiver, all you need to know is the  COM port number (on 
Windows) or Port name (on macOS) through which your device is connected to your computer and the 
Bits per second  rate. The Port Settings frame allows you to select these values. Finding out the port 
number is discussed below in this chapter. The Bits per second rate is typically 4800 or 9600; please refer 
to the GPS receiver manual to find out this value. You can also click Detect to have TamoGraph scan your 
ports and detect the correct values. However, this might take several minutes.

Once you have selected or detected the port number/name and data rate values, click  Connect  to test 
your GPS receiver. The dialog will display the connection Status  and the availability of GPS data (also 
referred to as a “GPS fix”). If GPS data is available, which typically requires that you be outdoors, you will 
see your current Coordinates (you can select the format you prefer in the corresponding frame), as well as 

https://gpsgate.com/gpsgate-splitter
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the data accuracy information. Click Save Configuration  to save the data. You are now ready to perform 
GPS-assisted site surveys.

The GPS settings dialog on Windows is illustrated below:

The GPS settings dialog on macOS is illustrated below:
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Finding the GPS Receiver Port Number

As was explained earlier in the chapter, GPS receiver configuration requires that you enter the correct COM 
port number or name for your receiver. This information can be either automatically detected in the GPS 
configuration dialog or easily found by the user.

Windows

For Bluetooth devices, open Devices and Printers  in Windows, find your Bluetooth device, and double-
click on it. The Hardware tab will display the port number, as shown below.
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For USB devices, open Device Manager and find your device under Ports (COM & LPT). The device name 
will be followed by the port number, as shown below.
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  macOS

For Bluetooth devices, the port name typically contains the name of the GPS receiver that you have 
connected. An example of the port name would be “/dev/cu.BT-GPS-38B134-BT-GPSCOM” for the GPS 
receiver illustrated below:



TamoGraph Site Survey   ●   Configuring GPS Receiver Page  105  of  120

For USB devices, the port name typically looks like “usbserial-xxxx”.
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Taking Photographs

If you would like to add photos to your survey: e.g., images of APs, cabling, or other objects of interest, you 
can do so by using a video camera integrated into your laptop or tablet. To configure your video camera, 
click Settings => Camera and Voice Settings  in TamoGraph and select the Video Camera  tab. You can 
select the camera you want to use if there is more than one camera, as well as select the resolution of the 
photos that will be taken. Remember that while higher resolutions provide better image quality, such 
photos are much larger in size, which means that your project file might become much larger.

Once you have configured your camera, you can add photos to a floor plan. To take a photo, click on the 
webcam button on the toolbar or press Ctrl + P  (on Windows computers) or CMD + P  (on macOS 
computers). A preview window will appear. When you are ready to take a shot, press Enter or click on the 
preview window. To cancel, press Esc or click outside the preview window. The photo that you have taken 
appears as a small camera icon on the floor plan.

If you already have a photo (or some other image) that you would like to place on the floor plan, you can 
attach them by using the Attach Image button. Once the image has been placed on the floor plan, you can 
drag it to any position with the mouse.

The position of the icon depends on when you took the photo:

While you were surveying: You may want to take photos while you are conducting a survey. The 
best method is to pause the survey, take a photo, and resume the survey. In this scenario, the photo 
icon is placed at your current location on the floor plan.

While you were not surveying: You can take photos while you are inspecting the facility without 
conducting a survey at the same time. In this scenario, the photo icon is placed in the center of the 
floor plan image, as the application is not aware of your current location, unless you have 
configured a GPS receiver and your current map has been GPS-calibrated, in which case the photo 
icon is placed at your current GPS location on the map.

Regardless of the initial photo icon position, you can move the icon to any location on the floor plan by 
dragging it with the mouse. When you hover the mouse over the photo icon, you can see a small preview 
window. To see the full size photo, click on the preview window. If you do not want to see photo icons on 
the floor plan, use the View => Media Objects menu command to turn them on or off. To delete a photo, 
drag it off the floor plan image or press Del while viewing the full-size photo.

Photos can also be included in the reports. If the Media Objects  checkbox in the report configuration
window is checked, your photos will be appended to the report. For each photo, its location on the floor 
plan will be indicated.
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Voice Control

Voice control can be performed in English only. An English voice recognition engine 
may not be available in non-English operating system editions.

When you conduct site surveys, it is often convenient to control the application without using your hands. 
With TamoGraph, this can be achieved by using the operating system’s voice recognition engine. You can 
actually “tell” the application what to do using simple voice commands; for example, “TamoGraph, pause” 
or “TamoGraph, pan left”. To configure voice control, click Settings => Camera and Voice Settings in 
TamoGraph and select the Voice Commands tab. Check the Enable voice recognition box to turn on this 
functionality and select a Voice input device, which might be a microphone integrated into your laptop/
tablet; or, better yet, headphones with a microphone; an external microphone typically provides a much 
higher voice recognition quality. On Windows, the Voice recognition engine control allows you to select a 
language to be used, e.g. “English – US” or “English – UK”. On macOS, you may need to enable enhanced 
(offline) dictation. To enable it, open the system preferences dialog, select “Keyboard”, then “Dictation”, 
turn on “Dictation”, enable the “Use Enhanced Dictation” feature, and restart TamoGraph.

After configuring the voice recognition parameters, use the Voice command test  frame to test it. Press 
Start and say one of the pre-set commands:

Zoom in, Zoom out – zooms a floor plan in and out.

Start – starts a survey.

Stop – stops a survey.

Pause – pauses a started survey.

Resume – resumes a paused survey.

Pan up, Pan down, Pan left, Pan right – pans a floor plan.

Take photo – takes a photo.

Don’t listen – turns off voice recognition.

Each command must be prefixed with the specified Command prefix. By default, the prefix is 
“TamoGraph”, but you can change it to any other word. The reason why you need to use a prefix is the 
following: When voice recognition is enabled, the application is constantly listening for speech in the 
microphone. If you talk to someone while you are surveying and say, for example, “I need to take a photo”, 
the voice recognition engine hears the “take a photo” part and performs the action associated with this 
command, although you never wanted it to. To prevent the actions from being triggered by such phrases, 
actual commands intended for execution should be prefixed by a special word (by default, “TamoGraph”).

To test voice recognition, say “TamoGraph, zoom in” or “TamoGraph, take photo”. If the pronounced 
command is recognized, you will see and hear the confirmation message; e.g., “Zoom in ok”. For some of 
the commands, you can customize the associated action. Zoom step and Pan step control the percentage 
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of zoom and pan, respectively. Take photo after (sec.) controls the time interval after which the photo is 
automatically taken.

Once you have configured and tested voice recognition, you can close the configuration dialog and use 
voice commands to control TamoGraph. If a command is not applicable now; e.g., pausing a survey that 
was never started, you will be notified accordingly. Voice recognition can be turned on and off using the 
microphone icon on the right side of the status bar of the main TamoGraph window.
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Using TamoGraph in a Virtual Machine

You can install and use TamoGraph Site Survey inside a virtualized Windows OS running as a guest 
operating system on a Mac (or PC, if you prefer a virtual environment for whatever reason). In order to do 
that, you will need virtualization software, such as VMWare, Parallels Desktop for Mac, or Virtual Box.

Guest Operating System

As a guest Windows version, you can use Windows 10 or 11.

Hardware

To use TamoGraph for passive surveys, you need a compatible adapter. When you run our software on a 
Windows laptop, you can use any of the compatible adapters in different form factors. The list of 
compatible adapters can be found here (Windows) and here (macOS). When you run TamoGraph inside a 
virtual Windows machine, you can use USB adapters only. Please refer to the adapter list to find the USB 
adapter you are going to use. We strongly recommend that you choose an adapter marked 
"Recommended". They are also always available from us directly when you buy the boxed version.

Virtualization Software Configuration

If your virtualization software supports USB 3.0 emulation (which is the case if you are using VMWare or 
Parallels Desktop for Mac), be sure to use USB 3.0 emulation rather than USB 2.0 emulation, even if the 
USB port and the Wi-Fi adapter you are going to use are USB 2.0. USB configuration in VMWare is 
illustrated below.

https://www.tamos.com/download/main/tg
https://www.tamos.com/download/main/tg-macos
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USB 3.0 emulation is preferable because it dramatically increases the communication speed between the 
Wi-Fi adapter and guest OS. For example, in some adapters, switching the Wi-Fi channel might take 500 or 
even 1,000 milliseconds if you use USB 2.0 emulation and only 100 milliseconds if you use USB 3.0 
emulation. Considering the fact that TamoGraph typically switches channels every 250 milliseconds, this 
difference is dramatic. Using USB 2.0 emulation might slow down the application considerably.

For this reason, we recommend that you do not use VirtualBox  as virtualization software. At the time of 
writing, VirtualBox has no USB 3.0 support. If you still want to use VirtualBox, at least use the Enable USB 
2.0 (EHCI) Controller option; otherwise, your USB Wi-Fi adapter might not work.

Adapter Installation

Plug in the USB adapter into your computer. Once the adapter is plugged in, you will need to configure 
your virtualization software to use the detected USB device, i.e. disconnect it from the host OS and connect 
it to the guest OS. The configuration method depends on the specific virtualization software that you use; 
please refer to the related documentation. After the virtual machine takes control of the adapter, Windows 
will notify you that a new USB device has been found and will try to find the driver for the device. Click 
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Help => Driver Installation Guide in TamoGraph to find the instructions for installing our special packet 
capture driver. Once that driver has been installed, you can restart the application and use it.
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Command-Line Options and Configuration Settings for 
Advanced Users

A few command-line options are available for customizing the application’s behavior.

/nodriver – No attempt to use the compatible Wi-Fi adapter in TamoGraph will be made. In other words, 
if you launch TamoGraph with this switch, TamoGraph will not take control of your Wi-Fi adapter. 
Additionally, on macOS you can achieve the same effect if you press and hold the Fn key when launching 
TamoGraph.

/scanneroff  – TamoGraph will start up with the scanner turned off. This switch also prevents the driver 
installation guide dialog from appearing.

The rest of this chapter is intended for advanced users; please do not modify the registry or edit 
configuration files unless you know exactly what you are doing or unless you have been asked to do that 
by our technical support team.

/debug  – turns on writing debug information to a log file and writing captured packets to a capture file. 
Our technical support team may request these files for troubleshooting complex problems. On Windows, 
the output file names are debug.log and dump.ncf; the files are located in the application folder. On macOS, 
the output file names are TamoGraph.log and dump.ncf; the files are located on the desktop.

/debug-gps – turns on writing GPS-related debug information to a log file. Used together with the /debug 
option.

/gpu_force_bench  – forces TamoGraph to re-evaluate OpenCL compatibility of the connected GPU 
devices and to re-run benchmark tests for them in order to check their performance.

Certain advanced TamoGraph configuration settings cannot be accessed via the user interface; such 
settings can be edited in the registry (on Windows) or in the settings.xml file (on macOS).

Close TamoGraph before editing these settings!

On Windows, the parameters listed below are located under the following registry branch:

HKEY_CURRENT_USER\SOFTWARE\TamoGraph

On macOS, the parameters listed below are contained in the settings.xml file that is located in 
the following folder:

/Users/[UserName]/Library/Application Support/TamoGraph

APLabelTemplate – defines the format of information displayed on AP Labels. An AP label is a line of text 
that can include one or several of the following variables:
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%n – AP ordinal number according to the AP list on the left application panel.
%m – AP name
%s - SSID
%b - Band
%M - MAC
%v - Vendor
%e - Encryption
%c – Channel(s)
%r – Maximum PHY rate

If the parameter is empty, the labels will show only AP names. Note that this parameter affects only the AP 
labels; it does not affect the AP names saved as part of the project.

MinZoomPercent / MaxZoomPercent – defines the minimum and maximum zoom factor in percent for 
the floor plans displayed by TamoGraph.

SaveVisAPIconFactor  – this parameter controls the magnification in percent of AP icons when you use 
the Save Visualization As… function. If you want to make AP icons larger, specify a value > 100. To make 
them smaller, specify a value below 100.

RFPlanner\FloorNeighborhoodDepth – defines how many floors above and below the specific floor are 
taken into consideration when computing signals in predictive models. By default, this value equals 1, 
which means that signals from APs located one floor above and one floor below are computed. Note that 
increasing the value of this parameter slows down calculations.

Some user settings and presets are stored as separate files. These files can be manually edited, for 
example, if you need to add a long list of APs to the ignore-list. All the files that are listed below use UTF-16 
encoding.

On Windows, these files are located in:

C:\ProgramData\TamoSoft\TamoGraph Site Survey

On macOS, these files are located in:

/Users/[Username]/Library/Application Support/TamoGraph

ApAlias.txt – the list of custom AP names. If you renamed any APs manually, the file is modified after you 
exit TamoGraph. If needed, instead of renaming individual APs, you can manually populate this list with 
MAC addresses and corresponding custom AP names before a survey or before generating a report.

ApBlackList.txt – this list contains the MAC addresses of APs that should be fully ignored during passive 
surveys. For example, if internet sharing is enabled in your smartphone, you may want to fully ignore it.

ApLinked.txt– this list contains MAC addresses that belong to the same physical APs. Each line represents 
a physical AP; its MAC addresses (BSSIDs) are separated by spaces. This list is populated when you use the 
Link/Unlink MultiSSID AP  function in TamoGraph, but you can also edit it manually. This linking affects 
SIR calculations: If several radios on the same channel are linked into a Multi-SSID/Multi-MAC AP, they will 
not be considered as a source of interference for each other. This list is applicable to passive surveys. 
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Please note that all manual changes to this file will be applied to future surveys only; these changes are 
not retroactive. If you plan to survey a large WLAN with multi-SSID APs, we recommend that you obtain 
the lists of MAC addresses (BSSIDs) that belong to the same AP, add them to this file, save the file, and 
then perform a site survey.

Applications.user – custom applications defined for client types in coverage areas (applicable to predictive 
RF Modeling).

areas.user – custom attenuation area presets (applicable to predictive RF Modeling).

clients.user – custom client device presets (applicable to predictive RF Modeling).

floor_ceiling.user – custom floor/ceiling material presets (applicable to predictive RF Modeling).

obstructions.user – custom walls and doors presets.

stations.user – custom AP presets (they include antenna information + AP-specific values of band, rate, 
power, etc.)
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Frequently Asked Questions

Q1. Why is TamoGraph much more affordable than the competing site survey products?

A. Surprisingly, this non-technical question is probably the most frequently asked one. TamoGraph is more 
affordable for a number of reasons. We don't spend money on an impressive office in Silicon Valley. We 
don't fly first class looking for more venture capital. We've been in the software business for 15 years and 
we know how to work efficiently, to maintain a high brain-to-fat ratio. We also believe that all WLAN 
professionals should be able to afford a professional tool to do their job.

Q2. Do I need a compatible Wi-Fi card to perform active surveys?

A. No, you can use pretty much any modern Wi-Fi adapter. However, active surveys give you only a small 
part of the WLAN picture. To get comprehensive information, passive surveys are mandatory. A compatible 
adapter is required for passive surveys.

Q3. My card is not on your list of supported hardware. What are my options?

A. On Windows: Our hardware compatibility list includes only those cards that we've tested ourselves in 
our test lab. There are other cards that may be compatible with TamoGraph. The best way to find out if 
your card is compatible is downloading our Adapter Test Utility and running it on your computer. If a 
compatible adapter is installed, the utility will display its name. Before running our test utility, make sure 
that you use the latest driver supplied by your computer or adapter vendor. Visit their website to 
download and install the latest driver version. This is important, because the results of the test depend on 
the driver that is used. The newer the driver, the better the chances that it will work with TamoGraph. 
Finally, you may want to buy a compatible card, as they are not terribly expensive these days. Or simply 
order a boxed version from us; it comes with a compatible USB adapter. On macOS: TamoGraph works 
with the integrated Wi-Fi adapter built into your MacBook, so you may need an external USB adapter only 
if you want to conduct a simultaneous passive + active survey.The list of compatible USB adapters can be 
found on the TamoGraph macOS download page; anything that is not listed is not supported.

Q4. Why is the left panel that is supposed to display the list of access points empty?

A. This might be the case for a number of reasons:

You do not have a compatible adapter for passive surveys. The access point list is populated only if 
you have a compatible adapter or if you opened a project that already contains previously collected 
survey data.

You did not install the driver for your compatible adapter. Please refer to the Driver Installation
chapter for instructions. To verify that your compatible adapter is present and functioning correctly, 
look in the lower left corner of the application window. Your compatible adapter name should be 
displayed there. If the adapter name is displayed, but the list is still empty, contact our technical 
support.

https://www.tamos.com/files/tgcardcheck.zip
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Q5. Does TamoGraph support 802.11be (Wi-Fi 7) WLANs?

A. Yes, it does.

Q6. Do I need an 802.11be adapter to survey 802.11be WLANs?

A. For passive surveys, a supported 802.11ax (or even 802.11ac, if you are interested in the 2.4 and 5 GHz 
bands only) adapter is sufficient. Such adapters can capture 802.11be management frames, which is all that 
is needed for passive surveys. If you're interested in the 6 GHz band, then an 802.11be or 802.11ax adapter 
with Wi-Fi 6E support is a must. For active surveys, an 802.11be adapter might be a better choice, as older 
adapters might have lower maximum throughput. Again, if you plan to conduct active surveys in the 6 
GHz band, your 802.11ax or 802.11be adapter must support it.

Q7. I have a Wi-Spy USB spectrum analyzer. Do I still need a separate Wi-Fi adapter for passive or 
active surveys?

A. Yes, you do. Wi-Spy can be used for spectrum analysis only. It cannot replace a Wi-Fi adapter because it 
cannot capture packets or connect to the networks.

Q8. If I select a small Guess Range, then the predicted coverage at the end of the survey does not 
cover the whole office area that I am testing. Yet, if I increase the Guess Range, the coverage shadows 
seem to be bigger and cover the whole office. So I am confused how the results can have any accuracy 
when the Guess range can easily be manipulated to change the outcome of the coverage visualization.

A. Survey results may have an accuracy close to 100% only if you survey every square centimeter of the 
floor plan. Of course, this is impossible in practice (and not necessary), so the application has to do some 
extrapolation work to calculate the results for areas that have not been surveyed but that are near the 
walkabout path. There is a dependency between the guess range and the environment. If you are in the 
middle of a stadium field with no obstacles, Wi-Fi signal propagates freely and can be easily predicted 
dozens of meters around; therefore, you can use a greater guess range. If you are in a crowded office, 
signal propagation is very complex, so using the guess range that you used on the stadium field would be 
wrong. TamoGraph recommends a guess range for each environment type; this recommended value 
should be taken into account when you plan your walkabout paths. For example, if the recommended 
guess range is 5 meters and you survey the area by walking parallel paths, the distance between the 
parallel lines should not exceed 5 meters. To sum this up, if you conduct a quality survey by walking the 
entire area and leaving no “blank spots,” and if your walkabout paths are not far apart, then increasing the 
guess range would have almost no negative effect. That’s because, in such a scenario, you leave no room 
for the guesswork.

Q9. I noticed that the AP icon location affects the visualizations. When I move the icon, the 
visualizations change. How can I avoid that?

A. Moving the AP icon may or may not affect visualizations; this depends on the TamoGraph settings. A 
very detailed explanation of this functionality can be found in the Visualization Settings  chapter of this 
help file; see the How AP icon locations affect signal option description.
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Q10. Do I need to link the Multi-SSID APs manually to get valid results in the SIR visualization?

A. Usually, TamoGraph tries to group multiple SSIDs together automatically during the survey. However, 
depending on specific WLAN implementations, it might not be an error-free process. If you noticed that 
TamoGraph had not detected some SSID groups correctly, it is recommended that you link the SSIDs 
belonging to the same physical AP manually to get proper SIR results. It is preferable to do manual SSID 
linking after the entire passive survey is completed.

Q11. Does TamoGraph support multi-floor projects?

A. Yes, you can create projects with multiple floors in TamoGraph. If you perform predictive modeling, 
simply add new floors in Floor Manager, add floor plans for each floor, define floor height and material, 
and then align the floors.

Q12. Do I need to use the Floor Manager and floor alignment in passive surveys? Does the program 
take into account the floor materials and floor order in passive surveys?

A. No. The “Floor Manager” and “Align Floors” tools should be used for RF predictive models only. In 
passive surveys, the application collects actual signal data regardless of the floors and AP locations; in 
other words, it doesn’t “care” about floors, their order or materials.

Q13. I conducted a passive survey in a multi-floor building, and some of the APs were auto-placed on 
adjacent floors rather than on the floor where they are actually located. How do I correct that?

A. If you know the actual locations of the APs on their respective floors, then for each floor: (a) manually 
correct the locations of the APs that are physically located on that floor and (b) drag the icons of all APs 
that belong to other floors off the floor plan. If you don’t know the actual locations of any APs and wish to 
view the signal coverage map only, then clear all AP locations; this will make the application use only the 
actual data, without any extrapolations.

Q14. I have one physical AP that I want to move around to simulate multiple APs before deploying my 
WLAN. Can TamoGraph treat this single AP as multiple APs so that I can estimate the characteristics of 
the future WLAN?

A. Yes, this widely used method is called “AP-on-a-stick”. TamoGraph provides the functionality necessary 
to handle such scenarios. Please see Splitting an AP into Multiple Unique APs for detailed instructions.

Q15. It appears that there are very few virtual AP templates and all of them are for generic APs. How 
do I create a virtual AP that simulates a specific model by a major Wi-Fi equipment vendor?

A. Virtual APs can be constructed like Lego. For example, if you want to simulate a Cisco Aironet 2700 
series AP, you should begin with the Generic dual 802.11ac template. Place the AP on the floor map, 
double-click on it, configure its properties to match the properties of the physical AP you plan to deploy 
(e.g., channel width or output power), and then select the antenna type, which in your case should be 
Cisco Aironet 2700 series 4 dBi. Be sure to do this for both radios of this dual-band AP. In other words, you 
use Lego bricks to build a model that matches the actual AP. You can then save this configuration as a new 



TamoGraph Site Survey   ●   Frequently_Asked_Questions.htm Page  118  of  120

template and use it in your projects. Why don’t we provide you with a ready-to-use model? Because we 
cannot know how you plan to configure your physical Cisco Aironet 2700 series APs. For example, we 
cannot know whether you plan to use 20 or 40 MHz channels in your APs. This is why you have the 
utmost flexibility in creating your own template.

Q16. Is there a way to tell the software to ignore all APs except the one with which I am are surveying? 
I want to collect data for our survey AP only and generate a report for this AP only.

A. You can have visualizations for any set of AP,  even a single AP. There are two buttons on the toolbar 
that switch between the All APs and Selected APs modes, so you can press the latter and select only one 
AP on the left pane. Please note that in case of the Signal-to-Interference Ratio visualization, the signal of 
the selected AP is analyzed against all APs in the projects.

Q17. Can I use multiple adapters with TamoGraph to make the scanning process faster?

A. On macOS - no. On Windows - yes. TamoGraph can capture data from multiple channels 
simultaneously if you use multiple compatible USB adapters. This shortens the time needed to collect data 
from the channels being scanned as you move along the survey path, and, therefore, improves the data 
quality. For example, with the default 250 ms per channel interval, it takes five seconds to sweep through 
20 channels if you use only one adapter. If you use three adapters, the same amount of data will be 
collected in less than two seconds. The following 802.11ac USB adapters can be used for multichannel 
capturing: ASUS USB-AC68, Belkin F9L1109 v1, D-Link DWA-180 rev A1, D-Link DWA-182 rev C1 or D1, 
Edimax EW-7822UAC, Edimax EW-7833UAC, EnGenius EUB1200AC, Linksys WUSB6300, Linksys 
WUSB6400M, NETGEAR A6210, Proxim ORiNOCO 9100, TP-LINK Archer T4U, TP-LINK Archer T4UH, 
TRENDnet TEW-805UB, and ZyXEL NWD6605, and ZyXEL AC240. The following 802.11ax USB adapters can 
be used for multichannel capturing: ASUS USB-AX56, D-Link DWA-X1850, FusionFutures AX1800, NETGEAR 
A8000, and Alfa AWUS036AXML. Note that different types of adapters cannot be mixed; all the adapters 
should be of the same model. You should also install the same driver for all adapters.

Q18. Some channels in the scanner options window are not listed. Is this normal? What if I want to 
monitor these channels?

A. The answer depends on the adapter type and operating system. For Windows:

Recommended Ralink-, MediaTek-, and Realtek-based USB adapters: All channels are always 
available when using them in TamoGraph.

Recommended Intel-based adapters: Channel availability may depend on the specific model. In any 
case, we try to make all channels available.

Other adapters (e.g. Dell or Broadcom): enabling channels 12 and 13 may be possible. Open the 
TamoGraph application folder (usually C:\Program Files\TamoGraph or C:\Program Files 
(x86)\TamoGraph). You will see the file named ch1213.exe there. Double-click on that file to execute 
it. Restart TamoGraph and enable channel 12 and 13 in the scanner options; these channels will 
become available for selection. Note that the adapter's ability to capture packets on channels 12 and 
13 depends on the regulatory domain set by the laptop vendor. If the vendor enabled them in your 
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case, there won't be a problem. However, we've heard of many examples when laptop vendors did 
not enable channels 12 and 13 even in the laptops that were sold in a country where these channels 
were legal.

For macOS, depending on the region where it was sold, your MacBook’s Wi-Fi adapter comes with a preset 
country code, e.g. “US” (for USA), “AU” (for Australia), or “X2” for Europe. This normally defines the set of 
available channels. However, this set might change dynamically. In macOS versions prior to Sierra, the Wi-
Fi adapter “listens” to the country codes that some access points broadcast using the 802.11d standard. 
Once the adapter “decides” that it had been relocated to a new regulatory domain, it changes its country 
code, effectively changing the list of available channels and a few other parameters, such as maximum 
output power. In macOS Sierra and newer, the system uses Location Services to figure out where your 
MacBook is located. If, for whatever reason, you want to prevent macOS from switching to a new country 
code, go to System Preferences => Security and Privacy => Privacy => Location Services => System 
Services => Details and uncheck the Wi-Fi Networking box.

Q19. Why is the UDP downstream throughput value always zero?

A. This is a firewall issue. This means that the UDP data being sent from the server cannot reach the client. 
When performing UDP testing, the client sends upstream UDP traffic to the server from a random UDP 
port to the server port (27100 by default.) The return downstream traffic goes from port 27101 to the client 
source port. Use this information to configure your firewall.

Q20. Why do I see very high (over 50%) UDP downstream loss?

A. This question is answered in the UDP Upstream and Downstream Loss chapter.
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Sales and Support

At TamoSoft, we want you to be happy with your purchase. That is why we encourage you to try our 
products and technical support free of charge for 30 days before you make a decision regarding your 
purchase. By making the most of these free evaluations, you can fully test the software and make sure that 
it does everything you need. When you are ready to buy, we welcome you to https://www.tamos.com/
order to order directly from us or through our partners and resellers.

As a registered user, you will receive:

A fully functional, unrestricted copy of the software.

Free updates that will be released within one year from the date of purchase.

Information on updates and new products.

Free technical support.

Prices, terms, and conditions are subject to change without notice. Please check our website for the latest 
product offerings and prices.

For technical support, please visit https://www.tamos.com/support.

https://www.tamos.com/order/
https://www.tamos.com/support
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